PET Application GUI Style Guide

Document Version 1.4 Beta

November 7, 2003
Important Information

Texas Instruments makes no warranty, either express or implied, including but not limited to any implied warranties of merchantability and fitness for a particular purpose, regarding any programs or book materials and makes such materials available solely on an as-is basis. In no event shall Texas Instruments be liable to anyone for special, collateral, incidental, or consequential damages in connection with or arising out of the purchase or use of these materials, and the sole and exclusive liability of Texas Instruments, regardless of the form of action, shall not exceed the purchase price of this product. Moreover, Texas Instruments shall not be liable for any claim of any kind whatsoever against the use of these materials by any other party.

Permission is hereby granted to teachers to reprint or photocopy in classroom, workshop, or seminar quantities the pages in this work that carry a Texas Instruments copyright notice. These pages are designed to be reproduced by teachers for use in their classes, workshops, or seminars, provided each copy made shows the copyright notice. Such copies may not be sold, and further distribution is expressly prohibited. Except as authorized above, prior written permission must be obtained from Texas Instruments Incorporated to reproduce or transmit this work or portions thereof in any other form or by any other electronic or mechanical means, including any information storage or retrieval system, unless expressly permitted by federal copyright law. Send inquiries to this address:

Texas Instruments Incorporated
7800 Banner Drive, M/S 3918
Dallas, TX 75251

Attention: Manager, Business Services

Copyright © 2003 Texas Instruments Incorporated. Except for the specific rights granted herein, all rights are reserved.

Printed in the United States of America.

Trademarks

PET® is a trademark of Texas Instruments Incorporated.

The Qt logo®, Qt®, and Qtopia® are all registered trademarks of their owner.

Acknowledgements

Principal Authors: Lance Smith and Kiana Matthews
with contributions from the entire PET Development Team

Technical Reviewers: Kiana Matthews and Dale Philbrick

ICOM Standards Editor: Chris Alley
Table of Contents

Important Information ................................................................................. 2
Trademarks ................................................................................................. 2
Acknowledgements ................................................................................... 2

About this book
Document organization .............................................................................. 7
Intended audience .................................................................................... 7
Related documentation ............................................................................ 8
Style and typographical conventions ........................................................ 8
Technical support ..................................................................................... 8

Design philosophy
Introduction to PET Solution meta-architecture ....................................... 10
  Purpose of the PET Solution meta-architecture ...................................... 10
  How third-party developers can use the PET meta-architecture .......... 10
  Definition of PET meta-architecture elements ...................................... 10
PET meta-architecture elements ................................................................. 11
  Metaphors ............................................................................................... 11
  Principles ................................................................................................. 12
  Guidelines .............................................................................................. 13
  Mechanisms ........................................................................................... 14
Maximize content area ............................................................................. 14
Consistency ............................................................................................... 15
Simplicity .................................................................................................. 15
Accessibility considerations ..................................................................... 16
  Federal legislation .................................................................................. 16
  Overview of disabilities ......................................................................... 16
  Assisted technology primer ................................................................. 17
  Tools for accessibility ............................................................................ 17
  Testing a GUI design for accessibility .................................................. 18
Other considerations ................................................................................ 18
  See and point ......................................................................................... 18
  User control ........................................................................................... 19
Application design checklist ................................................................... 19

User interactions
Soft keyboards .......................................................................................... 20
  Toggling soft keyboard on and off ....................................................... 20
Accessibility guidelines .......................................................................... 21
Single tap to open ..................................................................................... 21
Moving within an application .................................................................. 22
CellSheet operations ................................................................................ 22
  Editing cell content ............................................................................... 22
  CellSheet table scrolling and paging .................................................. 23
Start a command or action ...................................................................... 24
  Tap and hold - display context menus .............................................. 24
Making a selection .................................................................................... 24
  Single selection and multiple selection ............................................. 24
### Pre-production Beta v1.4 release

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All functionality</td>
<td>25</td>
</tr>
<tr>
<td>Stylus selections</td>
<td>25</td>
</tr>
<tr>
<td>Drop-down and list box item selection</td>
<td>25</td>
</tr>
<tr>
<td>Keyboard selections</td>
<td>25</td>
</tr>
<tr>
<td>Drop-down list and list box item selection</td>
<td>25</td>
</tr>
<tr>
<td>CellSheet elements</td>
<td>26</td>
</tr>
<tr>
<td>Graphic object selection</td>
<td>27</td>
</tr>
<tr>
<td>Exchanging information between applications</td>
<td>28</td>
</tr>
<tr>
<td>Cut</td>
<td>28</td>
</tr>
<tr>
<td>Copy</td>
<td>29</td>
</tr>
<tr>
<td>Paste</td>
<td>29</td>
</tr>
<tr>
<td>Preventing or removing actions</td>
<td>30</td>
</tr>
<tr>
<td>Cancel an action</td>
<td>30</td>
</tr>
<tr>
<td>Undo and Redo actions</td>
<td>30</td>
</tr>
<tr>
<td>Enlarging and reducing application display resolution</td>
<td>31</td>
</tr>
<tr>
<td>Stylus Method</td>
<td>31</td>
</tr>
<tr>
<td>Keyboard Method</td>
<td>31</td>
</tr>
<tr>
<td>Actions with common files</td>
<td>32</td>
</tr>
<tr>
<td>Clear</td>
<td>32</td>
</tr>
</tbody>
</table>

### Application framework

| Application screen                                | 33   |
| Moving among major screen controls                | 34   |
| Title bar                                         | 34   |
| Menu bars                                         | 35   |
| Menus                                             | 36   |
| Client area                                       | 37   |
| Toolbars                                          | 37   |
| Toolbar icon groups                               | 38   |
| Multiple application management (multitasking)     | 39   |
| Application menus                                | 39   |
| Application title area                            | 39   |
| Multitasking and the application toolbar          | 40   |
| Full screen application client area               | 40   |
| Tiled screen application client area              | 41   |
| Task switcher                                     | 42   |
| Setup tiled screen dialog box                     | 43   |
| Starting a new task                               | 43   |
| Multitasking functions                            | 44   |

### User interface controls

| GUI control interaction                          | 48   |
| GUI control states                                | 48   |
| Examples of GUI control states                    | 49   |
| Overview of buttons                              | 49   |
| Text buttons                                      | 50   |
| Icon buttons                                      | 51   |
| Icon and Label buttons                            | 52   |
| Lists                                             | 54   |
| Drop-down lists                                   | 55   |
| List Boxes                                        | 55   |
| Scroll Bars                                       | 56   |
| Labels                                            | 57   |
Common dialog boxes

<table>
<thead>
<tr>
<th>Dialog Box Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to dialog boxes</td>
<td>71</td>
</tr>
<tr>
<td>Title area</td>
<td>71</td>
</tr>
<tr>
<td>Control area</td>
<td>71</td>
</tr>
<tr>
<td>Command area</td>
<td>71</td>
</tr>
<tr>
<td>Open dialog boxes</td>
<td>72</td>
</tr>
<tr>
<td>Title and command areas</td>
<td>72</td>
</tr>
<tr>
<td>Control area</td>
<td>72</td>
</tr>
<tr>
<td>Backpack vs. general GUI storage presentation</td>
<td>73</td>
</tr>
<tr>
<td>Tab key navigation</td>
<td>75</td>
</tr>
<tr>
<td>Open dialog functions</td>
<td>75</td>
</tr>
<tr>
<td>Save As dialog boxes</td>
<td>79</td>
</tr>
<tr>
<td>Title and command areas</td>
<td>79</td>
</tr>
<tr>
<td>Control area</td>
<td>80</td>
</tr>
<tr>
<td>Backpack vs. general GUI storage presentation</td>
<td>80</td>
</tr>
<tr>
<td>Tab key navigation</td>
<td>82</td>
</tr>
<tr>
<td>Save As dialog functions</td>
<td>83</td>
</tr>
<tr>
<td>Color dialog boxes</td>
<td>88</td>
</tr>
<tr>
<td>Title and command areas</td>
<td>89</td>
</tr>
<tr>
<td>Control area</td>
<td>89</td>
</tr>
<tr>
<td>Color dialog functions</td>
<td>90</td>
</tr>
<tr>
<td>Font dialog boxes</td>
<td>93</td>
</tr>
<tr>
<td>Title and command areas</td>
<td>93</td>
</tr>
<tr>
<td>Control areas</td>
<td>93</td>
</tr>
<tr>
<td>Font dialog functions</td>
<td>94</td>
</tr>
<tr>
<td>Help application</td>
<td>96</td>
</tr>
<tr>
<td>Accessing PET device help</td>
<td>97</td>
</tr>
<tr>
<td>Help Table of Contents</td>
<td>97</td>
</tr>
<tr>
<td>Help topic page titles</td>
<td>98</td>
</tr>
<tr>
<td>Help Search dialog box</td>
<td>99</td>
</tr>
<tr>
<td>Tab key navigation</td>
<td>99</td>
</tr>
<tr>
<td>Help search results</td>
<td>99</td>
</tr>
</tbody>
</table>
Help application functions .............................................. 100
About dialog box ......................................................... 104
  Texas Instruments About dialog box example .................. 104
  Title, command, and control areas ............................... 104
  Tab navigation order .................................................. 105
  About dialog functions ............................................... 105

File storage presentations
  Backpack ........................................................................ 107
  Backpack-Binder Architecture ....................................... 108
  Accessing backpack menu commands ............................... 109
  Navigating to another binder ....................................... 110
  Binders and sections .................................................... 111
  Sections and files ....................................................... 111
  Sections and file manipulation ..................................... 112
  General storage presentation ....................................... 112

Appendix - Reference Material
  Hard keys ..................................................................... 114
  Tab hard key ............................................................... 115
  Shortcut keys .............................................................. 115
  Suggested standard menu layout ................................... 117
  Application image limitations ....................................... 117
  Soft keyboards ................................................................ 118
  Overview ....................................................................... 118
  Full-screen and tiled soft keyboard displays ..................... 119
  Functions ...................................................................... 120
  English (Number) keyboard .......................................... 122
  French keyboard .......................................................... 123
  Spanish keyboard ......................................................... 124
  German keyboard ......................................................... 125

Index
About this book

Texas Instruments designed this style guide to assist third-party software companies that want to create applications for the Personal Learning Tool (PET). Developers can create applications using the PET Software Development Kit (SDK), which uses the Qt™ and Qtopia™ development software as its underlying foundation for developing software for Linux™ embedded devices.

Document organization

This document provides specific information about the PET Graphical User Interface (GUI) objects, their behavior within applications, and the user interactions necessary to control the PET application objects. This information is divided into these sections:

- **About this book** – Describes the style guide’s organization, the document’s intended audience, related PET documentation, technical support, and notation used throughout the TI PET application development documentation.

- **Design philosophy** – Lists the user interface principles and meta-architecture elements followed in selecting the GUI controls, choosing user navigation, and deciding on user input procedures.

- **Application framework** – Describes the PET application screen layout, the GUI controls used, and preferred methods to switch between PET applications.

- **Interaction methods** – Defines how the user interacts with one or more PET applications using the stylus, virtual keyboard, and external keyboard. TI also provides an illustration of how a user can switch between applications.

- **User interface controls** – Describes the standard PET GUI controls provided through the SDK and how a PET user should interact with these user interface elements.

- **Standard dialog boxes** – Defines the standard dialog boxes and help application, which all PET applications should use to provide application consistency for the PET device.

- **File storage presentations** – Describes the storage of PET documents using the Backpack metaphor and general file storage presentation.

- **Appendix reference material** – Defines the standard PET hard keys, keyboard shortcuts, suggested menu layout, PET image limitations, and multi-language soft keyboards.

Intended audience

This document provides the necessary information for third-party software developers who want to create applications for the PET hand-held device and adhere to TI’s user interface style guidelines. Business development professionals and product development managers will find this book helpful in planning application development that is consistent with Texas Instrument’s original customer vision: This book assumes that the reader has:

- Knowledge of standard graphical user interface environments.

- A basic knowledge of Qt and the Qtopia embedded development environment.
Related documentation

TI has documented its PET application user interface in this style guide document and in the PET Application SDK Reference Guide. Interested third-party developers can obtain these documents from the Texas Instruments PET EP&S Partner Collaboration Portal™: https://ti.alliancevista.net.

- See the PET Application SDK Reference Guide for more information about building applications using PET GUI controls with C++.

Style and typographical conventions

The PET application development documentation uses these typographical conventions to describe user and programmatic interactions with the PET software:

<table>
<thead>
<tr>
<th>This style</th>
<th>is used for...</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save As</td>
<td>Menus, buttons, radio button options, or GUI screen elements that a user controls.</td>
</tr>
<tr>
<td>Underlined</td>
<td>Hypertext links for Uniform Resource Locators (URL) and cross-references.</td>
</tr>
<tr>
<td>Italic</td>
<td>File names, directory names, document titles, and terminology.</td>
</tr>
<tr>
<td>Program code</td>
<td>C++ programming code used to call PET SDK methods and Qt underlying API classes.</td>
</tr>
<tr>
<td>Constant width</td>
<td>Examples and regular text to show methods, classes, keywords, objects, operators, variables, function names, data types, and the output from commands or programs.</td>
</tr>
<tr>
<td>User input</td>
<td>Text that a user must type on a computer keyboard or virtual software keyboard.</td>
</tr>
<tr>
<td>Constant-width italic</td>
<td>Shows variables where a context-specific substitution should be made that is correct for your programming environment. The variable file_name, for example, would be replaced by an actual file name.</td>
</tr>
<tr>
<td>[Expression List]</td>
<td>Items in square brackets are optional.</td>
</tr>
<tr>
<td>{While</td>
<td>Until}</td>
</tr>
<tr>
<td>Must</td>
<td>A PET user interface element or style that a developer must use without any major changes.</td>
</tr>
<tr>
<td>Should</td>
<td>A user interface element or style that Texas Instruments recommends that third-party developers should not change.</td>
</tr>
</tbody>
</table>

Technical support

The best resource for up-to-date information on developing PET applications for commercial usage is the Texas Instruments’ Partner Collaboration Portal. Additional information can be
obtained by calling these Texas Instrument EP&S contacts.
https://ti.alliancevista.net/

<table>
<thead>
<tr>
<th>User Interface Style Issues</th>
<th>Kiana Matthews</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDK Functionality</td>
<td>Alan Smith and Joel Pacheco</td>
</tr>
<tr>
<td>Documentation Corrections</td>
<td>Nelah McComsey</td>
</tr>
<tr>
<td>Third-party development</td>
<td>Ray Bonneau</td>
</tr>
</tbody>
</table>

Other software development information can be found at:

- Technical Support E-mail Address
  (To Be Announced)
- Texas Instruments PET EP&S Partner Collaboration Portal:
  https://ti.alliancevista.net
- Qt v2.3 Free Reference Documentation on Trolltech’s Internet:
  http://www.trolltech.com/
- PET Application SDK Reference Guide (Getting Started Chapter)
  https://ti.alliancevista.net
Design philosophy

Introduction to PET Solution meta-architecture

A high-level *meta-architecture* drives the Texas Instruments’ PET application design and development operation.

**Meta-architecture** – a set of high-level decisions and constraints that provide a framework for and strongly influence the structure of the system. The meta-architecture is not an actual architecture or system design. Through its metaphors, principles, guidelines, and styles, the PET meta-architecture provides guidance for design selections. Using the PET solution meta-architecture provides (1) metaphors, (2) principles, (3) guidelines, and (4) mechanisms for a third-party company to consistently follow Texas Instruments, while adding its own unique applications or implementations.

**Purpose of the PET Solution meta-architecture**

The meta-architecture provides a structure for architecture efforts, design validation, and resolving contending architecture and design choices. Its objectives include:

- **Alignment** – Maintains continuity between product vision and what is actually built. This applies across various levels — starting from business strategy and product strategy to requirements and software development. Meta-architecture helps align product strategy and development.
- **Translation** – Translates strategy and vision into a language that is tangible, usable, and traceable for product development.
- **Decision framework** – Provides guidance in resolving architecture trade-offs and design choices.

**How third-party developers can use the PET meta-architecture**

Third-party companies can use the Texas Instruments meta-architecture structure to implement processes within their own application development that involve:

- **Product strategy** – Extends current GUI application metaphors such as the Backpack/Binder/Section. By developing teacher desktop or connectivity metaphors that are consistent with TI’s initial design, third-parties can position applications for increased market acceptance.
- **Solution requirements** – Provide guidelines to developers that help them meet the customer needs and wants.
- **System architecture** – Ensure that the companies application architecture is consistent with the original meta-architecture at various solution levels. This would be reflected in the conceptual, logical, and information architecture artifacts produced by a company.

**Definition of PET meta-architecture elements**

Texas Instruments’ PET Solution architecture has these meta-architecture elements:
Section 2: Design philosophy

PET meta-architecture elements

Metaphors – Figures of speech that simplify a description or convey an aspect of a complex system using an illustrative example. Metaphors provide a theme or background context that is pervasive throughout the PET product. An example metaphor is a **backpack of binders**.

Principles – Statements of preferred architectural direction or practice. They help establish a context for architectural decisions by using business criteria to rationalize basic architectural choices. Principles eliminate the need for evaluating endless alternatives by agreeing up front on preferred directions.

Guidelines – Standards used to make a judgment or determine a policy or course of action. Guidelines are similar to principles, but don’t carry quite the weight that principles carry.

Mechanisms – Methods for access or communication to accomplish a system function. *Publish and subscribe messaging* is an example a mechanism for information exchange between multiple computers or databases.

PET meta-architecture elements

Metaphors

Whenever possible, model the software objects and actions with something from the real world. This focus helps inexperienced users quickly grasp how the program works. Common metaphors include:

- Tapping buttons to start actions.
- Index tabs to organize similar software functionality.
- In and out boxes for sending and receiving items.
- Keyboards for text entry.

Texas Instruments uses several metaphors to convey PET system aspects that our users readily understand:

- **Backpack of binders** – The PET device is like a portable, personal backpack. Inside the student’s backpack, the student and teacher find an organized view of binders, sections, documents, and tools. This metaphor permits a student to easily organize work. For the teacher, the backpack is an organized system where learning artifacts are collected and distributed.
Backpack of binders

- **Teacher as conductor** – The teacher plans, directs, and monitors the class as an orchestra conductor. Controlling the classroom lies with the teacher — not the students or the PET technology. This metaphor is reflected in the network connectivity and the teacher’s ability to collect and distribute learning artifacts, monitor individuals or groups, and delegate work selectively.

- **Slide-sheets and overlays** – Teachers can selectively hide and reveal, annotate, and highlight information without changing the data. This metaphor is like a transparent (or solid) sheet on an overhead projector that is gradually moved away, an essential teaching act that is used in many different contexts.

- **Building construction** – This metaphor picks up on the vision for high, medium, and low levels of software integration in the PET solution. The system provides public PET APIs at various levels to meet different requirements of third-party development.

**Principles**

Principles provide a context that uses specific business criteria to rationalize basic architectural choices. Principles that TI incorporated into its GUI design include:

- **Teach it your way** – Reflection of how teachers work today, how they want to work; supports and enhances current style and ability. No aspect of a PET application should force teachers to change their teaching style. Learning tasks are not pre-scripted or pre-programmed.

- **Continuity of experience** – Technology is transparent to the student and teacher. Users have similar experiences performing tasks with and without PET. Helps integrate PET into various communities with different computer literacy levels. An example is highlighting with a marker on a page of text vs. highlighting with a stylus on a text display.
Section 2: Design philosophy

• **Can’t get lost** – Represents the features available to the user that keep them grounded in the current tasks. Key rationale is for students to associate documents with their work in the backpack, not with a filing system. English documents sent from a teacher are stored on the student device where the student expects it. The number of places where things can be saved should be minimized. Also, the Home screen makes it easy for users to navigate and always have a good point of reference. (See “Backpack of binders” on page 12.)

• **You can take it with you** – Preserves the PET device state or current student activity, so the student can immediately resume work later. The teacher (or the system) can examine or retrieve a snapshot of a student’s work to make a progress assessment, monitor the classroom system state, or update other classroom content. An additional implication involves using removable storage devices and transferring files to a student’s home computer.

Guidelines

Guidelines provide a context that uses specific business criteria to rationalize basic architectural choices, but these elements do not carry the same weight as meta-architecture principles. Guidelines that Texas Instruments incorporated into its GUI design include:

• **Footprints in the sand** – Recognizable context and trace of a student’s evolving actions and progressive performance. Supplies the teacher with a window into a student’s progressive thinking and documents for the student the crucial meta-cognitive process of reflection. Each application provides a trace or audit trail (not too fine-grained or too coarse) that is understandable by the student and teacher.

• **Understandable error messages** – Unavoidable errors must provide a descriptive, understandable message to the users.

• **Contextual user interface** – Shape of learning tasks and user’s focus provides a sense of what I can do. Key perception in the user’s mind should be the task or artifact and not the PET application. For the developers who design activities, GUI controls can be bundled to support the creation of learning tasks.
Mechanisms

Mechanisms are methods for access or communication to accomplish a system function. Mechanisms that Texas Instruments incorporated into its GUI design include:

- **Broker** – Coordinates interactions between clients and servers within and across the PET devices and teacher PC. Servers register themselves with the broker and make their services available to clients through method interfaces. Provides for process passing (vs. data or file passing) across systems through remote invocation. The ORB broker in C++ on PET device helps interaction between applications on device.

- **Drop box** – Technique to exchange medium to large amounts of data across applications. An alternate name often used is an inbox/outbox. Permits the perception of communication while one or more entities are disconnected. An example of this mechanism is the cut-paste-copy clipboard functionality. The dropbox would be used with application meta-data to implement context-sensitive, task-centric operations.

- **Whiteboard** – A communication mechanism usually suited for sharing small to medium amounts of data in real time through a common display. Permits a collaborative effort by a teacher and a small group of students.

Maximize content area

The PET application framework maximizes the area used by the client applications. In the next graphic, the application does not display a menu bar under the Title Area until the user needs one. Notice also that the display does not have a status bar at the base of the screen. A small View picker and three sets of toolbars ensure that each application has as much screen area as possible to display application-specific information.

**Note:** An example of a tiled screen is shown later to illustrate how a user can work with multiple PET applications simultaneously. (See “Tiled screen application client area” on page 41.)
Consistency

Using the Texas Instruments PET Application GUI Framework ensures that your customers have a consistent interface. TI has built the PET GUI using the Qt user interface widgets in the Trolltech™ software development libraries.

Simplicity

Using real-world metaphors is just one of several design principles TI uses to simplify the PET GUI interface. Throughout the GUI interface, functionality matches the meta-architecture principles in attempting to help inexperienced users:

- **File storage** – Backpack metaphor for storing a student’s work. Uses an alternative, simple file structure for the situation when a user has removable multimedia card for work.
- **User-rich feedback** – The PET application responds to each user action with some visible change in focus or indication that an action is started.
- **Tolerant of mistakes** – When errors occur, the user can understand the alert messages easily and take corrective action. A safety net is created by using the Undo button and warning alerts. For selective actions, a user confirms an operation before proceeding. For operations where alert warnings would impede the user’s work, the Undo button signals a reversible action.
Section 2: Design philosophy

Accessibility considerations

- **Orient the user** – Home screen always orients and prevents the user from getting lost. The user always knows where they are from visual feedback and GUI control focus indicators.

- **Single document applications** – PET presents a single application to the user. There are no overlapping application windows; each application takes up the full screen unless the user wants the applications *tiled*.

- **Predictable** – PET uses the standard GUI controls and common dialog boxes (See “Common dialog boxes” on page 71.) to foster a perception of stability with its title areas, view tabs, standard buttons, and standard toolbar locations. A finite set of user input and editing techniques helps users learn to create and edit objects quickly.

**Accessibility considerations**

Good human interface and software design can make nearly any software usable by persons with disabilities. Such software is termed accessible. The PET GUI controls make implementing accessibility very easy by providing built-in support for the assisted software and technologies. It is important to understand how these assisting technologies interact with PET applications and what third-party developers must do to provide the maximum benefit.

There are many reasons why software should be made accessible. Of course, it's the "right thing to do" because over 40 million Americans have disabilities, and they have as much (and possibly more) need to use software as the population as a whole. Business factors must also be considered, and the strongest issues involve the Americans with Disabilities Act of 1990 and Section 508 of the Federal Rehabilitation Act.

**Federal legislation**

The *Americans with Disabilities Act* of 1990 (ADA) requires employers to make reasonable accommodations for employees with disabilities. As the world has computerized, *reasonable accommodations* has been interpreted to include providing accessible software. This means that a company’s internal applications should work well with assisted technologies and that commercial applications used by the employee must work properly with assisted technologies.

Section 508 of the Federal Rehabilitation Act requires that Federal agencies’ electronic and information technology be accessible to people with disabilities, including employees and members of the public. This Act went into effect in August, 2000, and federal agencies cannot purchase or develop software or computer equipment that is not usable by individuals with disabilities. If your software is not accessible, government contracts may be difficult to acquire.

**Overview of disabilities**

What constitutes a disability is a very complex issue, so let's simplify the term. When developing PET applications to aid the greatest number of people, disabilities can be broadly categorized into sensory impairments and motor-skill impairments.

At a minimum, developers should be aware of:

- Color blindness
- Poor vision or lack of vision
Section 2: Design philosophy

Accessibility considerations

• Poor hearing or lack of hearing
• Poor usage or inability to use a mouse and keyboard

If an application is sufficient for these populations, it can work well for most disabilities. However, a significant number of people have multiple disabilities, and a solution should not be developed that aids one disability group while precluding alternatives for any other group.

Cognitive disabilities also deserve consideration, but they are not addressed. These types of disabilities impair a person’s senses in very complex ways, making the impairments difficult to quantify. However, achieving accessibility for the disabilities listed often allows a person with cognitive disabilities to effectively use the application.

Assisted technology primer

Many users cannot use standard input or output devices, so one or more assisted technologies must be installed in their computing environments. Some assisted technologies affect application design and some do not. For instance, sticky keys make it possible for a person with mobility impairments to type by pressing the Shift key (which sticks on) and subsequently pressing the letter to be capitalized with the same finger. This type of technology does not significantly affect application design.

Alternatively, other technologies need help from each application in order to perform their functions properly. When the input focus is on an application that requires input, sighted users can look at the screen near the text field and understand what information is appropriate. Non-sighted users rely on screen readers to explain the context to them, and the screen readers depend upon the applications to provide semantic information. For example, suppose a blind user presses Tab to move to an address entry field. If the application provides no accessibility information, the screen reader may only say “Editable Text,” which does not provide any user information. When the developer uses control properties supported by PET and Qt, the computer can say something more meaningful, such as “Address, Line 1.”

Tools for accessibility

• All interface components must be keyboard traversable – Many people cannot use a pointing device effectively, so this is far more important than it may appear at first glance. Pressing Tab should move the input focus from GUI control to GUI control, and + Tab should move the focus in the opposite GUI control order.

• Use shortcut keys – Most menu items should have shortcut keys, so that keyboard-only use is practical. Shortcut key are displayed on menu items. (For example, the Save command should use the shortcut key + s.)

• Use accelerators – Accelerators require the use of a modifier key, and can be activated any time the application’s window has the input focus. Commonly used functionality should always be available via an accelerator. Using accelerators greatly improves the productivity of both power users and persons with mobility impairments.

• Accessible names and descriptions – An object’s accessible name explains its purpose, and an assisted technology often presents (for example, speaks) the name of each object. A user navigating a GUI encounters many controls, so limiting the name of each control to no more than one or two words prevents information overload. For instance, the fields of an address entry form could be named Street, City, and Zip code. Assisted technology looks for a
description and finding none falls back to using the object’s accessible name. For this and other reasons, all objects must have accessible names.

- **Avoid unnecessary font or color customizations** – Manipulating an application's font can make the difference between a usable and an unusable application for a person with a visual disability.

- **Use preferences and setup to change fonts and colors** – The issue of size is obvious: a person with limited vision benefits greatly from a font that is larger than the default. In the most common case, a selection of colors with high contrast is a great benefit. A less-obvious problem is that some users can see only certain colors and may require what seem strange color combinations to make an application usable.

- **Use a dynamic GUI layout** – One of the most common mistakes made by developers is using constant values with an SDK layout manager. Using constant parameters defeats dynamic layout, and the resulting application does not adapt properly to the users’ settings.

### Testing a GUI design for accessibility

To understand how your application design affects disabled individuals, perform these tests:

- **Don't use the stylus** – Bring up each PET application window and dialog and attempt to give every control focus using only the Tab key. When you are successful, use your application without touching the stylus and verify that all features are reachable. This test is important because some users cannot use a pointing device. For example, a blind person can find the stylus and physically move it, but has no idea where the stylus is positioned on the screen. You should also verify that frequently-used functionality is directly accessible with shortcut keys.

- **Change default font and color** – Choose a font of 24-32 points and colors other than the standard default palette. Bring up each PET application view and verify that screen objects do not overlap and the colors are correct. If overlapping occurs, check the code that interacts with the PET application framework manager.

- **Use a screen reader (Optional)** – Download and install a screen reader (for example, Speakup™) that works with Linux applications. Bring up each application view and Tab to every control, verifying that you hear a reasonable GUI control description as it receives the input focus. For instance, the label of a text field should be read when the text field receives the focus, and icons should cause their names to be read. If some controls do not announce themselves properly, you need to set their accessible names.

Note: Companies that wish to market PET applications for a visually-disabled customer base, may wish to test the product with one or more screen reader applications.

### Other considerations

#### See and point

PET applications use drop-down lists (See “Drop-down lists” on page 55.) and standard dialog boxes (See “Common dialog boxes” on page 71.) to present users with selection lists. Users choose what they need; they are not forced to remember where work is stored. Users can concentrate on accomplishing tasks instead of remembering how to operate your application.
User control

When users initiate and control screen actions, they master applications by starting with simple actions and can continue more complex tasks.

Application design checklist

An excellent application interface is based on addressing these key user issues:

• Metaphors from the real world that connect the user to actual software elements.
  - Student backpack, binders, sections of a binder.
  - Tapping buttons to start an action.
• Determining who the user is.
• Determining the user’s goal.
• Making it easy to accomplish the goal.
• Making the application easy to navigate.
• Scaling the application to perform only the necessary functions.
• Creating consistency throughout the application.
• Avoiding or reducing the amount of required text entry.
• Avoiding situations that cause unnecessary errors.
User interactions

This section briefly highlights the ways a user interacts with the PET GUI using a:

- Stylus.
- Soft keyboard that displays in the lower half of the PET screen.
- External keyboard that connects with a USB connector.

Note: Unless stated, all keyboard interactions apply to both the soft keyboard and any external keyboard.

Throughout this section, the guide focuses on describing human application interactions necessary to control the PET applications and perform these actions:

- Move from one GUI element to another.
- Transfer control from one application to a second application.
- Start a command or action within an application.
- Display a selection using a toolbar menu, toolbar icon group, lists, and context-sensitive menus.
- Exchanging application information using Cut, Copy, and Paste functions.
- Correct previous actions using the Undo and Redo functions.
- Enhancing or decreasing display resolution using the two Zoom commands.
- Navigate and specify actions within common files: documents, CellSheets, and images.

Soft keyboards

The soft keyboard can duplicate all the functionality of an external keyboard. For a complete discussion of the soft keyboard appearance and functionality, refer to section 8. (See “Soft keyboards” on page 118.)

Toggling soft keyboard on and off

Show or hide the soft keyboard using the:

- **Stylus** – Tap the soft keyboard icon in the system-wide toolbar.
- **Keyboard** – Press +TAB to navigate to the system-wide toolbar. Press Tab or the Left and Right Arrows to reach the soft keyboard icon. Press Enter.

If the soft keyboard is hidden, the soft keyboard displays and the application resizes the client area. Conversely, if the soft keyboard is already displayed, these actions hide the soft keyboard and the application(s) expand to use the entire client area.
Accessibility guidelines

Many people cannot use a pointing device effectively. Making all interface components keyboard traversable is far more important than it may appear at first glance. Pressing Tab should move the input focus from GUI control to GUI control, and Shift+Tab should move the focus in the opposite GUI control order.

Mnemonics, the underlined characters that appear in menu items and on some dialog box buttons, can only be activated when the item is visible and does not require a modifier key. (For example, the user does not need to press the Alt key.) All menu items must have mnemonics, so that keyboard-only use is practical. Accelerators are displayed on menu items or buttons in parentheses after the item's text.

Single tap to open

Double tapping, and select-and-open, with the stylus is strongly discouraged in the PET design.

A single tap causes an entry to open. Tapping an entry in a list highlights the entry and then opens it directly into a more detail view.

This has some negative impact on other tasks. For example, you need open a file before you can perform any action on it — such as send it or delete. This is an intentional design trade-off; the open-view-close task is expected to be the dominant interaction stylus task for PET.

Entries are highlighted only during a stylus tap or by pressing a hardware key. On stylus up, some action occurs — whether the context is a list view, a text button, a tab, or a direct navigation link in the help screens. The entry must always visually highlight, even if it is tapped very briefly.
Section 3: User interactions

Moving within an application

**Note:** If you have no views for your PET application, then you need only one view-specific toolbar.

**Note:** If you have views for your PET application, then the application-wide toolbar is optional.

Use `⌘+Tab` to navigate between the major screen areas: view picker, client area, application tool palettes, view-specific toolbar, application-wide toolbar, and the system toolbar:

- **View picker** – Focus should be placed on the current view. The user presses the Left and Right Arrows or Tab to navigate to a specific view-picker icon.
- **Client area** – Tab key is under control of the application. If the PET application has individual tool palettes, pressing Tab cycles through each tool before moving to the next three toolbars.
- **View-specific toolbar** – Focus should be placed on the left most item. The user presses the Left and Right Arrows or Tab to navigate to a specific toolbar item.
- **Application-wide toolbar** – Focus should be placed on the left most toolbar item. The user presses the Left and Right Arrows or Tab to navigate.
- **System toolbar** – Focus should be placed on the left most toolbar item. For navigation, the user presses the Left and Right Arrows or Tab.

**CellsSheet operations**

**Editing cell content**

In order to comply with accessibility guidelines, PET must edit the contents of a cell using only the keyboard. (See “**Accessibility considerations**” on page 16.)
To achieve this, there are two cellsheet operation modes: navigation and input. Pressing Enter toggles between these two modes.

To change from navigation to input mode:

- **Press Enter** – If a user is navigating through the cell grid with Arrow Keys and wants to access and edit a specific cell contents. If the cell has content, it displays in the input line, is selected, and displays in reverse video. If the cell does not have content, the cursor displays in the input line.

- **Start typing** – This action replaces any existing content in a given cell with the characters typed.

- **Tap the input line** – The cursor is displayed at the tap location.

**Note:** Pressing Left and Right Arrows should navigate within the input line and not the cell grid when in input mode.

To change from input to navigation mode, the user can:

- Press Enter.
- Press Tab.
- Press the Up or Down Arrows,
- Tap a different spreadsheet cell.

### CellSheet table scrolling and paging

To quickly navigate through the cellsheet rows and columns, PET applications must support scrolling and paging through the cellsheet.

**Scrolling**

**Stylus:** Vertical scrollbars are always present with the cellsheet. To scroll, the user taps the scrollbar arrows. Scrolling moves the focus by a single row or column.

**Keyboard:** The user moves the selection using the Tab, Enter, or Left and Right Arrows. Unlike the stylus interaction, Arrow scrolling does move the current selection. Scrolling moves the focus by a single row or column.

**Paging**

**Stylus:** To page, the user taps in the trough above or below the knob. The currently selected cell should not change. For Page Down, the last row displayed becomes the first row. For Page Up, the first row displayed becomes the last row. For Page Left, the first column becomes the last column. For Page Right, the last column becomes the first column. The last row and last column can be partially shown. The first row and first column must be fully shown.

**Keyboard:** Press ← Up Arrow to page up and → Down Arrow to page down. Unlike the stylus interaction, Arrow paging does move the current selection. For Page Down, the last row displayed becomes the first row. For Page Up, the first row displayed becomes the last row. The last row can be partially shown. The first row must be fully shown.
Section 3: User interactions

Section 3: User interactions

Pre-production Beta v1.4 release

Start a command or action

There is no mechanism to Page Left or Page Right using only the arrow keys.

Start a command or action

All PET application commands and actions start from a menu, toolbar icon, or a dialog box button.
The default button of most dialog boxes applies the dialog box settings to the application.

Tap and hold - display context menus

To display a context-sensitive menu for an application object, the user taps the object and holds
the stylus down. A context menu displays with functionality appropriate for the object. Most
context-sensitive menus should have these menu items:

- **Cut, Copy, and Paste** – Standard clipboard operations possible.
- **Delete (Clear)** – Remove object from the PET application.
- **Insert <Object Name>** – Create a new object from the PET application.

Examples of context-sensitive menus for cells in a PET spreadsheet application might be:

**Cell(s)**

A tap and hold on an individual cell or range of selected cells produces a context-sensitive menu
containing items: **Cut, Copy, Paste, Delete**, and **Insert Cell**.

**Row(s)**

Tap and holding the stylus on an individual row header or range of selected rows produces a
context menu containing: **Cut, Copy, Paste, Delete**, and **Insert Row**.

**Column(s)**

Tap and holding the stylus on an individual column header or range of selected columns produces
a context menu containing: **Cut, Copy, Paste, Delete**, and **Insert Column**.

Making a selection

Single selection and multiple selection
Section 3: User interactions

Select All functionality

**Stylus Method**

Tap the application icon located in the title area to display the menu. Access the Select All menu item under the Edit menu. Display an animated black and white dashed line around the entire Image.

**Keyboard Method**

Press the Menu hard key or +m on the QWERTY to access the menu. Use the cursor keys to access the Select All menu item under the Edit menu. Press the enter key to select it. Display an animated black and white dashed line around the entire Image. Press Enter. Alternatively, press +a on the soft keyboard as a shortcut key.

Stylus selections

**Drop-down and list box item selection**

The developer chooses the number of list columns and its selection mode — single selection or extended selection.

**Single selection**

Tap on the desired drop down list. A single tap on a list item selects the choice corresponding to the desired location.

**Extended selection**

Perform extended selection by holding down the key and tapping subsequent selections. Tapping an item without pressing the key selects the item and unhighlights all previous selections.

Keyboard selections

**Drop-down list and list box item selection**

The developer chooses the number of list columns and its selection mode — single selection or extended selection.

**Extended selection**

Perform extended selection by holding down the key and tapping subsequent selections. Tapping an item without pressing the key selects the item and unhighlights all previous selections.
CellSheet elements

**Cells**

**Stylus:** Tap the desired cell to select it. Update the display. The contents of the selected cell display in the entry line.

**Keyboard:** The user can select a cell by navigating to it using the Arrows or Tab key. Tab always moves one cell to the right. Backward tab always moves one cell to the left. When the right end of a row is reached, tab does nothing. When the left end of a row is reached, back tab does nothing. The Up Arrow always moves one cell up. The Down Arrow always moves one cell down. There is no top or bottom to columns; they appear to the user as infinite. When in navigation mode (not editing the independent value), the Left and Right Arrows behave like Tab and back Tab. The selected cell contents display in the entry line.

**Cell rows**
### Stylus:
Tap the row number to select an entire row. To select multiple rows, drag over the desired row numbers. The row that receives the Stylus Down event is the anchor point. The drag can move up or down the screen. The row that receives the Stylus Up event is the other selection boundary. Alternatively, the user may tap on a given row number then ⌃+tap on a second row. All of the rows between and including the originating row and the ⌃+tap row are selected.

### Keyboard:
Navigate to the desired header cell containing the row number. This selects the entire row. To select multiple rows, the user must hold down the soft keyboard Shift and press the Up or Down Arrows to extend the selection. The only way to accomplish a discontinuous selection is to use the Edit > Select menu command.

### Cell columns

**Stylus:** Tap the column letter to select an entire column. To select multiple columns, drag the stylus over the desired column numbers. The column that receives the Stylus Down event is the anchor point. The drag can move left or right. The column that receives the Stylus Up event is the other selection boundary. Alternatively, the user can tap a given column letter, then ⌃+tap a second column. All columns between the originating column and the ⌃+tap column are selected. The only way to accomplish a discontinuous column selection is use a Selection.

**Keyboard:** Navigate to the desired header cell containing the column letter. This selects the entire column. To select multiple columns, the user must hold down the soft keyboard Shift and press the Up or Down Arrows to extend the selection. The only way to accomplish a discontinuous selection is to access the Edit > Select menu command.

### Graphic object selection

In an image editing application, a user must sometimes define the boundaries of a graphical object. Using the stylus, a user can define two points that indicate a shape’s dimensions. Unfortunately, there is no way to perform this operation with a keyboard.

**Precondition:** The user must first navigate to the portion of the application using the View picker tabs and view-specific toolbars to select the appropriate function.
Section 3: User interactions

Two-point tap method

The user presses the \textbullet or \texttt{Shift} key and touches the stylus to the screen. This is the starting point of the object. The user drags the stylus across the PET screen. An object (with the user specified attributes) is dynamically drawn between the starting point and the final stylus position. The user selects the final point of the object by lifting the stylus from the screen.

Tap-drag-lift method

The user presses the \textbullet or \texttt{Shift} key and taps the screen to indicate the starting point (corner) of the object. The user then taps a second point on the PET screen. This is the opposite corner of the object. Immediately after the second tap, an object (with the user specified attributes) is drawn between the starting corner and second tap position.

Exchanging information between applications

Information from application objects (documents, images, CellSheets, and so forth) can be exchanged using the PET system Clipboard. Users can perform the same Cut, Copy, and Paste operations they perform on a standard Windows PC with the PET applications. These common operations should be part of the standard PET application menu bar or selection view. (See “Suggested standard menu layout” on page 117.)

Cut

Precondition: The Cut menu item is active when an application selects (highlights) at least one object.

Stylus

Tap the small application icon in the title area. When the menu displays, tap the Cut menu item under the Edit menu. Alternatively, tap the application’s Selection view tab (if it exists). Tap the Cut icon \textbullet on the view-specific toolbar to store the highlighted object on PET system Clipboard and remove it from the client area.

Keyboard

Press the Menu hard key or \textbullet+m on the soft keyboard to access the Edit menu. Use the Up and Down Arrows to select the Cut menu item. Press Enter. Alternatively, press \textbullet+x on the soft keyboard as a shortcut key. Alternatively, press the \textbullet+Tab sequence, Tab and Up, and Down
Section 3: User interactions
Pre-production Beta v1.4 release  Exchanging information between applications

Arrows to navigate to the Cut icon located in a Selection view-specific toolbar. Press Enter to remove the highlighted object from the client area and store it on PET system Clipboard.

Copy

Precondition: The Copy menu item is active when an application selects (highlights) at least one object.

Stylus

Tap the small application icon in the title area. When the menu displays, tap the Copy menu item under the Edit menu. Alternatively, tap the application’s Selection view tab (if it exists). Tap the Copy icon on the view-specific toolbar to store the highlighted object on PET system Clipboard and leave it highlighted in the client area.

Keyboard

Press the Menu hard key or +m on the soft keyboard to access the Edit menu. Use the Up and Down Arrows to select the Copy menu item. Press Enter. Alternatively, press +c on the soft keyboard as a shortcut key. Alternatively, press the +Tab sequence, Tab and Up, and Down Arrows to navigate to the Copy icon located in the Selection view-specific toolbar. Press Enter to leave the object highlighted in the client area and store it on PET system Clipboard.

Paste

Precondition: The Paste menu item is active when a valid data type (appropriate for this application as dictated by the application database) exists on the PET system Clipboard.

The application places the data in the client area at a location that is application dependent:

- Image editor – May put the data in the image’s upper, left-hand corner by default.
- Document editor – Would insert the data at the current focus location.
- CellSheet application – Insert the data into the highlighted cell(s).

Stylus

Tap the small application icon in the title area. When the menu displays, tap the Paste menu item under the Edit menu. Alternatively, tap the application’s Selection view tab (if it exists). Tap the Paste icon on the view-specific toolbar to copy the object from the PET system Clipboard to the pre-defined location in the client area.
Section 3: User interactions

Preventing or removing actions

Keyboard

Press the **Menu** hard key or **+m** on the soft keyboard to access the **Edit** menu. Use the Up and Down Arrows to select the **Paste** menu item. Press Enter. Alternatively, press **+v** on the soft keyboard as a shortcut key.

Alternatively, press the **+Tab** sequence, Tab and Up, and Down Arrows to navigate to the **Paste** icon located in the Selection view-specific toolbar. Press Enter to copy the object from the PET system Clipboard to the pre-defined location in the client area.

Preventing or removing actions

Cancel an action

For most of the common PET dialog boxes, the second button usually cancels the dialog box settings and does not apply them within the application.

Cancel a dialog box action using the:

- **Stylus** – Tap **Cancel** to stop the operation.
- **Keyboard** – Press Tab to navigate to the **Cancel** button. Press Enter to cancel the operation. Alternatively, press **Escape** or **+`** (apostrophe key) on the soft keyboard as a shortcut.

Undo and Redo actions

PET applications can contain an application-wide toolbar that supports object selection, Zoom-out, Zoom-in, Undo previous action, and Redo last Undo action functionality. Third-party developers must decide which functions can be undone or re-done with each application. Only the most recent application action can be undone or re-done.

*Stylus*

Tap the ** Undo** or ** Redo** icon located on the application-wide toolbar. Undo or Redo the last action. The icon changes to the ** Redo** icon if an Undo action is performed. If a Redo action happens, the icon reverts to the ** Undo** icon. As soon as another different action is performed by the user, change the icon to the ** Undo** icon.
Alternatively, tap the small title area icon to display the menu. Tap the **Undo** or **Redo** menu item under the **Edit** menu. Undo or redo the last action. Change the label of the menu item to **Redo** if it started as **Undo** or **Redo** if it started as **Redo**. As soon as another action is performed by the user, change the label to **Undo**.

**Keyboard**

Press the Menu hard key or 2+m on the soft keyboard to access the menu. Press the Up and Down Arrows to access the **Undo / Redo** menu item under the **Edit** menu. Press Enter. Undo or redo the last action. Change the menu item label to **Redo** if it started as **Undo**. Change it to **Undo** if it began as a **Redo** menu item. As soon as another action is performed by the user, change the label to **Undo**. Alternatively,

Alternatively, use these shortcut keys:

- **⌘+y** – Redo the action done before an Undo action.
- **⌘+z** – Undo the previous action.
- **⌘+Tab sequence, Tab key, and Arrows** – Navigate to the **Undo / Redo** icon located in the application-wide toolbar. Press Enter to activate the button.

**Enlarging and reducing application display resolution**

PET applications can contain an application-wide toolbar that supports Selection, Zoom-out, Zoom-In, Undo, and Redo functionality.

**Stylus Method**

Tap the **Zoom-in** or **Zoom-out** icons on the toolbar. This zooms the image through the following image sizes — 25%, 50%, 100%, 200%, 300%, and 400%. Alternatively, tap the small application icon located in the title area to display the menu. Access one of those numbers from the cascade menu under the **View > Zoom** command. The user can also access the **Custom** menu item from the cascade menu under the **View > Zoom** command. This displays the Custom Zoom dialog.

**Keyboard Method**

Press the Menu hard key or 2+m on the soft keyboard to access the menu. Press the Up and Down Arrows to access one of the numbers cascade menu under the **View > Zoom** command. Press Enter. The user can also access the **Custom** menu item from the cascade menu under the **View > Zoom** command. This displays the Custom Zoom dialog.

Alternatively, press **⌘++** or **⌘--** on the soft keyboard as a shortcut **Zoom-in** or **Zoom-out**, respectively. Alternatively, use the **⌘+Tab sequence, Tab, and Arrows** to navigate to one of the Zoom icons located in the application-wide toolbar. Press Enter to activate the button.
Actions with common files

Clear

*Stylus Method*

**Precondition:** The Clear menu item is active when a valid data type (appropriate for this application as dictated by the application database) is selected.

Switch to the Selection view, if it is not the current view. Tap the Clear icon located on the toolbar. Alternatively, tap on the small application icon located in the title area to display the menu. Then, the user may access the Clear menu item under the Edit menu.

*Keyboard Method*

**Precondition:** The Clear menu item is active when a valid data type (appropriate for this application as dictated by the application database) is selected.

Press the Menu hard key or 2+m on the soft keyboard to access the menu. Press the Up and Down Arrows to access the Clear menu item under the Edit menu. Press Enter to remove the object from the selected location in the client area.

Alternatively, press DEL on the soft keyboard as a shortcut key.
Application framework

Within the PET application framework section, you can find information about:

- Application screen GUI controls.
- Multiple applications exchanging screen control (multitasking) to perform tasks.
- Rules employed by users to connect to a central network device. (To be added.)

Note: Third-party developers that use the PET Software Developers Kit receive a library of GUI control widgets that behave similar to Qt Widgets. (See “PET GUI control behavior and Qt widgets” on page 69.) See the PET Application SDK Reference Guide for a complete list.

Application screen

For PET applications, developers maximize the application client area. PET application screens consist of GUI controls that control the application functions and take up a minimum of screen space:

- Title bar – Title area (mandatory) and view picker (optional).
- Menu bar.
- Client area.
- Application-specific tool palettes.
- Toolbars – View-specific, application-wide, and system.
- Toolbar icon groups (optional).

Note: If you have no views for your PET application, then you need only one view-specific toolbar.
Note: If you have views for your PET application, then the application-wide toolbar is optional.

Moving among major screen controls

Press the $\text{Shift} + \text{Tab}$ to move among the major application screen elements. The Tab navigation order is (1) view picker, (2) client area, (2a) application specific tool palettes, (3) view-specific toolbar, (4) application-wide toolbar, (5) system toolbar, and starting-over with the view picker.

Title bar

Every application must have a title bar, composed of a title area and an optional view picker. It has a tab widget image background, contains a two-state application icon button, and has a label.

Display the title label in a 12-point, bold, black, sans-serif font. The label may contain any text string, but Texas Instruments suggests that it contain one of these titles:

- Currently opened document name.
- Application name.
- Name of the view selected (group of application functions).

The view picker icons (optional) represent views or groups of similar application functions. Each view can alter the contents of the client area, the menu, and the toolbar. While there is no maximum number of views, only 17 can be shown on the title bar. If more than 17 views exist, scrolling arrows should be included at each view picker end. The scrolling arrows limit the number of views to 15, which can be displayed at one time.

The title area should grow to accommodate its contents, but preference must be given to the view picker. The view picker should negotiate its space first, with any remaining space provided to the title area. If the label contents exceed the title area size, the text should be truncated and ellipses (…) appended.

States

Each part of the title bar exhibits specific GUI control states. (See "GUI control states" on page 48.)

<table>
<thead>
<tr>
<th>Title bar element</th>
<th>GUI states</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title bar background</td>
<td>No states</td>
<td>The background is light blue and is lined on the bottom with gray.</td>
</tr>
<tr>
<td>Title area background</td>
<td>No states</td>
<td>The visual treatment is the same as a tab widget.</td>
</tr>
<tr>
<td>Title area icon button</td>
<td>Same states as a two-state icon</td>
<td>Same visual treatment as a two-state icon button. Contains the small application icon.</td>
</tr>
<tr>
<td>Title area label</td>
<td>No states</td>
<td>12-point, bold, black, sans-serif font.</td>
</tr>
</tbody>
</table>
Behavior

The title area icon button shows and hides the menu bar. When the menu bar is first shown, it should automatically display the first menu.

Tapping a view picker icon changes its state to On. All other view picker icons revert to the Up state. The menu, client area, and toolbar should be updated accordingly.

Menu bars

The menu bar is visually attached to the title bar. It is composed of a series of two-state menu buttons on a background. The menu buttons contain text in a normal, black, 10-point sans-serif font.

Note: The menu bar overlays the application's client area and the client area does not resize to accommodate it.
States

<table>
<thead>
<tr>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>The basic look for a menu button. (All examples reference the File button.)</td>
</tr>
<tr>
<td>On</td>
<td>The button has the same visual treatment as a two-state text button in the On state. On the menu bar, only one menu button can be on. When the button is on, the menu displays.</td>
</tr>
</tbody>
</table>

Behavior

Tapping a menu button in the Up state turns it On and displays the associated menu. All other menu buttons must be in the Up state and no other menus should display. Tapping a menu button in the On state takes that button to the Up state and hides the associated menu.

The user presses Left and Right Arrows to navigate between menu buttons.

Menus

Menus are similar to list boxes. (See “Lists” on page 54.) Only one menu can be displayed at a time. When a menu first displays, nothing is selected. When a user selects a menu item, the command action is performed and the menu and menu bar are dismissed.

Menus can contain icons, text, cascade arrows, separators, and shortcut key identifiers. (See “Shortcut keys” on page 115.)
States

<table>
<thead>
<tr>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up (Note the New menu item.)</td>
<td>This menu item is not in focus or selected.</td>
</tr>
<tr>
<td>In Focus (Note the Open menu item.)</td>
<td>This menu item is in focus, with the blue background and white text.</td>
</tr>
</tbody>
</table>

Behavior

Menu behavior is similar to a list box. However, to select a menu item with the Up or Down Arrows, the user must press Enter after navigating to the menu item selected.

Client area

The PET application completely controls the client area. The default background color should be white.

Toolbars

Every application must have a toolbar. If an application has views, then the toolbar is divided into the view-specific, the application-wide, and the system toolbars. The application-wide toolbar is optional.

The toolbar background gradient colors are:

- **Gray** – View-specific toolbar.
- **Blue** – Application-wide toolbar.
- **Green** – System toolbar.

The system toolbar is always right-justified and the view-specific toolbar is left-justified. The application-wide toolbar is right-justified, but to the left of the system toolbar.

If an application does not have views, then it only contains the application-wide and system toolbars. The application-wide toolbar is left-justified and the system toolbar is right-justified. The toolbar can contain single-state icon buttons, two-state icon buttons, and toolbar icon groups. It can also contain menu buttons and toolbar text buttons. Toolbar text buttons look like menu buttons, but they perform a command vs. displaying a menu.
States

<table>
<thead>
<tr>
<th>Toolbar background</th>
<th>GUI states</th>
<th>Background color</th>
</tr>
</thead>
<tbody>
<tr>
<td>View-specific</td>
<td>No states.</td>
<td>Gray gradient.</td>
</tr>
<tr>
<td>Application-wide</td>
<td>No states.</td>
<td>Blue gradient.</td>
</tr>
<tr>
<td>System</td>
<td>No states.</td>
<td>Green gradient.</td>
</tr>
</tbody>
</table>

Behavior

When a toolbar contains more items than can fit on a single line, the toolbar should expand to two lines. The different portions of the toolbar should negotiate for space accordingly.

Toolbar icon groups

A toolbar icon group consists of two parts: a selection icon on the left and a current choice icon on the right. In the next example, the user needs to choose what type of shape (square, rounded rectangle, or circle) to draw. The icon on the left tells the user they are dealing with shape functionality. The choice icon on the right represents the specific shape chosen (circle) or the application default shape.
States

<table>
<thead>
<tr>
<th>Appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Collapsed</td>
<td>Toolbar icon group's normal appearance. The choice icon indicates the function or attribute selected. When the application displays, each tool bar icon group has a default choice.</td>
</tr>
<tr>
<td></td>
<td>Expanded</td>
<td>The icon group expands to show all possible choices (shape group only).</td>
</tr>
</tbody>
</table>

Behavior

When the user taps the right icon, the toolbar icon group expands. Then, the user taps a selection and the group collapses. The chosen icon displays in the collapsed icon group.

Multiple application management (multitasking)

Switching control between multiple applications on the PET device involves controlling what portion of the screen's client area each application can occupy. The PET soft keyboard also competes for screen space. (See “Soft keyboards” on page 118.)

Application menus

Different menu structures are used for applications that permit multiple instances (for example, editing two different documents at the same time) and for applications that permit a single instance.

Multiple instance applications have two additional menu commands: a command to open an existing file in the new instance, and a command to start a new instance with a blank file. The exact command wordings are being tested, but a current suggestion is Open File in New Screen and New File in New Screen. Neither command has a keyboard shortcut. The precise menu structure for a given application can be found in that application’s GUI Design Document.

Multitasking controls which application gets focus. When the user chooses to display the menu (either by tapping the title area application icon, pressing the Menu hard key, or tapping \texttt{\textasciitilde m} on the soft keyboard), that application's menu is displayed.

Application title area

Multitasking does not modify the application, or home screen title areas. However, it does control which application gets focus. The title area for the application in focus is the title that displays.
Multitasking and the application toolbar

The application toolbar is composed of three parts: view-specific items (grey background), application-wide items (blue background), and system items (green background). The system toolbar contains multitasking task switcher icon . Multitasking does not modify the application-wide portion of the toolbar. It does control which application currently has focus. The application-wide toolbar for the application in focus displays. The view-specific toolbar is unaffected by multitasking, but the application that gets focus is displayed. The view-specific portion of the toolbar for the application in focus displays.

Full screen application client area

When the PET device is in full screen mode, the application controls the client area and displays information in a 276 (h) x 480 (w) pixel area.

Full screen Tab navigation

Use + to navigate among the major screen areas: view picker, client area, view-specific toolbar, application-wide toolbar, and the system toolbar. (See “Moving among major screen controls” on page 34.)

- **View picker** – Focus should be placed on the current view. The user presses the Left and Right Arrows or Tab to navigate to a specific view-picker icon.
- **Client area** – Tab key is under control of the application.
- **View-specific toolbar** – Focus should be placed on the left most item. The user presses the Left and Right Arrows or Tab to navigate to a specific toolbar item.
- **Application-wide toolbar** – Focus should be placed on the left most toolbar item. The user presses the Left and Right Arrows or Tab to navigate.
- **System toolbar** – Focus should be placed on the left most toolbar item. For navigation, the user presses the Left and Right Arrows or Tab.
Use ‿ Left or Right Arrows to cycle through the opened files and applications.

**Tiled screen application client area**

When the PET device is in the tiled mode, each application controls only half the client area and displays information in a 272 (h) x 236 (w) pixel area. The screen client area is divided into two application-controlled client areas, with a 2-pixel focus rectangle around each area.

![](image)

Two applications displayed in tiled mode. The Image Editor has focus and the CellSheet is visible.

**In Focus application**

A focus rectangle surrounds the In Focus application. The focus rectangle is a black, 2-pixel thick outline. This application's title area and toolbar should display.

**Visible, but not in focus, application**

The Visible application is displayed without a focus rectangle, leaving a 2-pixel area surrounding the application that does not display, but remains reserved for the focus rectangle. This area should display in white.

**Tiled screen Tab navigation**

Use ‿ Tab to navigate among the major screen areas: view picker, client area, view-specific toolbar, application-wide toolbar, and the system toolbar. (See “Moving among major screen controls” on page 34.)

- **View picker** – Focus should be placed on the current view. The user presses the Left and Right Arrows or Tab to navigate to a specific view-picker icon.
- **Client area** – Tab key is under control of the application.
- **View-specific toolbar** – Focus should be placed on the left most toolbar item. The user presses the Left and Right Arrows or Tab to navigate to a specific toolbar item.
Section 4: Application framework

• **Application-wide toolbar** – Focus should be placed on the left most toolbar item. The user presses the Left and Right Arrows or Tab to navigate.

• **System toolbar** – Focus should be placed on the left most toolbar item. For navigation, the user presses the Left and Right Arrows or Tab.

**Note:** In this sequence, focus is not placed on the visible file, only the file that has focus.

Use † † Left and Right Arrows to switch focus between the currently in focus file and the visible file.

**Task switcher**

The task switcher is essentially a shortcut menu. It contains an item on its menu for every PET file and application that is currently open on the PET device. Next, it contains the menu item to change the device between full screen and tiled display modes. Finally, it contains a menu item to view the Home screen. As stated earlier, the task switcher icon is located in the system toolbar. This ensures that it is available to every PET application. The icon is a two-state icon button.

**Organization of file and application menu items**

Each file or application entry in the task switcher menu has:

• **Small application icon** – Represents the application displaying the file. Always displays in the first position.

• **File name** – If the application does not use files, display the application name.

• **Close button** – The right most item in the task switcher.

**Notes about task switcher menu items**

The file and application entries list in the order that they last received focus. The item that currently has focus is listed at the top of the task switcher menu.

The file or application currently in focus is displayed in bold and should be the default selection when the task switcher displays. It should have a medium blue (R51, G153, B255) background and a 1-pixel, black border.

In tiled mode, the file or application entry that is visible, but not in focus, is displayed in italics and should have a light blue (R217, G234, B254) background.
Home Screen menu item

The first item is the Home screen icon, followed by the Home Screen label. The entry does not have a Close icon.

Setup tiled screen dialog box

When an application is in full screen mode, this menu item reads Setup Tiled Screen. When the application is tiled, this menu item reads Revert to Full Screen. The menu item text should align with the file name’s left margin. It has no associated icon or close button. If the device cannot be put into tiled mode (there are currently less than two files and applications open, in addition to the Home screen), the Setup Tiled Screen menu item should be made unavailable.

The dialog title is Setup Tiled Screen. In the control area are two labels (Left Side and Right Side), with associated drop-down lists. The Left Side drop-down list displays the icons and names of all currently open device files and applications. The file or application that is currently in focus is the selected value.

The Right Side drop-down list displays the icons and names of all currently open device files and applications. The entry corresponding to the selection in the first drop-down should be unavailable (grayed-out). The selected value is the file or application that previously had focus.

If the user chooses the same entry in the first drop-down list that is selected in the second drop-down list, update the second drop-down list to display a different file or application and gray out the previously selected entry.

The command area has two text buttons. The Tile button (default) and the Cancel button.

Starting a new task

To start a new task in the PET application framework, use the Home screen or applications that allow multiple instances of themselves. For specific ways to perform these tasks (for example, launching an application, opening a file in a new screen, starting a new file in a new screen, and so forth), refer to the appropriate GUI Design Document.

Affect upon the task switcher

In a full screen mode, show the new opened file or application full screen in place of the file that had focus. Update the task switcher to add a corresponding menu item at the top of the list. Update focus rectangle for the selected application or file.
In a tiled mode, replace the file or application having focus with the new one. Leave the visible file alone. Update the task switcher to add a menu item corresponding to the newly opened file at the top of the list. Update focus rectangle for the selected application or file.

Multitasking functions

The task switcher shortcut menu supports switching between PET applications and controlling the display on the screen. You can use a stylus or the keyboard to perform these commands.

- **Display the current task list** – Display all active applications and open files using the task switcher shortcut menu.
- **Switch view to an open but hidden file** – Display an open file that is hidden by selecting it from the switcher shortcut menu.
- **Switch the view to the shown, but not in focus, file** – Display an open file that does not have focus by selecting it from the task switcher menu.
- **Switch the view to the Home screen** – Use the task switcher menu to display the Home screen in full screen mode.
- **Put device in tiled mode** – Display two applications or files side-by-side in tiled mode.
- **Put device in full screen mode** – Display a selected application or file in full screen mode.
- **Close a file or quit an application with switcher** – Use the switcher shortcut menu to close (quit an application.)
- **Close a file or quit an application from within the application** – Use the application’s File menu to close or quit the application. The multitasking display must then adjust accordingly.

**Display the current task list**

Display all the applications and open files using the:

- **Stylus** – Tap the task switcher icon in the system toolbar.
- **Keyboard** – Press `2+Tab` to navigate to the system-wide portion of the toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select and display the task switcher.

The task switcher shortcut menu displays.

**Switch view to an open but hidden file**

The application to be replaced by the new file should be in focus. In the case where the PET device is not tiled, the visible application should have focus.

Switch the view to a file or application that is open and hidden by using the:

- **Stylus** – Tap the task switcher icon in the system toolbar. The task switcher menu displays. Tap the desired file name.
- **Keyboard** – Press `2+Tab` to navigate to the system toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select it and display the task
Section 4: Application framework

Pre-production Beta v1.4 release

Multiple application management (multitasking)

switcher shortcut menu. Press Up and Down Arrows to highlight the desired file name. Press Enter to select it.

The task switcher menu dismisses and the newly chosen file replaces the application in focus. Update the title area, referenced menu structure, client area, and toolbar accordingly. The task switcher menu is updated to show the chosen file at the top of the list (has focus).

In the full screen mode, a user can also use ⌃ + Left or Right Arrow to cycle through the currently open files.

Switch the view to the shown, but not in focus, file

Precondition: The device screen must be in tiled mode.

Switch the view to a file or application that is shown, but lacks focus, by using the:

- **Stylus** – Tap the file shown, but without focus on screen. Alternatively, tap the task switcher icon in the system toolbar. The task switcher menu displays. Tap the name of the file shown, but without focus.

- **Keyboard** – Press ⌃ + Left or Right Arrow. Alternatively, press ⌃ + Tab to navigate to the system toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select and display the task switcher menu. Press Up and Down Arrows to highlight the name of the shown, but not in focus, file. Press Enter.

The task switcher menu dismisses and the focus switches to the other side of the screen. Update the title area, referenced menu structure, client area, and toolbar accordingly. The task switcher menu is updated to show the chosen file at the top of the list (has focus). The previous file loses the focus rectangle display.

Switch the view to the Home screen

Switch to the Home screen view using the:

- **Stylus** – Tap the task switcher icon in the system toolbar. The task switcher menu displays. Tap Home Screen.

- **Keyboard** – Press ⌃ + Tab to navigate to the system toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select and display the task switcher menu. Press Up and Down Arrows to highlight the Home Screen entry. Press Enter.

The task switcher menu dismisses and the device displays the Home screen on the entire screen. Update the title area, referenced menu structure, client area, and toolbar accordingly. The task switcher menu is updated to show the Home screen has focus.

The above scenario happens in tiled or full screen mode when a user selects the Home screen. The Home screen always displays as a full screen. Note, viewing the Home screen does not alter the device mode. If the device is in tiled mode when the Home screen is chosen, it does not revert to full screen unless there is only one remaining file or application. It displays the Home screen in full screen. Then, when the user chooses a file to view (using the Home screen or the task switcher), the device displays the screen as tiled. The chosen file is displayed as the file in focus and the file that was last marked as visible, but not in focus, also displays on screen.
**Put device in tiled mode**

**Precondition:** The device must start in full screen mode and at least two files must be open.

Place the PET device in tiled mode by using the:

- **Stylus** – Tap the task switcher icon in the system toolbar. The task switcher menu displays. Tap the **Setup Tiled Screen** menu item. (See "Setup tiled screen dialog box" on page 43.)

- **Keyboard** – Press ⌘+Tab to navigate to the system toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select and display the task switcher menu. Press Up and Down Arrows to highlight the **Setup Tiled Screen** menu item. Press Enter.

Display the Setup Tiled Screen dialog. If the user chooses to proceed with the operation, the device goes into tiled mode. The display is updated to show the two files side-by-side. The left file has focus by default. The title area, referenced menus, and toolbar should be updated as needed to reflect the file in focus.

The **Setup Tiled Screen** item for the task switcher menu changes to **Revert to Full Screen**. The visual indicators in the task switcher menu show the left file as having focus and the right file as the viewable one.

**Put device in full screen mode**

**Precondition:** The device must start in tiled mode.

Display a single application or file in full screen mode by using the:

- **Stylus** – Tap the task switcher icon in the system toolbar. The task switcher menu displays. Tap **Revert to Full Screen** menu item.

- **Keyboard** – Press ⌘+Tab to navigate to the system toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select and display the task switcher menu. Press Up and Down Arrows to highlight the **Revert to Full Screen** menu item. Press Enter.

Dismiss the task switcher menu. The display is updated to show the application in focus on a full screen. The **Revert to Full Screen** menu item under the task switcher menu changes to **Setup Tiled Screen**. The visual indicators in the task switcher menu are updated to remove the viewable, but not in focus, indicator.

**Close a file or quit an application with switcher**

Close a file or application using the task switcher menu by using the:

- **Stylus** – Tap the task switcher icon in the system toolbar. The task switcher menu displays. Tap the close icon ☒ to the right of the desired file name.

- **Keyboard** – Press ⌘+Tab to navigate to the system toolbar. Press Tab or Left and Right Arrows to navigate to the task switcher icon. Press Enter to select and display the task
switcher menu. Press Left, Right, Up, and Down Arrows to highlight the close icon next to the desired file name. Press Enter.

Do not dismiss task switcher menu. Notify the corresponding application to close the file or quit. An alert may need to be displayed, depending upon the application or file state.

If the chosen file or application was displayed on screen, update the display as needed. In full screen mode, show the file and application that was last displayed. If there are no files or applications open, display the Home screen. Update the shortcut menu display to reflect the file or application that has focus. The task switcher shortcut menu remains visible.

In tiled mode, show the file or application that last had focus. If that file is visible, but not in focus, apply focus to that file and make the previous file that had focus visible. If only one file remains in the task men after the close operation is completed, revert to full screen mode and display the file.

Close a file or quit an application from within the application

Precondition: The referenced file is shown and has focus. Refer to the application-specific GUI Design Document for the actual method to quit the application or close the file.

In the full screen mode, show the file or application that was last viewed. If there are no files or applications open, display the Home screen. Update the task switcher menu to reflect the file or application that has focus.

In the tiled mode, show the file or application that previously had focus. If that file is visible, but not in focus, place that file in focus and make visible the next file on the task switcher shortcut menu that was last in focus. If there is only one file on the task switcher menu after the close operation is completed, revert the device to full screen mode and show that file.
User interface controls

This section specifies the desired visual characteristics and behaviors for the Graphical User Interface (GUI) controls used for a TI PET application. Each control has behaviors that define an expected control response to specific user action.

GUI control interaction

Users can navigate to these GUI controls and activate them with:

- A stylus.
- PET hard keys.
- A virtual or soft keyboard.
- An external keyboard.

Warning: Several of the GUI controls use an image as part of the user interface element. Each of these GUI controls images (usually icons) has a size limitation. For a list of artwork limitations, consult the last section of this style guide. (See “Application image limitations” on page 117.)

GUI control states

Throughout the PET Application GUI Style Guide, the following terminology describes the possible control states that define the GUI control’s appearance to the user. (See “Examples of GUI control states” on page 49.)

- **Up** – Basic state for all controls. The user is not interacting with the GUI control or the control’s associated command is not applied. Also, the user has not selected any elements of the control. The **Up** state is the same as **Off** for controls that toggle between two states.

- **Up In Focus** – Similar state to **Up**, except the GUI control indicates it has focus by displaying a black border (highlighting). To select this control the user must navigate to it with the hard keys. This state indicates that the associated control command is currently applied or the control’s element is selected.

- **On** – The associated control command is currently applied or the user selected the control element.

- **On In Focus** – Similar state to **On**, except the GUI control indicates it has focus by displaying a black border (highlighting). To select this control the user must navigate to it with the hard keys.

- **Down** – Feedback to the user that the control is currently tapped with the stylus or activated with hard keys.

- **Unavailable** – A command associated with this control is not available due to the current system state.
Section 5: User interface controls

Examples of GUI control states

This table illustrates several PET GUI controls (single-state buttons, drop-down lists, spin boxes) and shows how each control’s appearance changes with its active state.

<table>
<thead>
<tr>
<th>Up State (basic state)</th>
<th>Up In Focus State</th>
<th>On State</th>
<th>On In Focus State</th>
<th>Down State</th>
<th>Unavailable</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>OK</td>
<td>not applicable</td>
<td>not applicable</td>
<td>OK</td>
<td>OK</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Image Editor</th>
<th>Image Editor</th>
<th>Image Editor</th>
<th>Image Editor</th>
<th>Image Editor</th>
<th>Image Editor</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Calculus</th>
<th>Calculus</th>
<th>Calculus</th>
<th>Calculus</th>
<th>Calculus</th>
<th>Calculus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algebra</td>
<td>Algebra</td>
<td>Calculus</td>
<td>Calculus</td>
<td>Calculus</td>
<td>Calculus</td>
</tr>
<tr>
<td>Geometry</td>
<td>Geometry</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| 1.023         | 1.023        | not applicable | not applicable | 1.023       | not applicable |

Overview of buttons

PET GUI buttons are classified as:

- Text buttons.
- Icon buttons.
- Icon and Label buttons.
Text buttons

Text buttons typically appear in groups, permitting users to select one of a small number of commands. The buttons display against a variety of backgrounds. There are two types of text buttons: single-state and two-states.

**Single-state text buttons**

There are two versions of single-state text buttons in the Up state: Default and Normal. Default buttons are intended only for dialog boxes and should represent the *recommended* action for that dialog box. The Default button activates when the user presses Enter, even if the PET hard keys or the QWERTY keyboard did not give the button focus.

Normal buttons should be auto-default buttons — they become the default button when they receive keyboard focus. This means the button that was previously the default button becomes and acts like a Normal button.

<table>
<thead>
<tr>
<th>Single-state button appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="OK" /></td>
<td>Up (default)</td>
<td>Darker outline to distinguish it from normal buttons.</td>
</tr>
<tr>
<td><img src="image" alt="OK" /></td>
<td>Up (normal)</td>
<td>Normal text button appearance.</td>
</tr>
<tr>
<td><img src="image" alt="OK" /></td>
<td>Up In Focus</td>
<td>Solid line around the border and a darker outline to indicate focus.</td>
</tr>
<tr>
<td><img src="image" alt="OK" /></td>
<td>Down</td>
<td>Button offset two pixels down and to the right.</td>
</tr>
<tr>
<td><img src="image" alt="OK" /></td>
<td>Unavailable</td>
<td>Action command associated with the button is inactive.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

Two-state text buttons

Two-state text buttons work like check boxes; the buttons can toggle On and Off. For example, a developer may want to apply bold weight to a selected set of text. The two-state button can be set to apply bold weight or restore the text to normal weight. They are typically used in place of two-state icon buttons when text is preferred. In general, a two-state icon button should be used instead of a two-state text button.

<table>
<thead>
<tr>
<th>Two-state button appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Up</td>
<td>Normal text button appearance. Same appearance as the single-state text button Up state.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Up In Focus</td>
<td>Solid line around the border and has a darker outline to indicate focus. Same appearance as the single-state text button Up In Focus state.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>On</td>
<td>Button background changes to white and outline expands to indicate the state change.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>On in focus</td>
<td>Outline changes to black to indicate focus.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Down</td>
<td>Button offset two pixels down and to the right. Button background changes to gray. Same appearance as the single-state text button Down state.</td>
</tr>
<tr>
<td><img src="image" alt="Bold" /></td>
<td>Unavailable</td>
<td>Command associated with the button is inactive. Button text is lightened or grayed-out. Same appearance as the Unavailable state for a single-state text button.</td>
</tr>
</tbody>
</table>

Icon buttons

Icon buttons usually appear in groups and let users perform one of a small number of commands. The buttons can display against a variety of backgrounds, but most icon buttons are found on toolbars. PET supports transparent areas in the icon artwork. There are two types of icon buttons:

- Single-state – Used to invoke a command or system action. For example, the OK and Cancel buttons are single-state buttons.
- Two-state – Permits a user to control a setting that has two possible values (On and Off).

Single-state icon buttons

A single-state icon button usually accompanies a menu command or is part of a dialog box.
Section 5: User interface controls

Overview of buttons

Two-state icon buttons

A button that sets text to Italic is a typical example of a two-state button. Two-state icon buttons normally display along with single-state icon buttons within a toolbar.

Note: You cannot see color change for the Down state because the icon is against a gray background of the same color.

<table>
<thead>
<tr>
<th>Two-state icon appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Up</td>
<td>Basic button look where it has no focus or the user has not selected it.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Up In Focus</td>
<td>Indicates focus by displaying a solid line border.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Down</td>
<td>Provides visual feedback of depressed button. Border indicates the control has focus.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Unavailable</td>
<td>Action command associated with the icon is inactive and button is grayed-out.</td>
</tr>
</tbody>
</table>

Icon and Label buttons

Icon and Label buttons are used for application shortcuts. These icon buttons have an associated label that responds to the stylus with the same feedback as the icon.
PET supports transparent areas in the icon artwork. The Icon and Label buttons can display against a variety of backgrounds. PET uses single-state and two-state Icon and Label buttons.

### Single-state Icon and Label Buttons

<table>
<thead>
<tr>
<th>Single-state Icon and Label button appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Image Editor" /></td>
<td>Up</td>
<td>An icon in its basic state, with the label outlined in white, to ensure it can be displayed on multiple backgrounds.</td>
</tr>
<tr>
<td><img src="image" alt="Image Editor" /></td>
<td>Up In Focus</td>
<td>A black border encloses the label to indicate focus.</td>
</tr>
<tr>
<td><img src="image" alt="Image Editor" /></td>
<td>Down</td>
<td>Icon and label move four pixels down and to the right. The label background changes to gray to indicate the icon is being pressed.</td>
</tr>
<tr>
<td><img src="image" alt="Image Editor" /></td>
<td>Unavailable</td>
<td>Inactive action command associated with the icon and label. Both icon and label are grayed-out.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

Two-state Icon and Label Buttons

<table>
<thead>
<tr>
<th>Two-state Icon and Label button appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Up Icon" /></td>
<td>Up</td>
<td>An icon in its basic state, with the label outlined in white to ensure it can be displayed on multiple backgrounds.</td>
</tr>
<tr>
<td><img src="image" alt="Up In Focus Icon" /></td>
<td>Up In Focus</td>
<td>A black border encloses the label to indicate focus.</td>
</tr>
<tr>
<td><img src="image" alt="On Icon" /></td>
<td>On</td>
<td>Items are displaced four pixels down and to the right. The label is enclosed in a white box with a gray border.</td>
</tr>
<tr>
<td><img src="image" alt="On in focus Icon" /></td>
<td>On in focus</td>
<td>Label border changes to black to indicate focus.</td>
</tr>
<tr>
<td><img src="image" alt="Down Icon" /></td>
<td>Down</td>
<td>Icon and label move four pixels down and to the right. The label background changes to gray to indicate the icon is being pressed.</td>
</tr>
<tr>
<td><img src="image" alt="Unavailable Icon" /></td>
<td>Unavailable</td>
<td>Inactive action command associated with the icon and label. Both icon and label are grayed-out.</td>
</tr>
</tbody>
</table>

Lists

As part of PET’s simple design philosophy, student and teachers use lists to select work items instead of looking through a file system. Within the Open and Save As dialog boxes, when the backpack is displayed, a list also displays the set of binders. Consequently, after a user selects a binder, a list of sections displays. And finally, when a section is chosen, PET displays a file list.
PET supports these list controls:

- **List box** – Displays one or more columns of items from which one or more rows may be selected. The developer chooses the supported selection type — single selection or extended selection, depending on the user’s task.

- **Drop-down list** – Intended for situations with limited screen space and when users are making a single selection.

### Drop-down lists

A drop-down list permits users to select one item from a list of choices. It replaces a list box with a drop-down list when screen space is scarce. Drop-down lists can behave as *Can-edit* or *Read-only* selection lists. When configured as a *Can-edit* version, a drop-down list behaves like a single-line text box that it is in the Up state.

Vertical scrollbars may be required if the list length exceeds available screen space. Horizontal scrollbars are not provided for drop-down lists.

Screen or dialog box space may require the developer to position a drop-down list near the bottom of the PET screen. If the list length crosses a screen boundary and more screen space exists above the drop-down list than below, the list should expand up instead of down.

<table>
<thead>
<tr>
<th>Drop-down list appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Up</td>
<td>Basic look for a drop-down list. The list is not extended and there is no focus.</td>
</tr>
<tr>
<td>Calculus</td>
<td>Up In Focus</td>
<td>Black border around drop-down list indicates focus.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>The list is expanded and displays the single, selected item in white text against a blue background.</td>
</tr>
<tr>
<td>Calculus</td>
<td>On In Focus</td>
<td>Displays the selected item in white text against a blue background. Use a black border around the selection to indicate focus.</td>
</tr>
</tbody>
</table>

### List Boxes

The developer chooses the number of list columns and its selection mode — *single selection* or *extended selection*. Users can perform extended selection by holding down the key and tapping...
Section 5: User interface controls

Scroll Bars

subsequent selections. Tapping an item without pressing the • key selects the item and unhighlights all previous selections.

When the number of list items exceeds the vertical list box size, provide a vertical scrollbar for the control. Horizontal scrolling must be supported when any individual list item’s physical width exceeds the width of the list box.

### List Box Appearance

<table>
<thead>
<tr>
<th>List box appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algebra Homework</td>
</tr>
<tr>
<td>Science Homework</td>
</tr>
<tr>
<td>Algebra Quiz</td>
</tr>
<tr>
<td>English Collaboration</td>
</tr>
<tr>
<td>History Assignment</td>
</tr>
</tbody>
</table>

### GUI State

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic look for a list box with no items selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>List box appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algebra Homework</td>
</tr>
<tr>
<td>Science Homework</td>
</tr>
<tr>
<td><strong>Algebra Quiz</strong></td>
</tr>
<tr>
<td>English Collaboration</td>
</tr>
<tr>
<td>History Assignment</td>
</tr>
</tbody>
</table>

### Up In Focus

Black border around single item indicates focus.

<table>
<thead>
<tr>
<th>List box appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algebra Homework</td>
</tr>
<tr>
<td>Science Homework</td>
</tr>
<tr>
<td><strong>Algebra Quiz</strong></td>
</tr>
<tr>
<td>English Collaboration</td>
</tr>
<tr>
<td>History Assignment</td>
</tr>
</tbody>
</table>

### On

The list is expanded and displays the selected item(s) in white text against a blue background.

<table>
<thead>
<tr>
<th>List box appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algebra Homework</td>
</tr>
<tr>
<td>Science Homework</td>
</tr>
<tr>
<td><strong>Algebra Quiz</strong></td>
</tr>
<tr>
<td>English Collaboration</td>
</tr>
<tr>
<td>History Assignment</td>
</tr>
</tbody>
</table>

### On In Focus

Displays the selected item(s) in white text against a blue background and outlines it with a black border to indicate focus.

<table>
<thead>
<tr>
<th>List box appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algebra Homework</td>
</tr>
<tr>
<td>Science Homework</td>
</tr>
<tr>
<td><strong>Algebra Quiz</strong></td>
</tr>
<tr>
<td>English Collaboration</td>
</tr>
<tr>
<td>History Assignment</td>
</tr>
</tbody>
</table>

### Scroll Bars

Vertical and horizontal scrollbars permit users to access screen areas that may be hidden when the content quantity exceeds the dimensions that a GUI control can display. Vertical and horizontal scrollbars display when required — they are not always present, but display automatically when content exceeds the GUI control dimensions, either horizontally or vertically. The GUI control must adjust its height, width, and text wrapping to accommodate the screen area used by scrollbars.
Section 5: User interface controls

Labels

Labels are used to identify the content of another control (such as a text box, list, or drop-down list) or group of GUI controls.

The font size determines the height of the label. The string length determines the label's length. Labels can be displayed across multiple lines for large amounts of text or when used in columns.

The Bitstream Vera font, provided with PET, is a sans serif, variable-width font. Use 10 points as the label default font size. The label's default font color is black (Red 000, Green 000, Blue 000); however, you can assign any system color to the label.

<table>
<thead>
<tr>
<th>Scrollbar appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Scrollbar Up" /></td>
<td>Up</td>
<td>Use paging or dragging to show user interaction feedback with scrollbars.</td>
</tr>
<tr>
<td><img src="image" alt="Scrollbar Down" /></td>
<td>Down</td>
<td>In response to a user Press event, the arrows fill with black.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

Radio button groups

PET uses a smaller prompt label to provide guidance to a user when they are inserting information into text boxes. For example, when a user specifies a password, they may need to type a minimum number of characters, and they are also constrained to a maximum number of characters. The prompt label displays in 8-point, sans serif, variable-width Bitstream Vera font.

Prompt labels

Radio button groups

Radio buttons always display as a group of two or more buttons. Because they are used to select an item from a set of alternatives, only one radio button can ever be in the On state. The developer organizes the radio button group, using a vertical, horizontal, or multiple-column layout.

Note: Tapping a radio button label generates the same response as tapping the radio button.

### Appearance and state for labels

<table>
<thead>
<tr>
<th>Label appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binder: Calculus 101</td>
<td>Up</td>
<td>A Label has only a single state: Up. Labels have a transparent background and a font color chosen by the developer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Label appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td></td>
<td>Basic look for a radio button that is not selected.</td>
</tr>
</tbody>
</table>
### Text boxes

Text boxes divide into two groups: boxes with a single line of text and boxes with multiple lines of text. Each group has several variations:

- **Single-line text boxes** – This text box type has a Can-edit, Read-only, and Password version. The Password text box operates as the Can-edit version, except that all typed characters display as asterisks.

- **Multiple-line text boxes** – Used to hold or display large amounts of text that must continue on multiple lines. Multiple-line text boxes are Can-edit or restricted to Read-only functionality.

#### Single-line text boxes

PET developers use single-line text boxes to permit users to input a short text string for a field. A typical example would be for a user to type a new file name for a document.

The Can-edit and Read-only versions can have an attached context menu. The Can-edit text box implements the Cut, Copy, and Paste commands. The Read-only version implements the Copy functionality only. No context-sensitive menu exists for the Password text box.

Single-line text boxes do not have horizontal scrollbars. However, they can exhibit auto-scrolling behavior. When the user drags the stylus in a horizontal direction, the text box selects text and scrolls in that direction until the starting or ending text is reached. The user can scroll one character at a time using the left and right arrow keys.

<table>
<thead>
<tr>
<th>Single-line text box appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="This is a text box." /></td>
<td>Up</td>
<td>Basic text box look. The Can-edit version has a white text background. The Read-only version has a gray text background.</td>
</tr>
<tr>
<td><img src="image" alt="This is a text box." /></td>
<td>(Can-edit and Read-only versions.)</td>
<td>Basic text box look. The Can-edit version has a white text background. The Read-only version has a gray text background.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

Text boxes

Multiple-line text boxes are used to type or display blocks of text that needs to display on the PET screen formatted as multiple lines. This GUI control has a Can-edit and a Read-only version. An attached context menu works with both multiple-line text box versions.

The Can-edit text box implements the Cut, Copy, and Paste commands. The Read-only version implements the Copy functionality only.

Multiple-line text boxes display vertical scrollbars when content exceeds the control’s dimensions. Horizontal scrollbars can be used, but are not recommended by the PET development staff. Multiple-line text boxes should automatically wrap lines on word boundaries.

<table>
<thead>
<tr>
<th>Single-line text box appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is a text box.</td>
<td>Up in Focus (Can-edit and Read-only versions.)</td>
<td>For the Up In Focus state, a cursor or selected text displays. Selected text displays as reverse video. The Can-edit version has a white text background. The Read-only version has a gray text background.</td>
</tr>
<tr>
<td>This is a text box.</td>
<td>Unavailable</td>
<td>Both the text and the background are gray.</td>
</tr>
</tbody>
</table>

### Multiple-line text boxes

Multiple-line text boxes display vertical scrollbars when content exceeds the control’s dimensions. Horizontal scrollbars can be used, but are not recommended by the PET development staff. Multiple-line text boxes should automatically wrap lines on word boundaries.

<table>
<thead>
<tr>
<th>Multiple-line text box appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is a text box. It has many lines. This is a text box. It has many lines. This is a text box. It has many lines.</td>
<td>Up (Can-edit and Read-only versions.)</td>
<td>Basic text box look. The Can-edit version has a white text background. The Read-only version has a gray text background.</td>
</tr>
</tbody>
</table>
### Spin boxes

Spin boxes consist of a text entry field and two arrow buttons — one for increasing and one for decreasing the text box's numerical value. The developer determines the increment and decrement value for the spin boxes. Optionally, if the user exceeds the maximum appropriate value, the text field value can also jump to the minimum value permitted.

The numerical value displays in a single-line text box. The user can change the spin box value by tapping the increment or decrement arrows or entering a value directly in the text box.

<table>
<thead>
<tr>
<th>Spin box appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="spin_box.png" alt="1.023" /></td>
<td>Up</td>
<td>Basic spin box look. Nothing has focus.</td>
</tr>
<tr>
<td><img src="spin_box.png" alt="1.023" /></td>
<td>Up - Display in Focus</td>
<td>For the Up In Focus state, a cursor or selected text displays as reverse video.</td>
</tr>
<tr>
<td><img src="spin_box.png" alt="1.023" /></td>
<td>Up - Arrow in Focus</td>
<td>The selected arrow is surrounded with a black box to indicate focus.</td>
</tr>
</tbody>
</table>
Check boxes

Check boxes can display as a single control or in groups. Check boxes function independently of other check boxes; therefore, any number can be in the On state concurrently. The developer determines the check box screen organization using a vertical, horizontal, or multiple-column layout.

Note: Tapping the label associated with a check box generates the same response as tapping the check box.

<table>
<thead>
<tr>
<th>Check box appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌ Unchecked</td>
<td>Up</td>
<td>Basic look for a check box.</td>
</tr>
<tr>
<td>❌ Unchecked with Focus</td>
<td>Up Focus</td>
<td>A black border is placed only around the check box label to indicate focus.</td>
</tr>
<tr>
<td>✔ Checked</td>
<td>On</td>
<td>The item(s) that are On have a check mark in the corresponding box.</td>
</tr>
<tr>
<td>✔ Checked with Focus</td>
<td>On Focus</td>
<td>A black border is placed only around the check box label and the box is marked to indicate focus plus selection.</td>
</tr>
<tr>
<td>❌ Unavailable</td>
<td>Unavailable</td>
<td>The background and its label change to a gray color.</td>
</tr>
</tbody>
</table>

Sliders

A slider is a widget with a knob that you can drag to choose a numeric value from a predefined range. The position of the knob is proportional to the selected value in relation to the slider’s numeric range. The developer determines the scale by selecting the minimum and maximum values. The minimum and maximum value labels can be displayed on either side of the trough, or not at all. The slider bar can be oriented vertically or horizontally.
The developer chooses whether or not to display tick marks. Usually the developer selects how many tick marks to display and chooses the amount associated with the arrows that increment and decrement the slider value.

The display box is stationary. It shows the current numerical value (single-line text box) designated by the knob of the slider. If the developer does not want the user to edit the display box, this element can be set to a Read-only version. Alternatively, the display box can be hidden.

To change the slider value:

- Tap or drag the knob.
- Tap the increment and decrement arrows.
- Enter a value in the display box.

<table>
<thead>
<tr>
<th>Slider appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Slider" /></td>
<td>Up</td>
<td>Basic look for the slider bar, with nothing having focus.</td>
</tr>
<tr>
<td><img src="image" alt="Slider" /></td>
<td>Display In Focus</td>
<td>For the Display In Focus state, a cursor or selected text displays. Selected text displays as reverse video.</td>
</tr>
<tr>
<td><img src="image" alt="Slider" /></td>
<td>Arrow In Focus</td>
<td>A black border indicates that the increment or decrement arrow has focus.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

Progress bars

Progress bars are used to show the application working on a lengthy operation and the percentage of task completion. By selecting the size and the number of steps in the bar, the developer can provide feedback in small or large increments.

<table>
<thead>
<tr>
<th>Progress bar appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Progress bar" /></td>
<td>Up</td>
<td>Only progress bar state.</td>
</tr>
</tbody>
</table>

Splitter bars

Vertical and horizontal splitter bars divide the screen to allocate space for one or more PET GUI controls.

Using the stylus (no hard key method available), splitter bars can be dragged. This direct manipulation alters the ratio of the individual screen areas assigned to the GUI controls.

<table>
<thead>
<tr>
<th>Splitter bar appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Splitter bar" /></td>
<td>Up</td>
<td>Normal look for a horizontal splitter bar.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

View tabs

View tabs always display in groups of two or more. They group related application functionality. For example, in a text or imaging editing application, the Text view tab may contain GUI elements that permit a user to change the font family, font size, and font weight of the selected text. Only one view tab in a group can be On at any moment.

PET view tabs only display in a horizontal layout, never as a group of vertical tabs. They may use text, icons, or both as labels. If all of the necessary tabs cannot fit in a single row, scrolling tabs display on either or both ends.

**Note:** For PET applications, do not create multiple rows or *stacked* view tabs.

<table>
<thead>
<tr>
<th>View tabs appearance</th>
<th>GUI state</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Tab 1](Tab 1) ![Tab 2](Tab 2) ![Tab 4](Tab 4)</td>
<td>Up</td>
<td>Refer to Tab 1 and Tab 4 on the left. A view tab in the Up state is not the view tab currently displaying its contents.</td>
</tr>
<tr>
<td>![Tab 1](Tab 1) ![Tab 2](Tab 2) ![Tab 4](Tab 4)</td>
<td>On</td>
<td>Refer to Tab 2 on the left. A view tab in the On state is the one currently displaying its contents. The down state is the same as the On state. When the stylus is tapped on a view tab in the Up state, it immediately changes to the On state.</td>
</tr>
</tbody>
</table>
Section 5: User interface controls

Alerts

Alerts from the PET applications provide the user with information they need to successfully control the application and avoid performing actions that might delete current work. PET applications classify alerts into:

- **Information messages** – Confirms a task completion or advises a user of further application functionality they can employ.
- **Confirmation messages** – Requests a Yes or No (OK or Cancel) response from the user. Alerts user to potential deletion of work or other adverse condition.
- **Stop messages** – Warns that a task did not complete successfully.

**Information messages**

Uses a single OK button to confirm that a user successfully completed a task. The information message can describe the resulting PET application actions and suggest the next steps for the user to perform.
Confirmation messages

Provide a way for the user to avoid an adverse situation, such as unexpectedly deleting a binder, section, or file. The confirmation messages use two buttons (Yes and No, OK and Cancel) to determine the application’s next action.

Stop messages

The Stop (warning) message can be used to alert the user that the previous task failed. The message should display possible corrective actions to help the user perform the task successfully.
Section 5: User interface controls

Complex dialog boxes

![Diagram of a dialog box]

**Title Area**

Dialog boxes should have informative titles. If the dialog box results from choosing a menu item, the dialog box should have the same title as the menu item. The title is displayed in a black, sans serif font. Below the title area is a black line that runs the width of the dialog box.

**Control Area**

This area is reserved for the GUI controls that make up the contents of the dialog box.

**Command Area**

All dialog boxes must include at least one text button to dismiss the dialog box. Text buttons that perform the associated commands are left-justified in the command area, at the bottom of the dialog box.

Usually, one of the text buttons should be labeled **Cancel**, an action that dismisses the dialog box without performing any changes. Another text button should be provided to act upon the user input. The title of this button varies, but it should describe the performed action.

For example, in a Save As dialog box, use the word **Save As** as the default button instead of **OK**. Place the single-state button that is the equivalent of **Save As** as far to the left in the dialog box as possible. The **Cancel** button is typically adjacent to the default **Save As** button. If one of the text buttons represents the preferred or typical action, use a default text button.
PET GUI control behavior and Qt widgets

The TI PET widgets are derived from Qt widget classes and inherit most of the widget’s behavior and characteristics. The next table describes the original Qt widgets that are equivalent to the behavior of the PET GUI controls.

<table>
<thead>
<tr>
<th>PET GUI control</th>
<th>Qt widget behavior, class, and property conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>alert messages</td>
<td>QMessageBox</td>
</tr>
<tr>
<td>check box</td>
<td>QCheckBox</td>
</tr>
<tr>
<td>drop-down lists</td>
<td>QComboBox</td>
</tr>
</tbody>
</table>

Active
Basic look for a dialog box that has input focus.

Unavailable
Dialog box that is unavailable.

This state is reached when multiple dialog boxes display and one of the other dialog boxes has input focus.

The title area and buttons are grayed-out.
### Section 5: User interface controls

PET GUI control behavior and Qt widgets

<table>
<thead>
<tr>
<th>PET GUI control</th>
<th>Qt widget behavior, class, and property conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>icon buttons (single-state)</strong></td>
<td>Toolbar: `QToolButton with the toggleButton property set to false.</td>
</tr>
<tr>
<td></td>
<td>Non-toolbar: Behaves like the <code>TIQ_ImageButton</code> push button class.</td>
</tr>
<tr>
<td><strong>icon buttons (two-state)</strong></td>
<td>Toolbar: <code>QToolButton with the toggleButton property set to true.</code></td>
</tr>
<tr>
<td><strong>icon buttons (two-state)</strong></td>
<td>Non-toolbar: Behaves like the <code>TIQ_ImageButton</code> push button class.</td>
</tr>
<tr>
<td><strong>labels</strong></td>
<td><code>QLabel</code></td>
</tr>
<tr>
<td><strong>list boxes</strong></td>
<td><code>QListBox</code></td>
</tr>
<tr>
<td><strong>progress bars</strong></td>
<td><code>QProgressBar</code></td>
</tr>
<tr>
<td><strong>radio buttons</strong></td>
<td><code>QRadioButton in a QButtonGroup</code></td>
</tr>
<tr>
<td><strong>scrollbars</strong></td>
<td><code>QScrollBar</code></td>
</tr>
<tr>
<td><strong>sliders</strong></td>
<td><code>QSlider</code>. The slider arrow pushbutton behaves as a <code>QSlider</code>. The display box behaves like a single-line text box or <code>QLineEdit</code>. Minimum and maximum slider annotations are <code>QLabels</code>.</td>
</tr>
<tr>
<td><strong>spin boxes</strong></td>
<td><code>QSpinBox</code></td>
</tr>
<tr>
<td><strong>splitter bars</strong></td>
<td><code>QSplitter</code></td>
</tr>
<tr>
<td><strong>tabs (views)</strong></td>
<td><code>QTabWidget</code></td>
</tr>
<tr>
<td><strong>text boxes (single-line)</strong></td>
<td><code>QLineEdit</code></td>
</tr>
<tr>
<td><strong>text boxes (multiple-line)</strong></td>
<td><code>QTextEdit</code></td>
</tr>
<tr>
<td><strong>text button (single-state)</strong></td>
<td><code>QPushButton with the toggleButton property set to false.</code></td>
</tr>
<tr>
<td><strong>text button (two-state)</strong></td>
<td><code>QPushButton with the toggleButton property set to true.</code></td>
</tr>
<tr>
<td><strong>toolbar text button</strong></td>
<td><code>QToolButton with the toggleButton property set to false.</code></td>
</tr>
<tr>
<td><strong>toolbar text button</strong> (two-state)</td>
<td><code>QToolButton with the toggleButton property set to true.</code></td>
</tr>
</tbody>
</table>
Common dialog boxes

PET applications use many dialog boxes. To provide consistency and simplify the user interface, Texas Instruments recommends that these common dialog boxes be used within PET applications. This section discusses the File Selection (Open), File Storage (Save As), Color Picker, Font Picker, and About dialog boxes. While Texas Instruments does not provide Help in its SDK, the GUI Help display and functionality standards are included here for any company that wants to develop this component.

Note: When you see a keyboard action discussed in this section, that action can be performed on the virtual (soft) keyboard and the physical, external keyboard.

Introduction to dialog boxes

![Dialog Box Diagram]

**Title area**

Dialog boxes should have informative titles. If the dialog box displays after choosing a menu item, the dialog box title and the menu item command text should match. The title is displayed with a 10-point, black, sans-serif font, above a black line that runs the width of the dialog box.

**Control area**

This area is reserved for the GUI controls that make up the dialog box contents. Each of the standard PET dialog boxes has specific control layout, which is described in this section.
Section 6: Common dialog boxes

Command area

All dialog boxes must include at least one text button to dismiss the dialog box. Left-justify the text buttons in the command area, at the bottom of the dialog box, that perform the associated commands.

Usually, one of the text buttons should be labeled **Cancel**, an action that dismisses the dialog box without performing any changes. Another text button should be provided to act upon the user input. The title of this button varies, but it should describe the performed action. For example, in a **Save** dialog box, use the word **Save** as the default button instead of **OK**. Place the single-state button that is the equivalent of **OK** as far to the left in the dialog as possible. The **Cancel** button is typically adjacent to the default button. If one of the text buttons represents the preferred or typical action, use a default text button.

Open dialog boxes

A PET customer uses the standard Open dialog box to access information. The Open dialog box can locate student files on the local backpack storage, a multi-media card, or a USB-connected network device.

PET supports two file storage presentations. This restricts the number of locations where students and teachers can search for information. The PET device navigates among stored files using two different **storage presentations**:

- **Backpack storage presentation** – A Backpack-Binder metaphor of student work that resides (1) locally on the PET device, (2) remotely on server using a USB connection, or (3) externally on a **multi-media card** (MMC).
- **General storage presentation** – A general directory folder-file organization of student work on a multi-media cards or remote devices.

Title and command areas

The title area for this dialog box is Open. The title can be customized to reflect the type of PET application. For example, an appropriate title for a music application would be **Open Track**.

The command area contains two single-state text buttons. The first button is the default button and is labeled **Open**. The second button is a normal button labeled **Cancel**. The Open dialog only requires a selection, not text entry, so a soft keyboard icon does not display on the dialog box.

**Note:** Throughout the **Standard dialog boxes** section, the soft keyboard icon ![Soft Keyboard Icon] displays in dialog boxes that can accept text entry.

Control area

The initial GUI control in the control area is a **Read-only** drop-down list with the **Open From** label. The drop-down list always contains at least one item, labeled **Backpack**. This is the default setting for the drop-down list. This choice means the control area displays in the **Backpack storage presentation** format. (See “**Backpack vs. general GUI storage presentation**” on page 73.)
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

The remaining portion of drop-down list is occupied with accessible, external storage location names. If the user selects any of these alternative storage locations from the drop-down list, the remainder of the control area displays in the General storage presentation format.

Examples of the general storage presentation includes:

- **MMC** – A multi-media storage card plugged into the PET device. The name of the storage card would be one of the Open From drop-down list choices.
- **USB Storage** – If the PET is connected to a *Universal Serial Bus* (USB) storage device, that device name could be another list choice.
- **Network Devices** – Additional possibilities are network location names that the PET device can access to find files.

```
Backpack vs. general GUI storage presentation

Backpack GUI storage presentation

**Note:** The Backpack-Binder-Section metaphor mirrors the actual file directory structure used on the Linux PET device. (See “Backpack-Binder Architecture” on page 108.)

Below the storage location (Open From drop-down list) are two labels and two Read-only drop-down lists, arranged in two columns. The left column contains a Binder label, its drop-down list, and the New Binder icon button. The list is underneath the label and takes up the first column. The drop-down list contains all the binder names a user can access. For example, if the PET device had several accessible local binders and more binders on a multi-media card (MMC), all of these binders would display in the Binder drop-down list. The default choice should be the last binder the user selected or the binder that launched the application. If the user accessed no binders or the device home screen launches the application, then display the binder list alphabetically.
The right column contains a Section text label and its drop-down list. The drop-down list is underneath the label and takes up the other column. The drop-down list contains all the section names within the selected binder. The default choice should be the last section the user accessed or the section that launched the application. If the user accessed no binder sections or the device home screen launches the application, then display the New Files section.

Underneath the Binder and Section controls is a two-column file list box. It has headers and can be sorted. The left column (Name) is sorted alphabetically by default, and the right (Modified) column displays the binder modification date. Below the Name column, an application icon assigned to each file type, the file name, and its modification date are listed. If one of the file names exceeds the space provided, truncate the file names and append ellipses to each truncated name. A vertical scrollbar is included if the number of files exceeds the screen height. When the Open dialog box first displays, the currently open file should be highlighted.

Underneath the list box is a labeled text box and drop-down list. The Name text box contains the selected file name highlighted in the two-column list box. Underneath the Name text box, is a drop-down list with the Type label. The Type drop-down list is controlled by the developer and restricts the file names displayed in the two-column list to the desired file types. Right-align the Name and Type labels.

**General GUI storage presentation**

Below the storage location (Open From drop-down list) is a single Location label, two single-state icon buttons, and one Read-only drop-down list. The Location label is left-aligned. The two icon buttons, Previous Directory ( ) and Parent Directory ( ) are right-aligned. The Location drop-down list below the two icon buttons uses the entire control area width. This drop-down list contains the current directory name and icon. The current directory under the selected storage location is linked to its parent directories — up to the device’s root directory. The default choice should be the current directory or the top directory. When the drop-down is expanded, the directory choices are displayed in sequential, parent-child order as shown in the next figure. Indentation should be used to properly indicate the directory relationships.

Underneath these controls is a two-column list box. It has headers and is sortable. The left column (Name) header is sorted alphabetically by default. The right column (Modified) header displays the date of the file or directory’s last change. Under the Name column, the control displays an application or directory icon that is associated with the item type, file names, or directories. If one
of the file names exceeds the space provided, truncate the file names and append ellipses to each truncated name. A vertical scrollbar is included if the number of files exceeds the screen height. When the Open dialog box first displays, the currently open file should be highlighted.

Underneath the list box is a labeled text box and drop-down list. The Name text box contains the selected file name highlighted in the two-column list box. Below the Name text box is a drop-down list with the Type label. The Type drop-down list is controlled by the developer and restricts the file names displayed in the two-column list to the desired file types. Right-align the Name and Type labels.

Tab key navigation

In keeping with the PET design philosophy of accessibility, the Open dialog box GUI controls can be accessed using only the Tab key. For the Open dialog box and other dialog boxes in this section, the Tab key order follows the most common control usage. When there is no preferred order for accessing the GUI controls, the developer should move the application focus from screen top-to-bottom, and within each horizontal screen portion, from left-to-right.

Note: Developers should enable the diamond modifier key + Tab key combination to traverse the Open dialog in reverse order as specified in the next table.

<table>
<thead>
<tr>
<th>Tab key order</th>
<th>Open dialog box element (backpack storage presentation)</th>
<th>Open dialog box element (general storage presentation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Two-column list box</td>
<td>Two-column list box</td>
</tr>
<tr>
<td>2</td>
<td>Name text box</td>
<td>Name text box</td>
</tr>
<tr>
<td>3</td>
<td>Type drop-down list</td>
<td>File type drop-down list</td>
</tr>
<tr>
<td>4</td>
<td>Open button</td>
<td>Open button</td>
</tr>
<tr>
<td>5</td>
<td>Cancel button</td>
<td>Cancel button</td>
</tr>
<tr>
<td>6</td>
<td>Open From drop-down list</td>
<td>Open From drop-down list</td>
</tr>
<tr>
<td>7</td>
<td>Binder drop-down list</td>
<td>Back icon (previous directory)</td>
</tr>
<tr>
<td>8</td>
<td>Section drop-down list</td>
<td>Up icon (parent directory)</td>
</tr>
<tr>
<td>9</td>
<td>- - -</td>
<td>Location drop-down list</td>
</tr>
</tbody>
</table>

Open dialog functions

The Open dialog functionality supports searching, finding, and accessing all supported PET file types for any application. You can use the stylus or the keyboard to perform these commands. (See “Hard keys” on page 114.)

- **Change storage location** – Access any work artifact found in the PET Backpack, on a network storage device, or a multi-media card. Based on the file’s location, PET automatically presents the proper file storage presentation.
- **Select another binder** – Move to a new binder so you can display the sections and file names stored under this binder.
- **Select another section** – Move to a new section so you can display the file names stored under this section.
Section 6: Common dialog boxes

Open dialog boxes

- **Change directories** – Use the Location drop-down list to select a new directory.
- **Move to previous directory** – Use the Previous Directory icon button to move to the previously selected directory.
- **Move to parent directory** – Use the Parent Directory icon button to move to the previous level of the general storage presentation.
- **Select file type(s)** – Restrict the file names displayed in the two-column list to a given file type.
- **Select a file** – Select a single file and display its name in the Name text box.
- **Select a directory** – Switch to another directory in the General storage presentation.
- **Open a file** – Open and access a previously selected file.
- **Cancel the Open dialog action** – Dismiss this dialog box and do nothing.

Change storage location

Select a new storage location using the:

- **Stylus** – Tap the Open From drop-down list and tap the desired storage location.
- **Keyboard** – Press Tab to navigate to the Open From drop-down list. Press the Up and Down Arrows to highlight the desired storage location. (See “Tab key navigation” on page 75.)

If the Open dialog is displayed in the General storage presentation and the user selects a backpack storage location, update the display and switch to the Backpack storage presentation. Conversely, if the Open dialog displays the Backpack storage presentation and a different storage location is chosen, update the display and switch to the General storage presentation. (See “Backpack vs. general GUI storage presentation” on page 73.)

Select another binder

**Precondition:** The Open dialog box must be in the Backpack storage presentation to change to another binder within the backpack.

Select a new binder using the:

- **Stylus** – Tap the Binder drop-down list and tap the desired binder name.
- **Keyboard** – Press Tab to navigate to the Binder drop-down list. Press the Up and Down Arrows to highlight the desired binder name.

Once a new binder is selected, update the Section drop-down list contents. The developer must set the New Files section as the default. Update the two-column list contents with file names found in the default section of the selected binder.

Select another section

**Precondition:** The Open dialog box must be in the Backpack storage presentation to change to another section within this binder.

Select a new section using the:
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Open dialog boxes

• **Stylus** – Tap the Section drop-down list and tap the desired section name.
• **Keyboard** – Press Tab to navigate to the Section drop-down list. Press the Up and Down Arrows to highlight the desired section name.

Updates the two-column list contents with file names found in the chosen section.

*Change directories (using Location drop-down list)*

**Precondition:** The Open dialog box must be in the *General storage presentation* to change to another file directory.

Select a new directory using the:

• **Stylus** – Tap the Location drop-down list and tap the desired directory name.
• **Keyboard** – Press Tab to navigate to the Location drop-down list. Press the Up and Down Arrows to highlight the desired directory.

Updates the two-column list contents with directories and files found in the specified location.

*Move to previous directory*

**Precondition:** The Open dialog box must be in the *General storage presentation* to change to another file directory. The **Previous Directory** icon button should be unavailable (grayed-out) if the operation cannot be performed.

Move to the directory previously selected using the:

• **Stylus** – Tap the **Previous Directory** button.
• **Keyboard** – Press Tab to navigate to the **Previous Directory** button. Press **Enter** to activate the command.

Returns to the previously selected directory. Updates the Location drop-down list and highlights the previous directory. Updates the two-column list contents with directories and files found in the specified location.

*Move to parent directory*

**Precondition:** The Open dialog box must be in the *General storage presentation* to change to another file directory. The **Parent Directory** icon button should be unavailable (grayed-out) if the operation cannot be performed.

Move to the parent directory using the:

• **Stylus** – Tap the **Parent Directory** button.
• **Keyboard** – Press Tab to navigate to the **Parent Directory** button. Press **Enter** to activate the command.
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Return to the parent directory. Updates the Location drop-down list and highlights the parent directory. Updates the two-column list contents with directories and files found in the specified location.

Limit files displayed by type

To limit the file types displayed in the Open dialog box:

- **Stylus** – Tap the (file) Type drop-down list and tap the name of the desired file type(s) to display.
- **Keyboard** – Press Tab to navigate to the Type drop-down list. Press the Up and Down Arrows to highlight the name of the desired file type(s) to display.

Update the contents of the two-column list to show directories (*General storage presentation*) and files found of the selected file type.

Select a file

Select a single file using the:

- **Stylus** – Tap a name of the desired file displayed in the two-column list box.
- **Keyboard** – Press Tab to navigate to the two-column list box. Press the Up and Down Arrows to highlight the file name.

This selects file name and populates the Name text box with the file name.

Select a directory

**Precondition:** The Open dialog box must be in the *General storage presentation* to select a directory.

Select a directory using the:

- **Stylus** – Tap the desired directory displayed in the two-column list box.
- **Keyboard** – Press Tab to navigate to the two-column list box. Press the Up and Down Arrows to highlight the name of a directory. Press Enter to open the directory

The Open dialog navigates into the selected directory. The Location drop-down list updates to show the selected directory. The two-column list contents update to show the directories and files found in the current location.

Open a file

**Precondition:** The Open dialog box must show a file name highlighted in the two-column list.

Open a file using the:

- **Stylus** – Tap **Open** to open the selected file. A shortcut is to double-tap the file name in the two-column list.
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

• **Keyboard** – Press Tab to navigate to the **Open** button. Press **Enter** to select the file. Alternatively, press **Enter** to trigger the dialog’s default button.

The application dismisses the Open dialog box attempts to open the selected file.

*Cancel and dismiss the open dialog*

Cancel the Open dialog box using the:

• **Stylus** – Tap **Cancel** to stop the operation.

• **Keyboard** – Press Tab to navigate to the **Cancel** button. Press Enter to cancel the operation. Alternatively, press **Escape** or ` (apostrophe key) on the QWERTY keyboard as a shortcut.

Dismiss the Open dialog box.

**Save As dialog boxes**

A PET customer uses the standard Save As dialog box to store information. The Save As dialog box can save locate student files on the local backpack storage, a multi-media card, or a USB-connected network device.

PET supports two file storage presentations. This restricts the number of locations where students and teachers can search for information. The PET device navigates among stored files using two different *storage presentations*:

• **Backpack storage presentation** – A Backpack-Binder metaphor of student work that resides (1) locally on the PET device, (2) remotely on server using a USB connection, or (3) externally on a **multi-media card** (MMC).

• **General storage presentation** – A general directory folder-file organization of student work on a multi-media cards or USB connected network-accessible devices.

**Title and command areas**

Use Save As for the title area of this dialog box. The title can be customized by the developer to reflect the application. For example, an appropriate title for a music application would be **Save Track**.

The command area contains two single-state text buttons. The first button is the **default** button and is labeled **Save**. The second button is a regular button labeled **Cancel**. The Save As dialog requires text entry, so the soft keyboard icon is included on the right side of the command area.

**Note:** Throughout the *Standard dialog boxes* section, the soft keyboard icon ![keyboard icon] displays in dialog boxes that can accept text entry.
Control area

The initial GUI control in the control area is a Read-only drop-down list with the Save In label. The drop-down list always contains at least one item, labeled Backpack. This is the default setting for the Save In drop-down list. This choice means the control area displays in the Backpack storage presentation format.

The remaining portion of the drop-down list is occupied with accessible, external storage location names. If the user selects any of these alternative storage locations from the drop-down list, the remainder of the control area displays in the General storage presentation format.

Examples of general storage presentation includes:

- **MMC** – A multi-media storage card plugged into the PET device. The name of the storage card would be one of the Save In drop-down list choices.
- **USB Storage** – If the PET is connected to a Universal Serial Bus (USB) storage device, that device name could be another list choice.
- **Network Devices** – Additional possibilities are network location names that the PET device can access to find files.

![Backpack vs. General GUI Storage Presentation](image)

**Backpack vs. general GUI storage presentation**

**Backpack GUI storage presentation**

*Note:* The Backpack-Binder-Section metaphor mirrors the actual file directory structure used on the Linux PET device. (See "Backpack-Binder Architecture" on page 108.)

Below the storage location (Save In drop-down list) are two labels, two single-state icon buttons, and two Read-only drop-down lists, arranged in two columns. The buttons, New Binder ( ), and
Section 6: Common dialog boxes

New Section ( ) are right-aligned. The left column contains a Binder label and its drop-down list. The list is underneath the label and takes up the first column. The drop-down list contains all the binder names a user can access. For example, if the PET device had several accessible local binders and more binders on a Multi-Media Card (MMC), all of these binders would display in the Binder drop-down list. The default choice should be the last binder the user selected or the binder that launched the application. If the user accessed no binders or the device home screen launches the application, then display the binder list alphabetically.

The right column contains a Section text label and its drop-down list. The Section drop-down list is underneath the label and takes up the other column. The drop-down list contains all the section names within the selected binder. The default choice should be the last section the user accessed or the section that launched the application. If the user accessed no binder sections or the device home screen launches the application, then display the New Files section.

Underneath the Binder and Section controls is a two-column file list box. It has headers and can be sorted. The left column (Name) is sorted alphabetically, by default and the right (Modified) column displays the file modification date. Below the Name column, an application icon assigned to each file type, the file name, and its modification date are listed. If one of the file names exceeds the space provided, truncate the file names and append ellipses to each truncated name. A vertical scrollbar is included if the number of files exceeds the list box height. When the Save As dialog box first displays, the currently open file should be highlighted.

Underneath the list box is a labeled text box and drop-down list. The Name text box contains the selected file name highlighted in the two-column list box. When the dialog is first shown, the contents of the text box should be selected and ready for keyboard entry.

General GUI storage presentation

Below the storage location (Save In drop-down list) is a single Location label, two single-state icon buttons, and one Read-only drop-down list. The Location label is left-aligned. The two icon buttons, Previous Directory ( ) and Parent Directory ( ) are right-aligned. The Location drop-down list below the two icon buttons uses the entire control area width. This drop-down list contains the current directory name and icon. The current directory under the selected storage location is linked to its parent directories — up to the device’s root directory. The default choice should be the current directory or the top directory. When the drop-down is expanded, the directory choices are displayed in sequential, parent-child order as shown in the next figure. Indentation should be used to properly indicate the directory relationships.
Underneath these controls is a two-column file list box. It has headers and is sortable. The left column (Name) header is sorted alphabetically by default, and the right column (Modified) displays the date of the file or directory’s last modification. Under the Name column, the control displays an application or directory icon that is associated with the item type, file names, or directories. If one of the file names exceeds the space provided, truncate the file names and append ellipses to each truncated name. A vertical scrollbar is included if the number of files exceeds the two-column list box height. When the Save As dialog box first displays, the currently open file should be highlighted.

Underneath the list box is a labeled text box and drop-down list. The Name text box contains the selected file name highlighted in the two-column file list box. If a directory is selected, do not change the text box string. When the dialog is first shown, the contents of the text box should be selected and ready for keyboard entry.

**Tab key navigation**

In keeping with the PET design philosophy of accessibility, the Save As dialog box GUI controls can be accessed using only the Tab key. For the Save As dialog box and other dialog boxes in this section, the Tab key order follows the most common control usage. When there is no preferred order for accessing the GUI controls, the developer should move the application focus from screen top-to-bottom and, within each horizontal screen portion, from left-to-right.

**Note:** Developers should enable the diamond modifier key + Tab key combination to traverse the Save As dialog in reverse order as specified in the next table.

<table>
<thead>
<tr>
<th>Tab key order</th>
<th>Save As dialog box element (backpack storage presentation)</th>
<th>Save As dialog box element (general storage presentation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name text box</td>
<td>Name text box</td>
</tr>
<tr>
<td>2</td>
<td>Save button</td>
<td>Save button</td>
</tr>
<tr>
<td>3</td>
<td>Cancel button</td>
<td>Cancel button</td>
</tr>
<tr>
<td>4</td>
<td>Soft keyboard icon</td>
<td>Soft keyboard icon</td>
</tr>
<tr>
<td>5</td>
<td>Save In drop-down list</td>
<td>Save In drop-down list</td>
</tr>
<tr>
<td>6</td>
<td>New binder icon</td>
<td>Back icon (previous directory)</td>
</tr>
<tr>
<td>7</td>
<td>Binder drop-down list</td>
<td>Up icon (parent directory)</td>
</tr>
</tbody>
</table>
Save As dialog functions

The Open dialog functionality supports searching, finding, and accessing a PET file for any application. You can use the stylus or the keyboard to perform these commands. (See “Hard keys” on page 114.)

- **Change storage location** – Store any work artifact in the PET Backpack, on a network storage device, or a multi-media card. Based on the desired file storage location, PET automatically presents the proper file storage presentation.

- **Change binders** – Move to a new binder so you can display the sections and file names currently stored under this binder.

- **Create a binder** – Use the **New Binder** icon button to create a binder in which to further create sections that can hold this file and future work.

- **Change sections** – Move to a new section so you can display the file names stored under this section.

- **Create a section** – Use the **New Section** icon button to create a new section in which to store this file or future work.

- **Change directories** – Use the Location drop-down list to select a new directory.

- **Move to previous directory** – Use the **Previous Directory** icon button to move to the previously selected directory.

- **Move to parent directory** – Use the **Parent Directory** icon button to move to the previous level of the general storage presentation.

- **Select a file** – Select a single file and display its name in the Name text box.

- **Select a directory** – Switch to another directory in the **General storage presentation**.

- **Show or hide the soft keyboard** – Toggle the soft keyboard display so a user can use the stylus to type text.

- **Type a file name** – Create a file name to store the current work artifact.

- **Save a file using the typed file name** – Perform the action of storing the data.

- **Cancel the Save As dialog action** – Dismiss this dialog box and do nothing.

**Change storage location**

Select a new storage location using the:

- **Stylus** – Tap the Save In drop-down list and tap the desired storage location.

- **Keyboard** – Press Tab to navigate to the Open From drop-down list. Press the Up and Down Arrows to highlight the desired storage location. (See “Tab key navigation” on page 82.)
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Save As dialog boxes

If the Save As dialog is displayed in the General storage presentation and the user selects a backpack storage location, update the display and switch to the Backpack storage presentation. Conversely, if the Save As dialog box displays the Backpack storage presentation and a different storage location is chosen, update the display and switch to the General storage presentation. (See “Backpack vs. general GUI storage presentation” on page 80.)

Change binders

Precondition: The Save As dialog box must be in the Backpack storage presentation to change to another binder within the backpack.

Select a new binder using the:

• **Stylus** – Tap the Binder drop-down list and tap the desired binder name.
• **Keyboard** – Press Tab to navigate to the Binder drop-down list. Use the Up and Down Arrows to highlight the desired binder name.

Once a new binder is selected, update the Section drop-down list contents. The developer must set the New Files section as the default. Update the two-column list contents with file names found in the default section of the selected binder.

Create a binder

Precondition: The Save As dialog box must be in the Backpack storage presentation to create another binder within the backpack.

Create a new binder using the:

• **Stylus** – Tap the New Binder icon button. Display the New Binder dialog box found in the next figure. Type the name of the new binder.
• **Keyboard** – Press Tab to navigate to the New Binder icon button. Press Enter. Display the Add Binder dialog box shown in the next figure. Type the name of the new binder.

If the user successfully creates a new binder, update the contents of the Binder drop-down list and show the newly created binder as the current choice. Once a new binder is created, update the Section drop-down list contents. The developer must set the New Files section as the default. Update the contents of the two-column list to show that there are no files.
Section 6: Common dialog boxes

Change sections

Precondition: The Open dialog box must be in the Backpack storage presentation to change to another section within this binder.

Select a new section using the:

- **Stylus** – Tap the Section drop-down list and tap the desired section name.
- **Keyboard** – Press Tab to navigate to the Section drop-down list. Press the Up and Down Arrows to highlight the desired section name. Press Enter.

Update the two-column list contents with file names found in the chosen section.

Create a section

Precondition: The Save As dialog box must be in the Backpack storage presentation to create another section within the current binder.

Create a new section using the:

- **Stylus** – Tap the New Section icon button. Display the Add Section dialog box shown in the next figure. Type the name of the new section.
- **Keyboard** – Press Tab to navigate to the New Section icon button. Press Enter. Display the New Section dialog box found in the next figure. Type the name of the new section.

If the user successfully creates a new section, update the contents of the Section drop-down list and show the newly created section as the current choice. Once a new binder is created, update the Section drop-down list contents. Update the contents of the two-column list to show that there are no files.

Change directories (using Location drop-down list)

Precondition: The Save As dialog box must be in the General storage presentation to change to another file directory.

Select a new directory using the:

- **Stylus** – Tap the Location drop-down list and tap the desired directory name.
- **Keyboard** – Press Tab to navigate to the Location drop-down list. Press the Up and Down Arrows to highlight the desired directory.
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Update the two-column list contents with directories and files found in the specified location.

Move to previous directory

Precondition: The Save As dialog box must be in the General storage presentation to change to another file directory. The Previous Directory icon button should be unavailable (grayed-out) if the operation cannot be performed.

Move to the directory previously selected using the:

- **Stylus** – Tap the Previous Directory button.
- **Keyboard** – Press Tab to navigate to the Previous Directory button. Press Enter to activate the command.

Returns to the previously selected directory. Update the Location drop-down list and highlight the previous directory. Update the two-column list contents with directories and files found in the specified location.

Move to parent directory

Precondition: The Save As dialog box must be in the General storage presentation to change to another file directory. The Parent Directory icon button should be unavailable (grayed-out) if the operation cannot be performed.

Move to the parent directory using the:

- **Stylus** – Tap the Parent Directory button.
- **Keyboard** – Press Tab to navigate to the Parent Directory button. Press Enter to activate the command.

Return to the parent directory. Update the Location drop-down list and highlight the parent directory. Update the two-column list contents with directories and files found in the specified location.

Select a file

Select a single file using the:

- **Stylus** – Tap the name of the desired file displayed in the two-column list box.
- **Keyboard** – Press Tab to navigate to the desired file name displayed in the two-column list box. Press the Up and Down Arrows to highlight the file name. Press Enter.

This selects file name and populates the Name text box.

Select a directory

Precondition: The Save As dialog box must be in the General storage presentation to select a directory.
Select a directory using the:

- **Stylus** – Tap the desired directory displayed in the two-column list box.
- **Keyboard** – Press Tab to navigate to the two-column list box. Press the Up and Down Arrows to highlight the name of a directory. Press Enter to open the directory.

The Save As dialog navigates into the selected directory. The Location drop-down list updates to show the selected directory. The two-column list contents update to show the directories and files found in the current location.

**Show or hide the soft keyboard**

Hide or show the soft keyboard using the:

- **Stylus** – Tap the soft keyboard icon in the command area.
- **Keyboard** – Press Tab to navigate to the soft keyboard icon. Press Enter to toggle the soft keyboard.

Toggle the soft keyboard display to its opposite on or off display state. The dialog may need to resize to accommodate the presence or absence of the keyboard. The keyboard displays at the screen bottom and occupies the entire screen width. The Save As dialog box should be resized to fit above the keyboard.

**Type a file name**

Type a file name using the:

- **Stylus** – Tap or tap-and-drag in the Name text box (above the **Save** button).
- **Keyboard** – Press Tab to navigate to the Name single-line text box. The text should be selected.

Edit the Name text contents by using the soft keyboard or the physical QWERTY keyboard.
Save the file using the specified name

Precondition: The Save As dialog box must have a valid file name displayed in the Name text box.

Select a file name using the:

- **Stylus** – Tap **Save** to save the file as the specified name.
- **Keyboard** – Press Tab to navigate to the Name single-line text box. The text should be selected. Press Tab to navigate to the **Save** button. Press Enter to select it. Alternatively, trigger the default button by pressing the Enter key.

The Save As dialog is dismissed and the application should attempt to save the file. If the file name contains invalid characters, a stop message alert should be issued asking the user to choose another name. If the name is exactly the same as the name of another file in the same location, then a confirmation message alert should display asking the user if they wish to replace the file or cancel the operation. (See “Alerts” on page 66.)

Cancel and dismiss the open dialog

Cancel the Save As dialog box using the:

- **Stylus** – Tap **Cancel** to stop the operation.
- **Keyboard** – Press Tab to navigate to the **Cancel** button. Press Enter to cancel the operation. Alternatively, press **Escape** or ′ + ″ (apostrophe key) on the QWERTY keyboard as a shortcut.

Dismiss the Save As dialog box.

Color dialog boxes

A user accesses the standard Color dialog box to select standard or custom colors for a PET application.
Title and command areas

Use Color for the title area of this dialog box. The title can be customized by the developer to reflect a specific application such as drawing software or setting system preferences.

The command area contains two single-state text buttons. The first button is the default button labeled OK. The second button is a regular button labeled Cancel.

Note: The soft keyboard icon displays in the Color dialog box to permit the user to specify colors using Red-Green-Blue color contributions.

Control area

The custom color display example and the RGB controls occupy the right side of the control area. On the left side of the Color dialog box is a five-by-five grid of 24 standard color swatches and one swatch representing no color. The swatch representing no color should be unavailable (grayed-out) if the application cannot use this choice. The next table describes the color swatch specifications:

<table>
<thead>
<tr>
<th>Color swatch row</th>
<th>RGB color contributions (left-to right)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pink</td>
<td>255, 127, 127</td>
</tr>
<tr>
<td>Light Yellow</td>
<td>255, 255, 128</td>
</tr>
<tr>
<td>Light Green</td>
<td>0, 234, 0</td>
</tr>
<tr>
<td>Light Blue</td>
<td>153, 204, 255</td>
</tr>
<tr>
<td>Light Purple</td>
<td>255, 153, 255</td>
</tr>
</tbody>
</table>
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Color dialog boxes

Tab key navigation

To permit total dialog box usage with the keyboard, a user can navigate through the Color dialog box by pressing Tab to navigate to each Color control.

Note: Developers should enable the diamond modifier key + Tab key combination to traverse the Color dialog in reverse order as specified in the next table.

<table>
<thead>
<tr>
<th>Tab key order</th>
<th>Color dialog box element</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Color swatches: The swatch corresponding to the chosen color or the pink swatch in the first row</td>
</tr>
<tr>
<td>2</td>
<td>Red spinner</td>
</tr>
<tr>
<td>3</td>
<td>Green spinner</td>
</tr>
<tr>
<td>4</td>
<td>Blue spinner</td>
</tr>
<tr>
<td>5</td>
<td>Custom color swatches</td>
</tr>
<tr>
<td>6</td>
<td>Add button</td>
</tr>
<tr>
<td>7</td>
<td>OK button</td>
</tr>
<tr>
<td>8</td>
<td>Cancel button</td>
</tr>
<tr>
<td>9</td>
<td>Soft keyboard icon</td>
</tr>
</tbody>
</table>

Color dialog functions

The Color dialog functionality supports selecting one of twenty-five standard colors, selecting one of three custom colors, or defining custom colors. (See “Hard keys” on page 114.)
Section 6: Common dialog boxes

• Select a standard or custom color – Select one of the 25 predefined colors or one of the three custom colors.

• Change the color specification – Use the RGB spinner box arrows or text boxes to select a nonstandard color.

• Add a custom color – Make the current color specification one of the three permanent custom color swatches.

• Show or hide the soft keyboard – Toggle the soft keyboard display so a user can use the stylus to type color specifications.

• Apply the selected color – Apply the selected color for the application or system function.

• Cancel the Color dialog – Dismiss this dialog box and do nothing.

Select a standard or custom color

You can select a color that is already defined in the Color dialog box by using the:

• Stylus – Tap one of the standard 25 color swatches or one of three possible custom colors.

• Keyboard – Press the Tab and Arrows to navigate to the desired swatch. Press Enter.

This selects that color, which displays in the color display example. The RGB spinner text boxes are updated with the values corresponding to the selected RGB contribution.

Change the color specification

You can change the Red-Green-Blue (RGB) spinner box values to define a custom color by using the:

• Stylus – Tap the RGB spinner arrow to change the primary color contributions or type with the soft keyboard to define the spinner values. Values can range from 0 to 255.

• Keyboard – Press Tab to navigate to an RGB spinner. Press the Up and Down Arrows to change the desired RGB value or use the external keyboard to input a new value.

When an RGB spinner value changes, update the color display example with a color that reflects the chosen RGB primary color contributions.

Add a custom color

Precondition: The Color dialog box must display the desired color in the color display example.

Store the color displayed in the color display example using the:

• Stylus – Tap the desired custom color swatch and tap the Add button.

• Keyboard – Press Tab and Arrows to navigate to the custom color swatch. Press Enter to select it. Press Tab to navigate to the Add button. Press Enter.

The color shown in the color display example replaces the contents of the selected custom color swatch.
Warning: You must perform the custom color selection actions in the correct sequence. First change the color specification. Second, click Add. Finally, select one of the three custom color swatches using the swatch selection dialog box.

![Color dialog box]

(1) Change RGB component amounts that range from 0-255
— or —
(1) Use spin box arrows to set RGB component values.

(2) Click Add.

(3) Use another dialog box to pick where to add custom color.

Show or hide the soft keyboard

Hide or show the soft keyboard using the:

- **Stylus** – Tap the soft keyboard icon in the command area.
- **Keyboard** – Press Tab to navigate to the soft keyboard icon. Press Enter to toggle the soft keyboard.

Toggle the soft keyboard display to its opposite on or off display state. The dialog may need to resize to accommodate the presence or absence of the keyboard. The keyboard displays at the screen bottom and occupies the entire screen width. The Color dialog box should be resized to fit above the keyboard.

Apply the selected color

Confirm that the application should use the chosen color by using the:

- **Stylus** – Tap OK to set the color to the chosen color, the one displayed in the color display example.
- **Keyboard** – Press Tab to navigate to the OK button. Press Enter. Alternatively, trigger the dialog default button by pressing Enter.

The application dismisses the Color dialog box and uses the selected color.

Cancel and dismiss the Color dialog

Cancel the Color dialog box using the:

- **Stylus** – Tap Cancel to stop the operation.
- **Keyboard** – Press Tab to navigate to the Cancel button. Press Enter to cancel the operation. Alternatively, press Escape or `+` (apostrophe key) on the QWERTY keyboard as a shortcut.
Dismiss the Color dialog box.

**Font dialog boxes**

Developers use the Font dialog box to permit user applications to select font families, font sizes, and font styles stored on the PET device.

**Note:** The user is restricted to font sizes between 4 and 32 points, for the Bitstream™ Vera Sans fonts stored on the PET device.

![Font dialog box](image)

**Title and command areas**

Use *Font* for the title area of this dialog box. The title can be customized by the developer to reflect a specific application such as drawing or document software.

The command area contains two single-state text buttons. The first button is the *default* button labeled *OK*. The second button is a regular button labeled *Cancel*.

**Note:** The soft keyboard icon displays in the Font dialog box to permit the user to specify font sizes.

**Control areas**

The Font dialog box controls are arranged in two columns; the left column containing the right-aligned labels and the right column containing the left-aligned control widgets.

The top control area item is the Font *Read-only* drop-down list. The Font drop-down list is populated with the names of all font families installed on the PET device. The currently chosen font family displays in the Font drop-down list, if selected from within an application. However, the default choice should be *Vera Sans*. 
A new PET device ships from the factory with the pre-installed font families:

- Vera Sans
- Vera Mono
- Vera Serif

Below the Font drop-down list is a four radio button group, a check box, and a Style label. The radio buttons are arranged in a two-by-two grid with the labels Normal, Italic, Bold, and **Bold Italic**. Only one radio button is active. The radio button defines the current style of the font family that the application should use. However, the Normal radio button is selected by default.

Underneath the radio buttons is the **Underline** check box. It should reflect the current style of the font, but it is deselected by default. The Underline check box should be made unavailable (grayed-out) by application developers if underlining is an inappropriate application choice.

The final set of controls is a Size label, a single-line text box, and a list box. The text box should reflect the current font point size, but 10 is the default value. The Size drop-down list contains the selections 8, 10, 12, 14, 16, 18, and 20 and is a single-selection list box. The selection should reflect the current point size, but 10 is the default selection. If the current font point size is not one of the list items, the list should have no items selected.

**Tab key navigation**

A user can navigate through the Font dialog box by pressing Tab to navigate to each Font dialog box control.

**Note:** Developers should enable the diamond modifier key + Tab key combination to traverse the Font dialog in reverse order as specified in the next table.

<table>
<thead>
<tr>
<th>Tab key order</th>
<th>Font dialog box element</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Font drop-down list</td>
</tr>
<tr>
<td>2</td>
<td>Rotate through the Style radio button group beginning with the Normal item</td>
</tr>
<tr>
<td>3</td>
<td>Underline check box</td>
</tr>
<tr>
<td>4</td>
<td>Size text box</td>
</tr>
<tr>
<td>5</td>
<td>Size list box</td>
</tr>
<tr>
<td>6</td>
<td>OK button</td>
</tr>
<tr>
<td>7</td>
<td>Cancel button</td>
</tr>
<tr>
<td>8</td>
<td>Soft keyboard icon</td>
</tr>
</tbody>
</table>

**Font dialog functions**

The Font dialog functionality supports selecting font sizes between 4 and 32 points for all fonts stored on the PET device.

- **Change the font family** – Select the desired font family to use in the application.


Section 6: Common dialog boxes

Font dialog boxes

- **Change the font style** – Determine the font’s weight (bold or normal), oblique characteristics (italic or normal), and any optional underlining to use.

- **Change the font size** – Select the font size (values displayed in points) in multiples of 1/72\(^{\text{nd}}\) of an inch.

- **Show or hide the soft keyboard** – Toggle the soft keyboard display so a user can use the stylus to type font specifications.

- **Apply the font changes** – Apply the selected font and desired characteristics in the application.

- **Cancel the Font dialog** – Dismiss this dialog box and do nothing.

**Change the font family**

Select the desired font family by using the:

- **Stylus** – Tap the Font drop-down list. Tap the name to select a font from the opened list.

- **Keyboard** – Press Tab to navigate to the Font drop-down list. Press the Up and Down Arrows to select the font name.

The developer must gray-out the radio button and its label corresponding to any font style (normal, italic, bold, bold italic, or underlined) that cannot be rendered for the chosen font.

**Change the font style**

The font’s style characteristics are changed by using the:

- **Stylus** – Tap the desired Style radio button. Tap the Underline check box to toggle selection (apply or remove underlining).

- **Keyboard** – Press Tab to navigate to the Style radio button group. Press Left, Right, Up, or Down Arrows to put focus on the desired Style radio button label. Press Enter to select it. Press Tab to move to the Underline check box. Press Enter to toggle selection (apply or remove underlining).

One of the four Style radio button labels remains selected with a highlighted border.

**Change the font size**

Determine the font size by using the:

- **Stylus** – Tap the size value displayed in the list box.

- **Keyboard** – Press Tab to navigate to the Size list box. Press the Up and Down Arrows to select the font size. The text box updates to show the selected size. Otherwise, the corresponding size should be selected. Alternatively, press Tab to navigate to the Size text box. Edit the text using the keyboard.

**Note**: If you want to select a font size (13) that is not a listed choice, you must use a keyboard — the soft keyboard or physical QWERTY keyboard. Tap or drag on the Size text box to place the cursor or highlight the text. Use a soft or QWERTY keyboard to type the font size (4 to 32 points).
The Size text box displays the size chosen in the list box. If the Size text box does not match any of the list box choices, select nothing in the Size list box. Otherwise, the text box size should be selected in the list box.

**Show or hide the soft keyboard**

Hide or show the soft keyboard using the:

- **Stylus** – Tap the soft keyboard icon in the command area.
- **Keyboard** – Press Tab to navigate to the soft keyboard icon. Press Enter to toggle the soft keyboard.

Toggle the soft keyboard display to its opposite on or off display state. The dialog may need to resize to accommodate the presence or absence of the keyboard. The keyboard displays at the screen bottom and occupies the entire screen width. The Font dialog box should be resized to fit above the keyboard.

**Apply the font changes**

Apply the chosen font family, style, and size in the application by using the:

- **Stylus** – Tap **OK**.
- **Keyboard** – Press Tab to navigate to the **OK** button. Press Enter. Alternatively, trigger the default button by pressing Enter.

Dismiss the Font dialog box and use the selected font family and style characteristics.

**Cancel and dismiss the Font dialog**

Cancel the Font dialog box using the:

- **Stylus** – Tap **Cancel**.
- **Keyboard** – Press Tab to navigate to the **Cancel** button. Press Enter to cancel the operation. Alternatively, press **Escape** or `+` (apostrophe key) on the QWERTY keyboard as a shortcut.

Dismiss the Font dialog box.

**Help application**

**Note:** Help for the PET device is not currently implemented as a portion of the Texas Instruments PET Software Development Kit.

**Note:** This section describes how a PET on-device help should be designed so that users see a consistent user interface across multiple software applications.
Accessing PET device help

**Note:** When specifying a keyboard action, that action can be performed on the virtual (soft) keyboard and the physical, external keyboard.

Display the Help small application icon in the application title area. Define a Help menu that defines access to the Help screens and the About dialog box. Use the ⌘+m shortcut to display the Help menu or press the ⌘+h shortcut keys to display the Help Table of Contents.

If help was launched from within an application, display `<Application Name>` Help in the title area. If the backpack launched the help, display PET Help. If the title area string is too long, truncate it and add ellipses (…) at the string’s end. Help only has one view, so it is not necessary to include the view picker or view tabs.

On the application toolbar there are four single-state icons: Table of Contents, Back, Forward, and Search. If the development company chooses not to implement the Back or Forward functionality, they should be made unavailable or grayed-out.

**Help Table of Contents**

The background of the Help client area is white. The Table of Contents screen first line displays the string Contents. The text should be displayed in a 12 point, black, underlined, variable width, sans-serif font.
Section 6: Common dialog boxes

Books and sub-books

Book or sub-book titles are displayed in a 10 point, black, variable width, sans serif font. To the left of each Help title is a closed book or open book icon. If the book or sub-book is expanded, then use the open book icon. If either is collapsed, then use the closed book icon. If the title is too long to fit in a single line across the screen, then the topic, subtopic, or page title should wrap to the next line. There is only one book or sub-book title per line. Sub-books titles should be indented to the right to show relationship with parents and child topics. The sub-book icon should be left-aligned with the text of the parent book. To indicate focus, surround the book title text with a single pixel black box.

Help topic page titles

Individual help page titles are displayed in a 10 point, black, variable width, sans-serif font. To the left of the title is the help page icon. If the title is too long to fit in a single line across the screen, then the text should wrap to the next line. There is only one help page title per line. Help page titles should be indented as needed to show their relation to their parent book or sub-book. The help page icon should be left-aligned with the text of their parent. To indicate focus, surround the topic title text with a single pixel black box.

Help topic description

In general, defer to the format of the individual help page.

The client area background is white. All text is displayed in a black, variable-width, sans-serif font, unless otherwise indicated by the help file formatting. If no size is specified by the help file, use a 10 point font.

It is up to the developer whether or not text can be selected. If text can be selected, it is displayed in reverse video. The text contents should always word wrap to stay within the left and right margins of the client area. The user should never need to use the horizontal scrollbar (if one is present) to read the text. The only way a horizontal scrollbar displays in the client area is if an image exceeds the client area width.
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Help application

All images are displayed as actual size. They are never scaled to fit the display. If an image is wider than the client area, horizontal scrollbars must be provided. The developer decides whether or not images can be selected. If images can be selected, they are displayed in reverse video.

Unless otherwise indicated by the help file, all hyperlinks are underlined and displayed in a blue variable width, sans serif font. If no size is specified in the help file, use the 10 point font size. To indicate focus, surround the hypertext with a single pixel black box.

Image hot spots do not receive any visual treatment, except when in focus. To indicate focus, the hot spot area is surrounded by 1 pixel, dashed blue and white box.

Help Search dialog box

The Search dialog box contains the Keywords to search for: label above its associated text box. The text box should be blank, but given input focus. In the command area are two text buttons: Search and Cancel. Since the dialog requires text entry, the keyboard icon displays.

Tab key navigation

The tab key should cycle through all navigable items (book and sub-book titles, individual help page titles, hyperlinks, and hot spots) beginning at the top of the screen.

Help search results

If an individual help page was accessed from the search results screen, then the text on that page that matches the search term(s) is highlighted in yellow. This includes text that is a hyperlink. The help page titles should be displayed in order of relevance to the search term(s), with the most relevant result displayed at the top of the screen. All of the titles and icons left-justified in a single column. There is no indentation to show hierarchy, unlike the Table of Contents screen.
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Help application

Help search results topics

The first line on the Search Results screen displays the Search Results string. The text should be displayed in a 12-point, black, underlined, variable-width, sans-serif font. Individual help page titles are displayed in a 10-point, black, variable-width, sans-serif font. To the left of the title is the help page icon. If the title is too long to fit in a single line across the screen, then the text should wrap to the next line. There is only one help page title per line. The search terms are highlighted in yellow.

Help search results context

Underneath the help page title is a portion of the text from that help page that contains the search terms. The developer should limit exact amount of text to display to a single line. The text shown must contain at least one of the search terms. TI suggests that the text portion displayed should be the first search term instance in the help page. Only one text portion should be displayed. The supporting text is displayed in a 10-point, black, variable-width, sans-serif font. It is left-aligned underneath the help page title text. The search terms are highlighted in yellow.

Help application functions

• Access the table of contents – Display the default Help screen showing the organization of Help information.
• Expand a book or sub-book – On the Table of Contents screen, expand a book and update the display to show the child sub-books and help pages.
• Collapse a book or sub-book – On the Table of Contents screen, collapse a book and update the display to hide the details of the child sub-books and help pages.
• Display a Help page – Select a page on the Help Table of Contents screen and display the individual help page.
• Go back – Display the previous Help screen.
• Go forward – Display the next screen stored within the Help browser application.
Section 6: Common dialog boxes

• **Scroll and page through a help screen** – For help pages that exceed the screen size, use the scroll bars and paging keys to move by fixed amounts.

• **Search** – Display the Search dialog box and display search results once the user has typed one or more keywords.

• **Activate a hyperlink** – Activate the hyperlink and display the referenced Help page.

• **Activate an image hot spot** – Activate the hot spot and display the referenced Help page.

• **Quit** – Immediately quit the Help application.

**Access the table of contents**

Display the Help table of contents by using the:

• **Stylus** – Tap the table of contents toolbar icon. Alternatively, tap the Help > Table of Contents menu command.

• **Keyboard** – Press the Menu hard key or +m on the QWERTY keyboard. Press Arrows to access the Help > Table of Contents command. Press Enter. Alternatively, press +h on the QWERTY as a shortcut.

Display the Help Table of Contents screen, with nothing having focus. (See “Help Table of Contents” on page 97.)

**Expand a book or sub-book**

Expand a closed book or sub-book icon to reveal the organization of child Help information by using the:

• **Stylus** – Tap the book or sub-book’s title or icon.

• **Keyboard** – Press Tab to place the focus indicator on desired book or sub-book title. Press Enter.

Expand the item and update the Help Table of Contents screen to show its child sub-books and pages. Change the selected book or sub-book icon from the closed book to the open book.

**Collapse a book or sub-book**

Collapse a closed book or sub-book icon to hide the organization of child Help information by using the:

• **Stylus** – Tap the book or sub-book’s title or icon.

• **Keyboard** – Press Tab to place the focus indicator on desired book or sub-book title. Press Enter.
Collapse the item and update the Help Table of Contents screen to hide its child sub-books and pages. Change the selected book or sub-book icon from the open book 📖 to the closed book 📑.

**Display a Help page**

Display the Help page content by using the:

- **Stylus** – Tap the Help page title or icon.
- **Keyboard** – Press Tab to move the focus indicator to the desired help page title. Press Enter.

Display the selected Help page. If the help page was selected using the search results screen, highlight the search terms in yellow on the Help page.

**Go back**

Display a previous Help screen using the:

- **Stylus** – Tap the Back icon 🔄 on the toolbar. Alternatively, tap the **Help > Back** command.
- **Keyboard** – Press the Menu hard key or ♯+m on the QWERTY keyboard. Press Arrows to access the **Help > Back** command. Press Enter.

Display the screen previous to the current screen, with nothing having focus.

**Go forward**

**Precondition:** You must use the Go back feature to put a screen on a history list before the Go forward button in the application tool bar becomes available.

Display the next Help screen on the internal Help history display list using the:

- **Stylus** – Tap the Forward icon ➔ on the toolbar. Alternatively, tap the **Help > Forward** command.
- **Keyboard** – Press the Menu hard key or ♯+m on the QWERTY keyboard. Press Arrows to access the **Help > Forward** command. Press Enter.

Display the next screen in the Help history list, with nothing having focus.

**Scroll and page through a help screen**

Vertical or horizontal scrollbars only display in the client area when the Help page content exceeds the screen size.

Scroll or page through a Help page by using the:
Section 6: Common dialog boxes

Pre-production Beta v1.4 release

Help application

- **Stylus** – To scroll, the user taps the scroll bar arrows. To page, the user taps in the trough above or below the thumb. The user can also drag the scroll thumb to move through the client area.

- **Keyboard** – To scroll, press the appropriate Up, Down, Left, or Right Arrows. To page, press ⌃+up arrow to page up and ⌃+down arrow to page down. There is no mechanism to page left and right using only the cursor keys.

Scrolling moves the display by a fixed amount.

**Search**

Search for Help pages containing keywords by using the:

- **Stylus** – Tap the Search icon on the toolbar. Alternatively, tap the Help > Search command.

- **Keyboard** – Press the Menu hard key or ⌃+m on the QWERTY keyboard. Press Arrows to access the Help > Search command. Press Enter.

Display the Search dialog box. (See “Help Search dialog box” on page 99.) If the user types keywords and presses OK, display the Search Results page. (See “Help search results topics” on page 100.)

**Activate a hyperlink**

Use the hyperlink to jump to the related Help page by using the:

- **Stylus** – Tap the hyperlink.

- **Keyboard** – Press Tab to place the focus indicator on the desired hyperlink. Press Enter.

Display the Help page the hyperlink references.

**Activate an image hot spot**

Use the image hot spot to jump to the related Help page by using the:

- **Stylus** – Tap the hyperlink.

- **Keyboard** – Press Tab to place the focus indicator on the desired hot spot. Press Enter.

Display the Help page that the image hot spot references.

**Quit**

Exit the Help application by using the:

- **Stylus** – Tap the Help small application icon located in the title area to display the menu. Tap the Help > Quit command.

- **Keyboard** – Press the menu hard key or ⌃+m on the QWERTY to access the menu. Use the cursor keys to access the File > Quit menu command. Alternatively, press ⌃+q on the QWERTY as a shortcut.
Quit the Help application immediately without displaying any alert messages or dialog boxes.

**About dialog box**

Warning: This dialog box is an example of how Texas Instruments chose to construct its About dialog box. Each company should try to make an About dialog box that uniquely expresses their application's look-and-feel.

The About dialog box permits third-party developers to provide application information to their customers such as:

- Official PET application name.
- Current software revision number (plus date if desired).
- Internet sites where customers can find technical support.
- Third-party software license agreement or warranties.
- Miscellaneous information – telephone number, fax number, e-mail address, and so forth for customer support services.

**Texas Instruments About dialog box example**

![Required About dialog box elements](image)

![Each company should design the About dialog box based on information content and company identification names and graphics.](image)

**Title, command, and control areas**

The About dialog box requires just the title area and a default, single-state OK text button. The About dialog does not require text entry, so the soft keyboard icon is not displayed.

**Software identification**

Third-party developers can insert a background graphic in the control area. Position the graphic 10 pixels below the About title area. Superimposed over the graphic can be two text labels. Use
Section 6: Common dialog boxes

the first label (12-point font size) to display the software application product name. The second label (10-point font size) contains the product version number. Both labels are centered horizontally within the dialog box.

**Technical support**

Below the background graphic (10 pixels), horizontally centered, and displayed with an 8-point font, is an area to display text with a Uniform Resource Locator (URL) of any Internet page used to provide your company's customer support. If the product has no specific web page, use the default URL: http://education.ti.com.

**Software license text**

Underneath the Internet address is an optional read-only, multi-line text box. The text box runs the entire width of the dialog and may need a scrollbar. It contains information such as third party software license agreement text.

Third-party companies can also use this area for miscellaneous information such as:

- Technical support – Telephone numbers and e-mail addresses.
- Copyrights and Trademarks – Any additional copyright information or trademarks of purchased software libraries.
- Related products information – Ways to obtain more information about products that work with this company’s application.

**Copyright information**

Several labels and another graphic fill out the About dialog below the license notice text box. The labels are displayed in the left column and the graphic is to the right. The labels are horizontally centered within the column and displayed in 6-point font. The first label reads Copyright© <YEAR>, where the copyright year needs to be specified for the product. The second label reads “Texas Instruments Incorporated” and the third reads “All Rights Reserved. The graphic is the Texas Instruments logo.

**Tab navigation order**

Press Tab on the keyboard, the OK button receives focus first and then the software license text box.

**About dialog functions**

This dialog box is restricted to scrolling through the software license text box and dismissing the dialog box.

**Scroll through the text box**

Scroll up and down the information text box using the:
Section 6: Common dialog boxes

About dialog box

- **Stylus** – To scroll, the user taps the scroll bar arrows. Scrolling moves at fixed amounts. To page, the user taps in the trough above or below the thumb. (See “Scroll Bars” on page 56.)
- **Keyboard** – Press the Up and Down Arrows. Scrolling moves in fixed amounts. To page, the user presses † +Up Arrow to page up and † +Down Arrow to page down.

**Note:** A small overlap should be kept from the previous text page.

*Dismiss the About dialog*

Remove the About dialog box using the:

- **Stylus** – Tap OK.
- **Keyboard** – Press Tab to navigate to the OK button. Press Enter to cancel the operation. Alternatively, press Escape or † + ‘ (apostrophe key) on the QWERTY keyboard as a shortcut.

Dismiss the About dialog box.
File storage presentations

As discussed in the Open (See “Open dialog boxes” on page 72.) and Save As (See “Save As dialog boxes” on page 79.) dialog boxes, PET supports two file storage presentations. This restricts the number of locations where students and teachers can search for information.

A PET customer uses the standard Open and Save As dialog boxes to access information. The Save As dialog box saves student files on local storage, a multi-media card, or a USB-connected network device.

Users find their work, store new work in named files, and navigate among stored PET files using two storage presentations:

- **Backpack storage presentation** – A Backpack-Binder metaphor of student work that resides (1) locally on the PET device, (2) remotely on server using a USB connection, or (3) externally on a multi-media card (MMC).
- **General storage presentation** – A general directory folder-file organization of student work on a multi-media cards or USB connected network-accessible devices.

**Backpack**

PET's local storage structure always displays in the Backpack presentation mode. If the files reside on a network device or MMC, the user can select to display the files in the Backpack presentation or switch to the more general storage presentation.
Backpack-Binder Architecture

The Backpack-Binder Architecture makes it easy for students and teachers to organize class files. The backpack and binder are common tools used in schools. The backpack bag holds a student’s class binders, along with miscellaneous tools needed for the day. Each binder represents a defined class, project, or other classification and can be subdivided into sections. The Texas Instruments’ Backpack-Binder Architecture mirrors this metaphor. The backpack is the root of the architecture composed of user-defined binders, sections, and files.

The backpack architecture layout uses this general format:

Root directory - Backpack

- **Binder 1**
  - Section1
  - Section2
  - Section3
  - Section4
- **Binder 2**
  - Section1
  - Section2
  - Section3
- **Binder 3**
  - Section 1

**Example**: An actual backpack directory structure might look like:

- Root directory - Backpack
  - Binder 1
    - Section1
    - Section2
    - Section3
    - Section4
  - Binder 2
    - Section1
    - Section2
    - Section3
  - Binder 3
    - Section 1
Section 7: File storage presentations

/Backpack (root directory)

    /Biology (Binder 1)
      /Homework (section)
      /New Files
      /Cells
    /Chemistry (Binder 2)
      /New Files
      /Metals
      /Nonmetals
      /Homework
      /Assignments
      /Quizzes
    /Algebra 1 (Binder 3)
      /New Files
      /Test 1
      /Midterm
      /Final problems
    /English Project (Binder 4)
      /New Files
      /Research
      /First Draft
      /Revision
      /Final Draft

Accessing backpack menu commands

The Backpack menu icon is always resident on the PET Home screen and displays the File, Edit, and Help menus when tapped. These menus and menu item commands:

- **Provide file access** – Standard Open, New, Close, Save, and Save As operations.
- **Perform binder operations** – Add, Delete, and Rename binders.
- **Display application information** – Can display the application’s name, version, copyrights, software license, technical support, and so forth. (See “About dialog box” on page 104.)
Navigating to another binder

You can use the Open dialog box to find a section file for any binder within the backpack. From the Home screen, you can drill-down to a backpack file by first selecting the desired binder, selecting the section, and displaying all files stored within the binder-section. To select another binder:

- **Binder drop-down list** – Tap or press Tab with the Binder drop-down list displays a complete list of all binder names defined on the PET device.
- **View Backpack command** – Use stylus or keyboard to select File > View Backpack. Press Up and Down Arrows to display selected binder. (See “Backpack” on page 107.)
Section 7: File storage presentations

Binders and sections

The PET backpack structure only permits two levels of sub-folders — binders and sections. The binders organize all related class or major project materials. Each binder is identified by a cover page, which acts like a list of file directory properties, supplying the teacher or student with binder information.

Sections and files

Inside each section, a two-column list displays the individual name and the last modification date for each file. The file names can be sorted alphabetically or by modification dates. Directories cannot be created from the sections to make a more complex or deeper file structure. This follows the Texas Instruments meta-architecture Can’t get lost guideline. There is a limited number of locations a user can search for information. (See “Principles” on page 12.)
Sections and file manipulation

Using the Edit menu, the user can manage the sections and files within each section for an entire binder. Selecting the Edit > Edit section manages the sections, and selecting the Edit > Edit file entry cascade menu manages individual files.

General storage presentation

For information stored on a USB-connected network device or a multi-media card, the user can display the files in a more standard tree-structure, similar to Windows. The general storage presentation permits a more experienced computer user to navigate a file directory tree faster and locate files with less effort.

Dialog boxes that present a general storage organization must provide two icon buttons. The buttons should take a user to either the Previous Directory ( ) or go one level up the file directory tree and access the Parent Directory ( ).

The current directory under the selected storage location is linked to its parent directories — up to the device’s root directory. The default choice should be the current directory or the top directory. When the drop-down is expanded, the directory choices are displayed in sequential, parent-child order as shown in the next figure. Indentation should be used to properly indicate the directory relationships.
Appendix - Reference Material

Note: For the first PET software/hardware release, the only available on-device keyboard input is a QWERTY-based soft keyboard. A user can attach an external keyboard using a USB connection.

Hard keys

The hard keys found on the PET device implement standard GUI actions, that are summarized in the following table and subsequent annotated screen shot. (See "Tab hard key" on page 115.)

<table>
<thead>
<tr>
<th>Key</th>
<th>Normal action</th>
<th>When pressed after pressing Diamond †</th>
</tr>
</thead>
<tbody>
<tr>
<td>On / Off</td>
<td>Turn PET on</td>
<td>Turn PET off</td>
</tr>
<tr>
<td>Home</td>
<td>Display Home screen</td>
<td>No action</td>
</tr>
<tr>
<td>Menu</td>
<td>Display application menu</td>
<td>Display context-sensitive shortcut menu for the object having focus</td>
</tr>
<tr>
<td>Diamond †</td>
<td>Turn diamond modifier on</td>
<td>Toggles the diamond modifier off</td>
</tr>
<tr>
<td>Tab</td>
<td>Move to next field in order (See &quot;Tab key navigation&quot; on page 75.)</td>
<td>Move among major on-screen elements (See &quot;Moving among major screen controls&quot; on page 34.)</td>
</tr>
<tr>
<td>Up</td>
<td>Move focus or entry cursor up</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Move focus or entry cursor down</td>
<td>Page Down</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Move focus or entry cursor left</td>
<td>Traverse open applications or documents. Change application focus in split screen mode.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Move focus or entry cursor right</td>
<td>Traverse open applications or documents. Change application focus in split screen mode.</td>
</tr>
<tr>
<td>Enter</td>
<td>Activate control in focus or insert a carriage return in text</td>
<td>No action</td>
</tr>
<tr>
<td>Escape (ESC)</td>
<td>Cancel dialog action</td>
<td>No action</td>
</tr>
</tbody>
</table>
Tab hard key

Users can press the Tab hard key to move from field to field within a dialog box. (See “Tab key navigation” on page 75.) When Tab is pressed after the Diamond \( \text{△} \) key, the user navigates among the major areas of the application screen as shown in the next table. (See “Moving among major screen controls” on page 34.)

Shortcut keys

All PET applications should define a standard set of keyboard shortcuts that implement common system functionality.

Throughout the next table the diamond hard key is designated with the \( \text{△} \) notation. The notation \( \text{△} + m \) to display a menu, means, press the diamond hard key, followed by the “m” key.

<table>
<thead>
<tr>
<th>Shortcut keys</th>
<th>Application action</th>
</tr>
</thead>
</table>
| \( \text{△} + \text{Tab} \) | Move among the major application screen areas:  
  - View picker  
  - Client area. If the application contains toolbars, the focus circulates through the tool palettes.  
  - View-specific toolbar  
  - Application-wide toolbar  
  - System toolbar |
| \( \text{△} + \text{b} \) | Bold font weight - toggle on and off |
| \( \text{△} + \text{'} \) | Cancel the current dialog box |
| \( \text{△} + \text{c} \) | Copy - copy selected area and store it in the clipboard |
| \( \text{△} + \text{x} \) | Cut - remove selected area and store it in the clipboard |
### Shortcut keys

<table>
<thead>
<tr>
<th><strong>Shortcut keys</strong></th>
<th><strong>Application action</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>♦ + f</td>
<td>Find and Replace</td>
</tr>
<tr>
<td>♦ + g</td>
<td>Go To (jump to a page or location within a document)</td>
</tr>
<tr>
<td>♦ + h</td>
<td>Help - display table of contents (See &quot;Help application&quot; on page 96.)</td>
</tr>
<tr>
<td>♦ + i</td>
<td>Italic font style - toggle on and off</td>
</tr>
<tr>
<td>♦ + m</td>
<td>Menu for application displays</td>
</tr>
<tr>
<td>♦ + n</td>
<td>New File</td>
</tr>
<tr>
<td>none</td>
<td>New File in New Screen</td>
</tr>
<tr>
<td>♦ + o</td>
<td>Open dialog box (See &quot;Open dialog boxes&quot; on page 72.)</td>
</tr>
<tr>
<td>none</td>
<td>Load a file, such as a music track</td>
</tr>
<tr>
<td>♦ + Up Arrow</td>
<td>Page Up</td>
</tr>
<tr>
<td>♦ + Down Arrow</td>
<td>Page Down</td>
</tr>
<tr>
<td>♦ + v</td>
<td>Paste clipboard contents at the cursor entry or previous stylus tap position</td>
</tr>
<tr>
<td>♦ + y</td>
<td>Redo the action done before an Undo action</td>
</tr>
<tr>
<td>♦ + q</td>
<td>Quit the application</td>
</tr>
<tr>
<td>♦ + s</td>
<td>Save the current file (See &quot;Save As dialog boxes&quot; on page 79.)</td>
</tr>
<tr>
<td>none</td>
<td>This is unavailable for read-only objects.</td>
</tr>
<tr>
<td>♦ + a</td>
<td>Select All</td>
</tr>
<tr>
<td>♦ + Tap</td>
<td>Starting location or defining a graphic object</td>
</tr>
<tr>
<td>Shift + Tap</td>
<td>Multiple or extended selection</td>
</tr>
<tr>
<td>♦ + u</td>
<td>Underline text - toggle on and off</td>
</tr>
<tr>
<td>♦ + z</td>
<td>Undo the previous action</td>
</tr>
<tr>
<td>♦ + 1</td>
<td>View picker - select first view tab</td>
</tr>
<tr>
<td>♦ + 2</td>
<td>View picker - select second view tab</td>
</tr>
<tr>
<td>♦ + 3</td>
<td>View picker - select third view tab</td>
</tr>
<tr>
<td>♦ + 4</td>
<td>View picker - select fourth view tab</td>
</tr>
<tr>
<td>♦ + 5</td>
<td>View picker - select fifth view tab</td>
</tr>
<tr>
<td>♦ + 6</td>
<td>View picker - select sixth view tab</td>
</tr>
<tr>
<td>♦ + 7</td>
<td>View picker - select seventh view tab</td>
</tr>
<tr>
<td>♦ + +</td>
<td>Zoom in</td>
</tr>
<tr>
<td>♦ + -</td>
<td>Zoom in</td>
</tr>
</tbody>
</table>
Suggested standard menu layout

A standard application menu bar for a PET application should contain a **File**, **Edit**, **View**, and **Help** menus. A suggested menu layout is defined in the following figure.

![Application menu layout diagram](image)

**Application image limitations**

Several PET GUI controls use an image as part of the widget. The images for these widgets have a maximum size in screen pixels. If a developer uses an image that exceeds the control's maximum size, the image is cropped (truncated) and only the maximum size image displays. The next table lists several the GUI controls that use images and the maximum image size allowed. If the widget can handle an image with a transparent background, this is stated in the table.

<table>
<thead>
<tr>
<th>GUI control</th>
<th>Maximum image size (pixels)</th>
<th>Can use transparent background</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar icons</td>
<td>16 x 16</td>
<td>Yes</td>
</tr>
<tr>
<td>Icon and label button</td>
<td>32 x 32</td>
<td>Yes</td>
</tr>
<tr>
<td>View picker icons</td>
<td>16 x 16</td>
<td>Yes</td>
</tr>
<tr>
<td>Open dialog box</td>
<td>16 x 16</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Soft keyboards

Overview

When a keyboard action is described, that action can be performed both on the virtual (soft) keyboard and the physical, external keyboard.

The soft keyboard icon 📡 is a two-state icon button and located in the system-wide toolbar (lower-right screen). This ensures that it is available in every PET application.

Appearance

The soft keyboard is 478 pixels wide and 89 pixels tall. It has a basic QWERTY layout with a multi-use pad area on the right. The pad has four different settings: Spanish characters, French characters, German characters, and English characters (Numbers). The pad tabs are labeled ESP for Spanish, FRA for French, DEU for German and NUM for Number. The Number Pad displays by default. Each soft keyboard is shown in two graphics, one with keyboard in the unshifted state (Shift not depressed) and the shifted state. (See "English (Number) keyboard" on page 122.) For reference, the foreign language pad unicode values for the French, Spanish, and German characters follow the soft keyboard screenshots of each language.
All input keys have a white background and control keys have a gray background. The diamond and square control keys are special modifiers, so they have a white background. All keyed text is displayed in Bitstream Vera Sans, bold, 8-point. Control key text is displayed in Bitstream Vera Sans, bold, 5 point.

When a key is being pressed, or is toggled on (in the case of Caps Lock, Shift, diamond, and square), the key background becomes black and the key text becomes white.

### Full-screen and tiled soft keyboard displays

The previous graphic illustrates how the soft keyboard displays with an application in full-screen mode. When the PET device is in full-screen mode and the soft keyboard is hidden, the application controls the client area. It uses the full 276 (h) x 480 (w) pixel display area. When the soft keyboard displays, it docks above the application toolbar, causing the client area to resize to 187 (h) x 480 (w).

When the PET device displays in tiled mode and the soft keyboard is hidden, a given application has only half of the client area under its control. It is allotted 272 (h) x 236 (w) pixels for its tiled display. This area equals half of the entire client area minus 2 pixels on each side, allowing room to display the focus rectangle. When the soft keyboard is displayed, it docks above the application toolbar, thus causing both application client areas to resize. Each tiled application’s client area is now 183 (h) x 236 (w) pixels.
Functions

- **Display soft keyboard** – Display the soft keyboard in the lower-half of the PET screen.
- **Hide soft keyboard** – Remove soft keyboard display from the PET screen.
- **Select a language** – Press ESP, FRA, DEU, or NUM language key to display the desired characters.
- **Input text** – Insert characters into the PET application.
- **Shift the character set** – Press Shift to display upper-case characters in the current keyboard language.
- **Toggle keyboard into Caps Lock Mode** – Press Caps Lock to display upper-case characters continuously.
- **Release keyboard from Caps Lock Mode** – Press Caps Lock to return the soft keyboard to lower-case characters.
- **Use the diamond key** – Press the ♦ to modify the action of the PET hard keys and to create shortcut keys. (See “Hard keys” on page 114.) (See “Shortcut keys” on page 115.)
- **Use the square key** – Insert a special character into a PET application with the ■ square key modifier and input the associated Unicode number. Tables of Unicode characters in French, Spanish, and German follow the images of the soft keyboards. (See “French keyboard” on page 123.)

*Display soft keyboard*

Show the soft keyboard using the:

- **Stylus** – Tap the soft keyboard icon in the system-wide toolbar.
- **Keyboard** – Press ♦+TAB to navigate to the system-wide toolbar. Press Tab or the Left and Right Arrows to reach the soft keyboard icon. Press Enter.

Display the soft keyboard and resize the client area.
Hide soft keyboard

Remove the soft keyboard from the client area using the:

- **Stylus** – Tap the soft keyboard icon in the system-wide toolbar.
- **Keyboard** – Press **+**TAB to navigate to the system-wide toolbar. Press Tab or the Left and Right Arrows to reach the soft keyboard icon. Press Enter.

Hide the soft keyboard and resize the applications in the client area.

Select a language

- Select a language soft keyboard using the stylus and tapping **ESP**, **FRA**, **DEU**, or **NUM**.

Update the pad display to show the chosen character set. There is no keyboard method to accomplish this operation.

Input text

- Input text with a soft keyboard using the stylus and tapping the desired key.

The character is input to the widget with focus in the client area. There is no method using the Tab or Arrows to access a specific soft keyboard key. To input characters using a keyboard, the user must use an external, physical keyboard.

Shift the character set

- Display the upper-case character set by tapping **Shift**.

This should toggle on and display both Shift keys in reverse video. All characters (including the pad) change to their shifted version, as shown in the screenshots. Immediately after the user taps another soft key, toggle the **Shift** off and return all characters to their unshifted versions.

There is no method using the Tab or Arrows to access the **Shift** key. To input characters using a keyboard, the user must use an external, physical keyboard.

Put keyboard into Caps Lock mode

- Lock the soft keyboard to display upper-case characters by tapping **Caps Lock**.

It should toggle on and display in reverse video. All characters (including the pad) change to their shifted version, as shown in the screenshots. The soft keyboard remains in Caps Lock mode until the user taps **Caps Lock** again or hides the soft keyboard.

There is no method to use the Tab or Arrows to access the **Caps Lock**. To input characters using a keyboard, the user must use an external, physical keyboard.
Release keyboard from Caps Lock Mode

- Unlock the soft keyboard in Caps Lock mode, to display lower-case characters, by tapping Caps Lock.

It should toggle off and display normally. All characters (including the pad) change to their normal (unshifted) version, as shown in the screenshots. Alternatively, user can hide the soft keyboard to release it from Caps Lock mode.

There is no method to use the Tab or Arrows to access the Caps Lock key. To input characters using a keyboard, the user must use an external, physical keyboard.

Use the diamond modifier key

- Tap the diamond key. It should toggle on and display in reverse video. The diamond key displayed on the system-wide toolbar should also toggle on. Immediately after the user taps the next key on the soft keyboard, toggle off the diamond key and test if there is a command associated with the shortcut key sequence. For example, users can tap †+s to save a file. If the next key the user taps is the diamond key (two diamond key taps in a row), toggle off the diamond key and display it normally.

There is no method to use the Tab or Arrows to access the diamond key. However, the user may use keyboard navigation to access the diamond key in the system-wide toolbar. They can also press the diamond key on the physical PET device or an external keyboard. If any of these actions occur and the soft keyboard is visible, the diamond key on the soft keyboard should toggle on and off appropriately.

Input characters using Unicode numbers

- Tap ■ square. It should toggle on and display in reverse video. Then, tap a sequence of keys corresponding to the Unicode number of a character. Finally, tap ■ square again. It should toggle off and the device should check if there is a Unicode character associated with the key sequence. For example ▼+0230+■ inserts the character “a”). If the next key the user taps is the ■ square (two ■ square taps in a row), toggle off the ■ square key and display it normally.

There is no method to use the Tab or Arrows to access the square ■ key. However, if the user presses a square ■ or Alt key on an external keyboard, and the soft keyboard is visible, the square key on the soft keyboard should toggle on and off appropriately.

English (Number) keyboard

Press NUM to show lower-case characters and NUM+Shift to display upper-case characters.
French keyboard

Press **FRA** to show lower-case letters and **FRA+Shift** to display upper-case letters.

<table>
<thead>
<tr>
<th>French character</th>
<th>Unicode number</th>
<th>French character</th>
<th>Unicode number</th>
</tr>
</thead>
<tbody>
<tr>
<td>â</td>
<td>00E0</td>
<td>À</td>
<td>00C0</td>
</tr>
<tr>
<td>â</td>
<td>00E2</td>
<td>Â</td>
<td>00C2</td>
</tr>
<tr>
<td>ç</td>
<td>00E7</td>
<td>Ç</td>
<td>00C7</td>
</tr>
<tr>
<td>è</td>
<td>00E8</td>
<td>É</td>
<td>00C8</td>
</tr>
<tr>
<td>é</td>
<td>00E9</td>
<td>Ê</td>
<td>00C9</td>
</tr>
<tr>
<td>ê</td>
<td>00EA</td>
<td>Ê</td>
<td>00CA</td>
</tr>
<tr>
<td>è</td>
<td>00EB</td>
<td>Ê</td>
<td>00CB</td>
</tr>
<tr>
<td>ì</td>
<td>00EE</td>
<td>Ì</td>
<td>00CE</td>
</tr>
<tr>
<td>ì</td>
<td>00EF</td>
<td>Ì</td>
<td>00CF</td>
</tr>
</tbody>
</table>
## Spanish keyboard

Press **ESP** to show lower-case characters and **ESP+Shift** to display upper-case characters.

<table>
<thead>
<tr>
<th>Spanish character</th>
<th>Unicode number</th>
<th>Spanish character</th>
<th>Unicode number</th>
</tr>
</thead>
<tbody>
<tr>
<td>á</td>
<td>00E1</td>
<td>Æ</td>
<td>00C1</td>
</tr>
<tr>
<td>ç</td>
<td>00E7</td>
<td>Ç</td>
<td>00C7</td>
</tr>
<tr>
<td>é</td>
<td>00E9</td>
<td>É</td>
<td>00C9</td>
</tr>
<tr>
<td>í</td>
<td>00ED</td>
<td>í</td>
<td>00CD</td>
</tr>
<tr>
<td>ñ</td>
<td>00F1</td>
<td>Ñ</td>
<td>00D1</td>
</tr>
<tr>
<td>ó</td>
<td>00F3</td>
<td>Ô</td>
<td>00D3</td>
</tr>
<tr>
<td>ú</td>
<td>00FA</td>
<td>Ú</td>
<td>00DA</td>
</tr>
<tr>
<td>ü</td>
<td>00FC</td>
<td>Ü</td>
<td>00DC</td>
</tr>
<tr>
<td>ñ</td>
<td>00A1</td>
<td>ñ</td>
<td>00BF</td>
</tr>
<tr>
<td>a</td>
<td>00AA</td>
<td>a</td>
<td>00BA</td>
</tr>
<tr>
<td>«</td>
<td>00AB</td>
<td>»</td>
<td>00BB</td>
</tr>
<tr>
<td>ε</td>
<td>20AC</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
German keyboard

Press DEU to show lower-case characters and DEU+Shift to display upper-case characters.

<table>
<thead>
<tr>
<th>German character</th>
<th>Unicode number</th>
<th>German character</th>
<th>Unicode number</th>
</tr>
</thead>
<tbody>
<tr>
<td>à</td>
<td>00E0</td>
<td>À</td>
<td>00C0</td>
</tr>
<tr>
<td>ä</td>
<td>00E1</td>
<td>Ä</td>
<td>00C1</td>
</tr>
<tr>
<td>ã</td>
<td>00E2</td>
<td>Å</td>
<td>00C2</td>
</tr>
<tr>
<td>ä</td>
<td>00E4</td>
<td>Ä</td>
<td>00C4</td>
</tr>
<tr>
<td>é</td>
<td>00E9</td>
<td>É</td>
<td>00C9</td>
</tr>
<tr>
<td>ê</td>
<td>00EA</td>
<td>Ê</td>
<td>00CA</td>
</tr>
<tr>
<td>ö</td>
<td>00F6</td>
<td>Ö</td>
<td>00D6</td>
</tr>
<tr>
<td>ü</td>
<td>00FC</td>
<td>Ü</td>
<td>00DC</td>
</tr>
<tr>
<td>ß</td>
<td>00DF</td>
<td>“</td>
<td>00B0</td>
</tr>
<tr>
<td>«</td>
<td>00AB</td>
<td>»</td>
<td>00BB</td>
</tr>
<tr>
<td>€</td>
<td>20AC</td>
<td>“</td>
<td>201E</td>
</tr>
</tbody>
</table>
## Index

### A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About dialog boxes</td>
<td>105</td>
</tr>
<tr>
<td>functionality</td>
<td></td>
</tr>
<tr>
<td>overview</td>
<td>104</td>
</tr>
<tr>
<td>purposes</td>
<td>104</td>
</tr>
<tr>
<td>requirements</td>
<td>104</td>
</tr>
<tr>
<td>accelerators</td>
<td></td>
</tr>
<tr>
<td>accessibility tool</td>
<td>17</td>
</tr>
<tr>
<td>accessibility</td>
<td></td>
</tr>
<tr>
<td>general tools</td>
<td>17</td>
</tr>
<tr>
<td>introduction</td>
<td>16</td>
</tr>
<tr>
<td>adding</td>
<td></td>
</tr>
<tr>
<td>binders</td>
<td>84</td>
</tr>
<tr>
<td>files to a section</td>
<td>112</td>
</tr>
<tr>
<td>sections</td>
<td>85</td>
</tr>
<tr>
<td>sections to a binder</td>
<td>112</td>
</tr>
<tr>
<td>alerts</td>
<td></td>
</tr>
<tr>
<td>confirmation messages</td>
<td>67</td>
</tr>
<tr>
<td>information messages</td>
<td>66</td>
</tr>
<tr>
<td>stop messages</td>
<td>67</td>
</tr>
<tr>
<td>Americans with Disabilities Act</td>
<td></td>
</tr>
<tr>
<td>accessibility</td>
<td>16</td>
</tr>
<tr>
<td>application framework</td>
<td></td>
</tr>
<tr>
<td>client areas</td>
<td>37</td>
</tr>
<tr>
<td>menu bars</td>
<td>35</td>
</tr>
<tr>
<td>title bars</td>
<td>34</td>
</tr>
<tr>
<td>applications</td>
<td></td>
</tr>
<tr>
<td>closing file or application</td>
<td>47</td>
</tr>
<tr>
<td>designing excellent</td>
<td>19</td>
</tr>
<tr>
<td>displaying several</td>
<td>39</td>
</tr>
<tr>
<td>exchanging information</td>
<td>28</td>
</tr>
<tr>
<td>help</td>
<td>96</td>
</tr>
<tr>
<td>shortcut keys</td>
<td>115</td>
</tr>
<tr>
<td>views group functionality</td>
<td>65</td>
</tr>
<tr>
<td>application-wide</td>
<td></td>
</tr>
<tr>
<td>toolbars</td>
<td>37</td>
</tr>
<tr>
<td>architecture</td>
<td></td>
</tr>
<tr>
<td>interconnection technologies</td>
<td>14</td>
</tr>
<tr>
<td>audience</td>
<td></td>
</tr>
<tr>
<td>for this document</td>
<td>7</td>
</tr>
</tbody>
</table>

### B

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>back</td>
<td></td>
</tr>
<tr>
<td>previous Help page</td>
<td>102</td>
</tr>
<tr>
<td>backpack storage presentation</td>
<td></td>
</tr>
<tr>
<td>Open dialog box</td>
<td>72</td>
</tr>
<tr>
<td>overview</td>
<td>107</td>
</tr>
<tr>
<td>Save As dialog box</td>
<td>79</td>
</tr>
<tr>
<td>backpacks</td>
<td>107</td>
</tr>
<tr>
<td>binders</td>
<td>111</td>
</tr>
<tr>
<td>menus</td>
<td>109</td>
</tr>
<tr>
<td>metaphor for storage</td>
<td>11</td>
</tr>
<tr>
<td>behavior</td>
<td></td>
</tr>
<tr>
<td>menu bars</td>
<td>36</td>
</tr>
<tr>
<td>menus</td>
<td>37</td>
</tr>
<tr>
<td>title bars</td>
<td>35</td>
</tr>
<tr>
<td>toolbar icon groups</td>
<td>39</td>
</tr>
<tr>
<td>toolbars</td>
<td>38</td>
</tr>
<tr>
<td>binders</td>
<td></td>
</tr>
<tr>
<td>adding</td>
<td>84</td>
</tr>
<tr>
<td>backpack divisions</td>
<td>111</td>
</tr>
<tr>
<td>changing</td>
<td>84</td>
</tr>
<tr>
<td>section organization</td>
<td>111</td>
</tr>
<tr>
<td>selecting</td>
<td></td>
</tr>
<tr>
<td>buttons</td>
<td></td>
</tr>
<tr>
<td>icon</td>
<td>51</td>
</tr>
<tr>
<td>icon and label</td>
<td>52</td>
</tr>
<tr>
<td>overview</td>
<td>49</td>
</tr>
<tr>
<td>text</td>
<td>50</td>
</tr>
</tbody>
</table>

### C

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>can't get lost</td>
<td></td>
</tr>
<tr>
<td>meta-architecture principle</td>
<td>13</td>
</tr>
<tr>
<td>Caps Lock mode</td>
<td></td>
</tr>
<tr>
<td>activating</td>
<td>121</td>
</tr>
<tr>
<td>stopping</td>
<td>122</td>
</tr>
<tr>
<td>cellsheet modes</td>
<td></td>
</tr>
<tr>
<td>navigation and input</td>
<td>23</td>
</tr>
<tr>
<td>changing</td>
<td></td>
</tr>
<tr>
<td>binders</td>
<td>84</td>
</tr>
<tr>
<td>file directories</td>
<td>77</td>
</tr>
<tr>
<td>file directories using Save As</td>
<td>85</td>
</tr>
<tr>
<td>file storage locations</td>
<td>76</td>
</tr>
<tr>
<td>sections</td>
<td>85</td>
</tr>
<tr>
<td>character sets</td>
<td></td>
</tr>
<tr>
<td>shifting on soft keyboards</td>
<td>121</td>
</tr>
<tr>
<td>check boxes</td>
<td>62</td>
</tr>
<tr>
<td>clear</td>
<td></td>
</tr>
<tr>
<td>remove data types</td>
<td>32</td>
</tr>
<tr>
<td>client areas</td>
<td></td>
</tr>
<tr>
<td>application framework</td>
<td>37</td>
</tr>
<tr>
<td>full screen multitasking</td>
<td>40</td>
</tr>
<tr>
<td>maximize</td>
<td>14</td>
</tr>
<tr>
<td>tiled screen multitasking</td>
<td>41</td>
</tr>
<tr>
<td>closing</td>
<td></td>
</tr>
<tr>
<td>applications with task switcher</td>
<td>46</td>
</tr>
<tr>
<td>collapsing</td>
<td></td>
</tr>
<tr>
<td>Help book or sub-book</td>
<td>101</td>
</tr>
<tr>
<td>color blindness</td>
<td></td>
</tr>
<tr>
<td>accessibility</td>
<td>16</td>
</tr>
<tr>
<td>Color dialog boxes</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>functionality</td>
<td>90</td>
</tr>
<tr>
<td>overview</td>
<td>88</td>
</tr>
<tr>
<td>colors</td>
<td></td>
</tr>
<tr>
<td>affecting accessibility</td>
<td>18</td>
</tr>
<tr>
<td>apply in application</td>
<td>92</td>
</tr>
<tr>
<td>defining</td>
<td>91</td>
</tr>
<tr>
<td>selecting</td>
<td>91</td>
</tr>
<tr>
<td>task switcher shortcut menu</td>
<td>42</td>
</tr>
<tr>
<td>toolbars</td>
<td>37</td>
</tr>
<tr>
<td>columns</td>
<td></td>
</tr>
<tr>
<td>context-sensitive menu display</td>
<td>24</td>
</tr>
<tr>
<td>command areas</td>
<td></td>
</tr>
<tr>
<td>Color dialog box</td>
<td>89</td>
</tr>
<tr>
<td>dialog boxes</td>
<td>72</td>
</tr>
<tr>
<td>Font dialog box</td>
<td>93</td>
</tr>
<tr>
<td>Open dialog box</td>
<td>72</td>
</tr>
<tr>
<td>Save As dialog box</td>
<td>79</td>
</tr>
<tr>
<td>commands</td>
<td></td>
</tr>
<tr>
<td>View Backpack</td>
<td>110</td>
</tr>
<tr>
<td>confirmation messages</td>
<td>67</td>
</tr>
<tr>
<td>consistency</td>
<td></td>
</tr>
<tr>
<td>user interface actions</td>
<td>15</td>
</tr>
<tr>
<td>contact information</td>
<td></td>
</tr>
<tr>
<td>About dialog box</td>
<td>104</td>
</tr>
<tr>
<td>contextual user interface</td>
<td></td>
</tr>
<tr>
<td>meta-architecture guideline</td>
<td>13</td>
</tr>
<tr>
<td>continuity of experience</td>
<td></td>
</tr>
<tr>
<td>meta-architecture principle</td>
<td>12</td>
</tr>
<tr>
<td>control areas</td>
<td></td>
</tr>
<tr>
<td>Color dialog box</td>
<td>89</td>
</tr>
<tr>
<td>dialog boxes</td>
<td>71</td>
</tr>
<tr>
<td>Font dialog box</td>
<td>93</td>
</tr>
<tr>
<td>Open dialog box</td>
<td>72</td>
</tr>
<tr>
<td>Save As dialog box</td>
<td>80</td>
</tr>
<tr>
<td>copy (information)</td>
<td></td>
</tr>
<tr>
<td>keyboards</td>
<td>29</td>
</tr>
<tr>
<td>stylus</td>
<td>29</td>
</tr>
<tr>
<td>copying</td>
<td></td>
</tr>
<tr>
<td>file to a section</td>
<td>112</td>
</tr>
<tr>
<td>section to a binder</td>
<td>112</td>
</tr>
<tr>
<td>copyrights</td>
<td></td>
</tr>
<tr>
<td>About dialog box</td>
<td>105</td>
</tr>
<tr>
<td>corrections</td>
<td></td>
</tr>
<tr>
<td>undoing and redoing actions</td>
<td>30</td>
</tr>
<tr>
<td>custom colors</td>
<td></td>
</tr>
<tr>
<td>adding</td>
<td>91</td>
</tr>
<tr>
<td>defining</td>
<td>91</td>
</tr>
<tr>
<td>selecting</td>
<td>91</td>
</tr>
<tr>
<td>customizations</td>
<td></td>
</tr>
<tr>
<td>avoid for disabled</td>
<td>18</td>
</tr>
<tr>
<td>cut (information)</td>
<td></td>
</tr>
<tr>
<td>keyboards</td>
<td>28</td>
</tr>
<tr>
<td>stylus</td>
<td>28</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>default buttons</td>
<td></td>
</tr>
<tr>
<td>definition</td>
<td>50</td>
</tr>
<tr>
<td>deleting</td>
<td></td>
</tr>
<tr>
<td>application objects</td>
<td>32</td>
</tr>
<tr>
<td>files in a section</td>
<td>112</td>
</tr>
<tr>
<td>sections in a binder</td>
<td>112</td>
</tr>
<tr>
<td>designing</td>
<td></td>
</tr>
<tr>
<td>excellent GUI applications</td>
<td>19</td>
</tr>
<tr>
<td>dialog boxes</td>
<td>59</td>
</tr>
<tr>
<td>About</td>
<td>104</td>
</tr>
<tr>
<td>Color</td>
<td>88</td>
</tr>
<tr>
<td>complex</td>
<td>68</td>
</tr>
<tr>
<td>Font</td>
<td>93</td>
</tr>
<tr>
<td>multiple text lines</td>
<td>60</td>
</tr>
<tr>
<td>Open</td>
<td>72</td>
</tr>
<tr>
<td>overview</td>
<td>71</td>
</tr>
<tr>
<td>Save As</td>
<td>79</td>
</tr>
<tr>
<td>setup tiled screen</td>
<td>43</td>
</tr>
<tr>
<td>single-line text</td>
<td>59</td>
</tr>
<tr>
<td>standards</td>
<td>71</td>
</tr>
<tr>
<td>diamond key</td>
<td></td>
</tr>
<tr>
<td>shortcut keys</td>
<td>115</td>
</tr>
<tr>
<td>shortcuts</td>
<td>122</td>
</tr>
<tr>
<td>disabilities</td>
<td></td>
</tr>
<tr>
<td>overview</td>
<td>16</td>
</tr>
<tr>
<td>display resolution</td>
<td></td>
</tr>
<tr>
<td>zoom-in and zoom-out</td>
<td>31</td>
</tr>
<tr>
<td>displaying</td>
<td></td>
</tr>
<tr>
<td>Help page</td>
<td>102</td>
</tr>
<tr>
<td>soft keyboards</td>
<td>120</td>
</tr>
<tr>
<td>tasks available</td>
<td>44</td>
</tr>
<tr>
<td>documents</td>
<td></td>
</tr>
<tr>
<td>related to style guide</td>
<td>8</td>
</tr>
<tr>
<td>Down</td>
<td></td>
</tr>
<tr>
<td>GUI element state</td>
<td>48</td>
</tr>
<tr>
<td>drop boxes</td>
<td></td>
</tr>
<tr>
<td>meta-architecture mechanism</td>
<td>14</td>
</tr>
<tr>
<td>drop-down lists</td>
<td></td>
</tr>
<tr>
<td>binder selection</td>
<td>110</td>
</tr>
<tr>
<td>single selection</td>
<td>55</td>
</tr>
<tr>
<td>dynamic layout</td>
<td></td>
</tr>
<tr>
<td>use with GUI</td>
<td>18</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>elements</td>
<td></td>
</tr>
<tr>
<td>meta-architecture</td>
<td>10, 11</td>
</tr>
<tr>
<td>English</td>
<td></td>
</tr>
<tr>
<td>soft keyboard</td>
<td>122</td>
</tr>
<tr>
<td>error messages</td>
<td></td>
</tr>
<tr>
<td>meta-architecture guideline</td>
<td>13</td>
</tr>
<tr>
<td>examples</td>
<td></td>
</tr>
<tr>
<td>metaphors</td>
<td>11</td>
</tr>
</tbody>
</table>
exchanging information
  cut, copy, paste functions ............. 28
expanding
  Help book or sub-book ............... 101

F
Federal Rehabilitation Act
  accessibility ...................... 16
feedback
  GUI design ....................... 15
file directories
  changing .......................... 77
general storage presentation ........ 112
move to parent directory ............ 77
move to previous .................... 77
selecting ........................... 78
file storage locations
  changing ........................... 76
selecting ........................... 83
file types
  restrict Open dialog box .......... 78
files
  display selected type .............. 78
  managing within a section ........ 112
opening ................................ 78
saving ................................ 88
selecting ............................. 78
typing names ........................ 87
visible vs. in focus ................. 42
within sections ..................... 111
finding
  backpack menus ..................... 109
binders ............................. 110
help ................................ 97
focus rectangles
  tiled screens ...................... 41
Font dialog boxes
  font size limitations .............. 93
functionality ........................ 94
overview ............................ 93
overviews ........................... 93
fonts
  affecting usability ................ 18
  apply changes ..................... 96
changing families .................. 95
changing size ...................... 95
changing style ...................... 95
dialog box ........................ 93
families supplied by factory ....... 94
sizes for GUI ........................ 93
testing accessibility ............... 18
footprints in the sand
  meta-architecture guideline ...... 13
forward
  next Help page ................. 102
French
  soft keyboard ..................... 123
  unicode values for characters .... 123
full screen mode
  putting device ..................... 46
Tab navigation ...................... 40
task switcher menu ................... 42
functionality
  About dialog boxes ............... 105
  Color dialog boxes ............... 90
  Font dialog boxes ................. 94
  help application ................ 100
  multitasking ..................... 44
  Open dialog boxes ............... 75
  Save As dialog boxes ............ 83

G
general storage organization
  examples .......................... 73
general storage presentation
  file directories ................. 112
  Open dialog box ................ 72
  overview ........................ 107
  Save As dialog box ............. 79
German
  soft keyboard .................... 125
  unicode values for characters .... 125
graphics
  creating with stylus .............. 27
  stylus ........................... 28
GUI controls
  Qt widgets ........................ 69
GUI design
  accessibility considerations ...... 16
GUI object names
  accessibility ..................... 17
guidelines
  contextual user interface ....... 13
  definition ........................ 11
  footprints in the sand .......... 13
  GUI design policies ............ 13
  understandable error messages .. 13
H
hard keys
  changing action with diamond key . 122
  standards ........................ 114
help
  accessing ........................ 97
  functionality ..................... 100
  keyword searching ............... 103
<table>
<thead>
<tr>
<th>Table of Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search dialog box</td>
<td>99</td>
</tr>
<tr>
<td>search results</td>
<td>99</td>
</tr>
<tr>
<td>table of contents screen</td>
<td>97</td>
</tr>
<tr>
<td>topic page title</td>
<td>98</td>
</tr>
<tr>
<td>hiding</td>
<td></td>
</tr>
<tr>
<td>soft keyboards</td>
<td>121</td>
</tr>
<tr>
<td>Home screen</td>
<td></td>
</tr>
<tr>
<td>starting new task</td>
<td>43</td>
</tr>
<tr>
<td>switching the view</td>
<td>45</td>
</tr>
<tr>
<td>hyperlinks</td>
<td></td>
</tr>
<tr>
<td>help</td>
<td>99</td>
</tr>
<tr>
<td>help application</td>
<td>103</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td></td>
</tr>
<tr>
<td>icon and label buttons</td>
<td>52</td>
</tr>
<tr>
<td>icon buttons</td>
<td>51</td>
</tr>
<tr>
<td>single-state</td>
<td>50, 51, 52</td>
</tr>
<tr>
<td>two state</td>
<td>51</td>
</tr>
<tr>
<td>image hot spots</td>
<td></td>
</tr>
<tr>
<td>activating</td>
<td>103</td>
</tr>
<tr>
<td>image specification</td>
<td></td>
</tr>
<tr>
<td>only use a stylus</td>
<td>27</td>
</tr>
<tr>
<td>images</td>
<td></td>
</tr>
<tr>
<td>GUI limitations</td>
<td>117</td>
</tr>
<tr>
<td>help</td>
<td>99</td>
</tr>
<tr>
<td>hot spots for help</td>
<td>99</td>
</tr>
<tr>
<td>information messages</td>
<td>66</td>
</tr>
<tr>
<td>input</td>
<td></td>
</tr>
<tr>
<td>cellsheet mode</td>
<td>23</td>
</tr>
<tr>
<td>input devices</td>
<td></td>
</tr>
<tr>
<td>disabled persons</td>
<td>17</td>
</tr>
<tr>
<td><strong>K</strong></td>
<td></td>
</tr>
<tr>
<td>keyboards</td>
<td></td>
</tr>
<tr>
<td>accessibility tool</td>
<td>17</td>
</tr>
<tr>
<td>copying information</td>
<td>29</td>
</tr>
<tr>
<td>cutting information</td>
<td>28</td>
</tr>
<tr>
<td>list item selection</td>
<td>25</td>
</tr>
<tr>
<td>navigation and input</td>
<td>20</td>
</tr>
<tr>
<td>pasting information</td>
<td>30</td>
</tr>
<tr>
<td>soft versions</td>
<td>118</td>
</tr>
<tr>
<td>undoing actions</td>
<td>31</td>
</tr>
<tr>
<td><strong>L</strong></td>
<td></td>
</tr>
<tr>
<td>labels</td>
<td>57</td>
</tr>
<tr>
<td>supply user with information</td>
<td>58</td>
</tr>
<tr>
<td>languages</td>
<td></td>
</tr>
<tr>
<td>selecting on soft keyboard</td>
<td>121</td>
</tr>
<tr>
<td>license agreement text</td>
<td></td>
</tr>
<tr>
<td>About dialog box</td>
<td>105</td>
</tr>
<tr>
<td>list boxes</td>
<td></td>
</tr>
<tr>
<td>multiple selections</td>
<td>55</td>
</tr>
<tr>
<td>list items</td>
<td></td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>keyboard selection</td>
<td>25</td>
</tr>
<tr>
<td>stylus selection</td>
<td>25</td>
</tr>
<tr>
<td><strong>M</strong></td>
<td></td>
</tr>
<tr>
<td>mechanisms</td>
<td></td>
</tr>
<tr>
<td>broker</td>
<td>14</td>
</tr>
<tr>
<td>definition</td>
<td>11</td>
</tr>
<tr>
<td>drop box</td>
<td>14</td>
</tr>
<tr>
<td>GUI design technologies</td>
<td>14</td>
</tr>
<tr>
<td>whiteboard</td>
<td>14</td>
</tr>
<tr>
<td>menu bars</td>
<td></td>
</tr>
<tr>
<td>application framework</td>
<td>35</td>
</tr>
<tr>
<td>behavior</td>
<td>36</td>
</tr>
<tr>
<td>states</td>
<td>36</td>
</tr>
<tr>
<td>menu items</td>
<td></td>
</tr>
<tr>
<td>task switcher</td>
<td>42</td>
</tr>
<tr>
<td>menu layouts</td>
<td></td>
</tr>
<tr>
<td>standards</td>
<td>117</td>
</tr>
<tr>
<td>menus</td>
<td></td>
</tr>
<tr>
<td>behavior</td>
<td>37</td>
</tr>
<tr>
<td>context-sensitive</td>
<td>24</td>
</tr>
<tr>
<td>multitasking</td>
<td>39</td>
</tr>
<tr>
<td>overview</td>
<td>36</td>
</tr>
<tr>
<td>states</td>
<td>37</td>
</tr>
<tr>
<td>meta-architecture</td>
<td></td>
</tr>
<tr>
<td>definition of TI elements</td>
<td>10</td>
</tr>
<tr>
<td>elements</td>
<td>10</td>
</tr>
<tr>
<td>guidelines</td>
<td>13</td>
</tr>
<tr>
<td>metaphors</td>
<td>11</td>
</tr>
<tr>
<td>overview</td>
<td>10</td>
</tr>
<tr>
<td>principles</td>
<td>12</td>
</tr>
<tr>
<td>metaphors</td>
<td></td>
</tr>
<tr>
<td>backpack of binders</td>
<td>11</td>
</tr>
<tr>
<td>definition</td>
<td>11</td>
</tr>
<tr>
<td>examples</td>
<td>11</td>
</tr>
<tr>
<td>mistake tolerant</td>
<td></td>
</tr>
<tr>
<td>GUI design</td>
<td>15</td>
</tr>
<tr>
<td>moving</td>
<td></td>
</tr>
<tr>
<td>files between sections</td>
<td>112</td>
</tr>
<tr>
<td>sections between binders</td>
<td>112</td>
</tr>
<tr>
<td>multitasking</td>
<td></td>
</tr>
<tr>
<td>application menus</td>
<td>39</td>
</tr>
<tr>
<td>application title areas</td>
<td>39</td>
</tr>
<tr>
<td>full screen client area</td>
<td>40</td>
</tr>
<tr>
<td>functionality</td>
<td>44</td>
</tr>
<tr>
<td>tab navigation for full screen mode</td>
<td>40</td>
</tr>
<tr>
<td>tab navigation for tiled mode</td>
<td>41</td>
</tr>
<tr>
<td>tiled screen client area</td>
<td>41</td>
</tr>
<tr>
<td>toolbars</td>
<td>40</td>
</tr>
<tr>
<td>must</td>
<td></td>
</tr>
<tr>
<td>meaning in this document</td>
<td>8</td>
</tr>
</tbody>
</table>
N
navigation
  accessibility guidelines 21
cellsheet mode 23
soft keyboards 20

O
On
  GUI element state 48
On In Focus
  GUI element state 48
Open dialog boxes
  functionality 75
  overview 72
  storage presentations 73
opening
  file 78
overviews
  About dialog boxes 104
  accessibility 16
  backpack storage presentation 107
  buttons 49
  Color dialog box 88
  dialog boxes 71
  disabilities 16
  Font dialog boxes 93
  general storage presentation 107
Open dialog boxes 72
Save As dialog box 79
task switcher menu 42
text boxes 59
toolbars 37, 38

P
paging
  Help page 102
paste (information)
  keyboards 30
  stylus 29
preferences
  use for fonts and colors 18
principles
  definition 11
  GUI design architecture 12
product names
  About dialog box 105
progress bars 64

Q
Qt widgets
  GUI controls 69
quitting
  Help application 103

R
radio button groups 58
recommended actions
  default text buttons 50
redo actions
  stylus 30, 31
references 114
  English soft keyboard 122
  French soft keyboard 123
  German soft keyboard 125
  images in GUI controls 117
  menu layouts 117
  PET hard keys 114
  shortcut keys 115
  soft keyboards 118
  Spanish soft keyboard 124
renaming
  files in a section 112
  sections in a binder 112
requirements
  About dialog box 104
RGB values
  soft keyboard 89

S
Save As dialog boxes
  functionality 83
  overview 79
  storage presentations 80
saving
  files 88
screen dimensions
  full screen mode 40
  tiled mode 41
  with soft keyboard 119
screen readers
  accessibility needs 17
  accessibility testing 18
scroll bars 56
scrolling
  Help page 102
search results
  help 99
  help context 100
searching
  keywords in help 103
sections
  adding 85
  binder divisions 111
  changing 85
  document organization 7
  files stored 111
  managing within a binder 112
selecting .................................. 76
selecting
binders .................................. 76, 110
color ........................................ 91
drop-down lists ............................. 55
file .......................................... 78
file directories............................ 78
file storage locations .................... 83
multiple items from list .................. 55
sections .................................... 76
selections
soft keyboard .............................. 20
setting values
spin boxes .................................. 61
setup tiled screen
arrange tiled applications ............... 43
shortcut keys
accessibility tool .......................... 17
applications .............................. 115
using diamond modifier key ............ 115
should
meaning in this document ............... 8
single-line text ............................. 59
single-state
icon buttons .............................. 50, 51, 52
sliders ....................................... 62
slide-sheet and overlays
meta-architecture metaphor ............. 12
soft keyboards
displaying .................................. 120
full-screen vs. tiled mode ............... 119
functions .................................. 120
GUI icon .................................... 72, 79
hiding ...................................... 87, 121
inputting text .............................. 121
putting into Caps Lock Mode .......... 121
selecting a language ..................... 121
shifting character sets ................... 121
showing ..................................... 87
stopping Caps Lock Mode ............... 122
toggle on and off .......................... 20
software version numbers
About dialog box ......................... 105
Spanish
soft keyboard .............................. 124
unicode values for characters .......... 124
spin boxes
GUI controls .............................. 61
splitters ..................................... 64
spreadsheets
editing cells .............................. 22
square key
input characters with Unicode values .. 122
standards
About dialog box ......................... 104
Color dialog box ........................... 88
Font dialog box ............................ 93
hard keys ................................... 114
help for user ............................... 96
images in GUI controls .................. 117
menu layouts .............................. 117
Open dialog boxes ....................... 72
Save As dialog box ....................... 79
starting
task from application ..................... 43
states
check boxes .................................. 62
drop-down lists ............................ 55
GUI element ............................... 48
labels ........................................ 58
list boxes .................................... 56
menu bars .................................... 36
menus ........................................ 37
multiple-line text boxes ............... 60
progress bars .............................. 64
radio button groups ...................... 58
scroll bars ................................... 57
single-line text boxes ................. 59
single-state icon and label buttons .... 53
single-state icon buttons ............... 52
single-state text buttons ............... 50
sliders ........................................ 63
spin boxes .................................... 61
splitter bars .................................. 64
title bars ..................................... 34
toolbar icon groups ....................... 39
toolbars ....................................... 38
two-state icon and label buttons ...... 54
two-state icon buttons ................. 52
two-state text buttons ................. 51
view tabs ..................................... 65
stop messages .............................. 67
storage presentations
Open dialog box ........................... 73
Save As dialog box ....................... 80
stylus
copying information ...................... 29
creating graphics .......................... 27
cutting information ....................... 28
list item selection ......................... 25
pasting information ....................... 29
redoing actions ............................ 30, 31
testing accessibility without .......... 18
undoing actions ............................ 30
switching
PET to full screen mode ............... 46
PET to tiled mode .......................... 46
Tab navigation

About dialog box .......................... 105
Color dialog box .......................... 90
Font dialog box .......................... 94
Help topics ................................ 99
multitasking full screen .................. 40
multitasking tiled screen ................. 41
Open dialog box .......................... 75
Save As dialog box ......................... 82

Table of Contents

help screen ................................ 97
Initial Help screen display ................. 101

Tap-and-Hold

context-sensitive menus ................... 24
tap-drag-lift

stylus graphic technique ................... 28
tapping

stylus graphic technique ................... 28
task switcher

changes for starting new task ............... 43
closing file or application .................... 46
menu items .................................. 42
overview ..................................... 42
tasks

displaying ..................................... 44
starting ...................................... 43

Teach it your way

meta-architecture principle ................. 12
teacher as conductor

meta-architecture metaphor ................. 12
technical support

Internet URLs for GUI style questions .... 9
Internet URLs in About dialog box ....... 104
where to direct questions ..................... 8
text

help pages ................................... 98
text boxes

overview ..................................... 59
prompt labels ............................... 58
text buttons .................................. 50

Tiled mode

putting device in .......................... 46
Tab navigation .............................. 41
task switcher menu .......................... 42
title areas

Color dialog box .......................... 89
dialog boxes ................................ 71
Font dialog box ............................ 93
multitasking ................................ 39
Open dialog box ............................ 72
Save As dialog box .......................... 79
title bars

application framework ...................... 34

Behavior ..................................... 35
States ......................................... 34
toggling

soft keyboard ................................ 20
toolbar icon groups

behavior .................................. 39
States .................................. 39
toolbars

application-wide ......................... 37
background gradient colors ............... 37
behavior .................................. 38
multitasking ................................ 40
overview .................................. 38
States .................................. 38
types ........................................ 37
views ........................................ 37
topics

help search results ......................... 100
two-state

icon buttons .................................. 51
typing

file names .................................... 87
typographical notations

used in this document ....................... 8

Unicode characters

French ........................................ 123
German ........................................ 125
input with square key ....................... 122
Spanish ........................................ 124

Up

GUI element state ......................... 48

Undo actions

keyboards .................................... 31
stylus ........................................ 30

User interfaces

Design philosophy ........................... 10

Views

switch to file without focus ............... 45
switch to hidden file ....................... 44
switch to Home screen ..................... 45
tabs to group application functions ....... 65

Toolbar ....................................... 37

White boards

---
meta-architecture mechanism . . . . . . 14

you can take it with you
meta-architecture principle . . . . . . . 13